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Preface

Welcome to the Oracle Partner Management Implementation Guide, Release 11i.

This guide assumes you have a working knowledge of the following:

■ The principles and customary practices of your business area.

■ Oracle Partner Management.

If you have never used Oracle Partner Management, Oracle suggests you attend 
one or more of the Oracle Partner Management training classes available 
through Oracle University.

■ Oracle Self-Service Web Applications. 

To learn more about Oracle Self-Service Web Applications, read the Oracle 
Self-Service Web Applications Implementation Manual.

■ The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
The Oracle Partner Management Implementation Guide contains the information 
you need to understand and use Oracle Partner Management. This guide contains 
thirteen chapters:

■ Chapter 1 provides a brief introduction to Oracle Partner Management and 
highlights the key features and new features of Oracle Partner Management.
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■ Chapter 2 provides an overview of what you need to have installed and 
implemented before implementing Oracle Partner Management.

■ Chapter 3 describes user types, responsibilities and the transactional system 
that users can access depending on responsibilities.

■ Chapter 4 describes attributes, attribute categories, and seeded categories that 
enable vendors to segment their partners.

■ Chapter 5 describes setups required for the partner dashboard functionality.

■ Chapter 6 describes setups required for the channel manager dashboard 
functionality.

■ Chapter 7 describes setups required for the programs functionality.

■ Chapter 8 describes setups required for the enrollments functionality.

■ Chapter 9 describes how to route an opportunity to a partner.

■ Chapter 10 describes setups required for the referral functionality.

■ Chapter 11 describes setups required for the deal registration functionality.

■ Chapter 12 describes setups required for the special pricing functionality.

■ Chapter 13 describes setups required for the fund request functionality.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program Web site at http://www.oracle.com/accessibility/.

Other Information Sources
You can choose from many sources of information, including documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Partner Management.
xiv



If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). 

■ PDF Documentation- See the Documentation CD provided with each release 
for current PDF documentation for your product. This Documentation CD is 
also available on OracleMetaLink and is updated frequently.

■ Online Help - You can refer to Oracle iHelp for current HTML online help for 
your product. Oracle provides patchable online help, which you can apply to 
your system for updated implemenation and end user documentation. No 
system downtime is required to apply online help.

■ 11i Release Content Document - Refer to the Release Content Document for 
new features listed release. The Release Content Document is available on 
OracleMetaLink.

■ About document - Refer to the About document for patches that you have 
installed to learn about new documentation or documentation patches that you 
can download. The new About document is available on OracleMetaLink.

Related Guides
Oracle Partner Management shares business and setup information with other 
Oracle Applications products. Therefore, you may want to refer to other guides 
when you set up and use Oracle Partner Management.

You can read the guides online by choosing Library from the expandable menu on 
your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Guides Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI). This guide also includes information on setting user 
profiles, as well as running and reviewing reports and concurrent processes.
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You can access this user’s guide online by choosing “Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Guides Related to This Product

Oracle Partner Management Partner and Vendor User Guide
These guides contain information on various functions that vendors and partners 
can perform.

Oracle Filed Sales Implementation Guide
This guide contains information on how to enable the field sales force, telesales 
teams, resellers, partners, and web storefronts to collaborate in closing more 
business together as one sales team. Oracle Sales enables companies to implement 
flexible, customer-centric processes, not only to sell effectively and increase 
revenue, but also to create and enhance long-term customer relationships.

Oracle Approval Management (AME) Implementation Guide
This guide contains information on how approvers are set up for enrollment 
requests, referrals, deals, fund requests and special pricing.

Oracle iStore Implementation Guide
Partners can navigate into Oracle Partner Management through the partner 
dashboard. The partner dashboard is set up by configuring sites. Oracle Partner 
Management is integrated with Oracle iStore to provide a partner dashboard in the 
Oracle iStore Customer UI.

This guide contains information on how to configure sites.

Oracle Trade Management Implementation Guide
This guide contains information on how to set up budgets, offers, and claims.

Oracle Marketing Implementation Guide
While searching for partners, partners are displayed based on your search criteria. 
You can save your search as a list and associate this list with a marketing campaign 
or a promotion. Oracle Partner Management integrates with Oracle Marketing to 
enable you to generate partner lists. These lists can then be used to run marketing 
campaigns and events thereby enabling marketing to partners.

You can view details of the list only if you have the appropriate ’Audience 
Workbench’ permission.
xvi



This guide contains information on how to set up lists and marketing campaigns.

Oracle Leads Management Implementation and Administration Guide
This guide contains information on how to set up the rules engine to process leads.

Oracle Content Management Implementation Guide
This guide contains information on how to set up content that appears as the 
program summary.

Oracle Quoting Implementation Guide
This guide contains information on how to create quotes using modifiable 
templates, add and configure complex products, and perform real-time global 
availability checks. Users can accept product trade-ins, assign sales credits, and 
manually adjust prices.

Oracle Self–Service Web Applications Implementation Guide
This manual contains detailed information about the overview and architecture and 
setup of Oracle Self–Service Web Applications. It also contains procedures for using 
the Web Applications Dictionary.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications 
and the Oracle technology stack by automating many of the required steps. This 
guide contains instructions for using Oracle Rapid Install and lists the tasks you 
need to perform to finish your installation. You should use this guide in conjunction 
with individual product user guides and implementation guides.
xvii



Oracle Applications Implementation Wizard User Guide
If you are implementing more than one Oracle product, you can use the Oracle 
Applications Implementation Wizard to coordinate your setup activities. This guide 
describes how to use the wizard.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

“About” Document
For information about implementation and user documentation, instructions for 
applying patches, new and changed setup steps, and descriptions of software 
updates, refer to the ”About” document for your product. ”About” documents are 
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screen shots, and other information that you need 
to run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff and describes the Oracle Application Object Library components 
that are needed to implement the Oracle Applications user interface described in 
the Oracle Applications User Interface Standards for Forms-Based Products. This manual 
xviii



also provides information to help you build your custom Oracle Forms Developer 
forms so that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes
Use this guide as a reference for upgrading an installation of Oracle Applications. It 
provides a history of the changes to individual Oracle Applications products 
between Release 11.0 and Release 11i. It includes new features, enhancements, and 
changes made to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator's Guide
This guide explains how to complete the setup steps necessary for any Oracle 
Applications product that includes workflow-enabled processes, as well as how to 
monitor the progress of runtime workflow processes.

Oracle Workflow Developer's Guide
This guide explains how to define new workflow business processes and customize 
existing Oracle Applications-embedded workflow processes. It also describes how 
to define and customize business events and event subscriptions.

Oracle Workflow User's Guide
This guide describes how Oracle Applications users can view and respond to 
workflow notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference
This guide describes the APIs provided for developers and administrators to access 
Oracle Workflow.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Partner Management implementation team, as well as for users responsible 
xix



for the ongoing maintenance of Oracle Applications product data. This guide also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetalink

Oracle Applications Message Manual
This manual describes all Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Training and Support

Training
Oracle offers a complete set of training courses to help you and your staff master 
Oracle Partner Management and reach full productivity quickly. These courses are 
organized into functional learning paths, so you take only those courses 
appropriate to your job or area of responsibility.

You have a choice of educational environments. You can attend courses offered by 
Oracle University at any one of our many education centers, you can arrange for 
our trainers to teach at your facility, or you can use Oracle Learning Network 
(OLN), Oracle University's online education utility. In addition, Oracle training 
professionals can tailor standard courses or develop custom courses to meet your 
needs. For example, you may want to use your organization structure, terminology, 
and data as examples in a customized training session delivered at your own 
facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Partner Management 
working for you. This team includes your technical representative, account 
manager, and Oracle’s large staff of consultants and support specialists with 
expertise in your business area, managing an Oracle server, and your hardware and 
software environment.
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OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.
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Oracle develops and markets an integrated line of software products for database 
management, applications development, decision support, and office automation, 
as well as Oracle Applications, an integrated suite of more than 160 software 
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applications products, along with related consulting, education, and support 
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Introduction

This chapter provides information on the key features of Oracle Partner 
Management. Topics included are:

■ Section 1.1, "Oracle Partner Management Overview"

■ Section 1.2, "What's New in this Release"

■ Section 1.3, "Implementation Flow"
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Oracle Partner Management Overview
1.1 Oracle Partner Management Overview
The majority of Global 5000 businesses generate over fifty percent of their revenue 
through indirect sales channels and have a strong need for a functionally rich and 
fully integrated Oracle Partner Management solution. Oracle Partner Management 
fills this need by enabling vendors to efficiently and effectively manage business 
with their indirect channel partners resulting in more successful and lucrative 
channel partnerships. Oracle Partner Management streamlines and strengthens the 
entire partner lifecycle enabling companies to better recruit new partners, to more 
efficiently manage existing partnerships, to more effectively market to and through 
partners, to sell more with partners and to measure the performance of 
partnerships. Oracle Partner Management is part of the Oracle E-Business Suite, an 
integrated set of applications that are engineered to work together.

With this release, partners can:

■ refer business to the vendor and get compensated.

■ register deals with the vendor to avoid competition on a sale.

■ request special, discounted pricing from a vendor to respond to competitive 
selling situations.

■ request for funds to carry out marketing activities.

1.2 What's New in this Release

The following features are added in this release:

■ Setting Up the Partner Dashboard

■ Setting Up the Channel Manager Dashboard

■ Setting Up Referral Management

■ Setting Up Deal Registration

■ Setting Up Special Pricing Management

Note: If you are implementing this product prior to the release, 
using product minipacks or family packs, some new functionality 
may be dependent on integration with other Oracle products. 
Please consult MetaLink for relevant product patches and 
documentation.
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What's New in this Release
■ Setting Up Partner Funds Management

1.2.1 Enhancements to Existing Functionality
The programs, enrollments, and profile attribute features are enhanced.

Programs and Enrollment
The following are enhancements for the Programs and Enrollment functionality.

■ Distributor Initiated Invitation - Distributors can invite their managed partners 
or resellers to join programs.

■ Renewal Process - The program renewal process has been enhanced and 
partners can now renew their memberships into multiple programs. If the 
partner chooses to renew multiple memberships at one time, the system 
presents a consolidated questionnaire to seamlessly collect the profile 
information, summary of all applicable terms and conditions, and consolidated 
payment information.

■ Benefits Framework - Oracle Partner Management extends benefits to partners 
based on their program participation. The benefits framework is tightly 
integrated with various Oracle E-business suite applications such as Oracle 
Trade Management, Oracle Marketing, and Oracle Sales to enable the partner to 
refer business, register deals, request for discounts, funds and place orders.

■ Proforma Invoice - This provides a user friendly view of program fees and taxes 
during self-service enrollment process. Partners can now view a proforma 
invoice inclusive of local taxes, during the enrollment process.

■ Program Copy - Channel managers can copy existing program definitions and 
make modifications. Channel Managers can select attributes of the original 
program that should to be copied into the newly created one.

■ Program Prerequisites - Most companies require their partners to meet certain 
prerequisites before they can enroll into programs. Vendors can define 
prerequisites that a partner must meet to be eligible to enroll in a program.

■ Global/Subsidiary Member Types - Vendors can now manage partners with 
subsidiary organizations. Subsidiary partners can enroll into programs under 
their global partner's membership. The vendors can specify different 
contractual and payment terms for global partners and their subsidiaries.
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Partner Attributes
Vendors can define 'derived' attributes with the ’Currency’, ’Date’, and ’List of 
Values’ return types. They can define time intervals to refresh these attributes. They 
can also specify a possible list of values for the LOV derived attribute type.

New derived attributes have been seeded to track partner performance.

1.3 Implementation Flow
The implementation flow is an abstract of the detailed flow that follows in the rest 
of the guide.

■ Setting Up Profile Attributes

■ Setting Up the Partner Dashboard

■ Setting Up the Channel Manager Dashboard

■ Setting Up Programs

■ Setting Up Enrollments

■ Setting Up Opportunity Assignment

■ Setting Up Referral Management

■ Setting Up Deal Registration

■ Setting Up Special Pricing Management

■ Setting Up Partner Funds Management

Setting Up Profile Attributes
Attributes provide important characteristic information on Oracle Partner 
Management business entities (partners, partner contacts, leads, opportunities, 
referrals and deal registrations) and helps companies increase knowledge of their 
partner's demographics, contacts and capabilities, such as, who they are, what they 
sell, where they sell, what industries they focus on, what certifications they have, 
and so on. Thus, attributes are set up to capture additional specific business 
information for a given business entity within Oracle Partner Management.

To effectively manage partners and partner contacts, vendors need to collect an 
extended partner and contact profile. They can collect the profile information 
during the registration and enrollment process. The profile information can also be 
updated by the partner and the channel manager and in some cases may require 
validation.
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Oracle Partner Management provides an extensible framework to manually or 
automatically capture any kind of information about partners, including 
performance measures and data derived from external sources. After they have 
defined attributes, vendors or partners can enter profile information while enrolling 
into programs. The framework supports fixed attributes (information entered by the 
partner or channel manager) and derived attributes. (information calculated based 
on partner data and transactions) Channel managers can use this information to 
differentiate partners and provide better services, such as soft funds, incentives, and 
opportunities.

Setting Up the Partner Dashboard
The partner dashboard is the single entry point for all partners into your system. 
Using the dashboard, partners can:

■ Enroll into partner programs.

■ Manage their memberships including upgrades and renewals.

■ Access partners stores, browse the catalog and place orders using the store.

■ Accept and manage assigned sales opportunities, create quotes and place 
orders.

■ Submit referrals, register deals, request for funds, request for special pricing 
requests.

■ Maintain their organization and contact profiles.

■ View notifications.

■ Access targeted content such as product news, training information, FAQs and 
so on.

■ Distributors can view their managed partners profile information and invite 
new partners to join the vendor's partner programs.

The partner dashboard displays a summary of transactions and partners can 
navigate from the dashboard to the transactional system. The list of transactions 
available depends on the partner’s enrollments and role. For example, an 
authorized reseller might be assigned sales opportunities.

The key features are:

■ Configurable User Interface - Oracle Partner Management leverages Oracle 
iStore's template management framework to deploy the dashboard. The 
template management framework enables you to configure the layout of the 
dashboard. You can target partner promotions on the dashboard and deliver 
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partner specific content on the dashboard. You can deploy multiple partner 
portals to target different partner segments.

■ Quick Links Bin - This bin enables partners to access the transactional system.

■ Enhanced enrollment system - Oracle Partner Management leverages the Oracle 
iStore site and template manager framework to deliver a fully configurable user 
interface for the enrollment flow.

■ Self service registration for partner organizations - Oracle Partner Management 
enables self service registration for new partners. Partners are guided through a 
step-by-step registration and enrollment flow.

■ Self-service registration for partner users - Oracle Partner Management allows 
partner users of existing partner organizations to request for an account via 
self-service. Such requests are routed to partner administrators for approval. 

Setting Up the Channel Manager Dashboard
The channel manager dashboard provides vendors an easy to use, configurable user 
interface to help them with their day to day responsibilities. It provides them with a 
360 degree view of their partners and activities, thereby enabling them to make 
informed decisions.

The key features of the dashboard are:

■ Dashboard User Interface (UI) - The dashboard UI includes a Key Metrics bin, 
Charts and Graphs indicating the sales performance of partners, Quick Links 
bin, and saved search results where vendors can personalize their search and 
save it. They can personalize the view of the dashboard and thus make it more 
efficient for their needs.

■ Key Metrics bin - This bin provides a consolidated view of partners. The key 
metrics have been seeded (as derived attributes) and vendors can view 
attributes, how they relate to partners and make informed decisions. Vendors 
can also customize the key metrics view by enabling different attributes.

■ Partner Query tool - Vendors can perform advanced searches based on profile 
attributes. They can customize the criteria by adding or removing search 
attributes to tailor their search. Oracle Partner Management integrates with 
Oracle Marketing to enable them to generate partner lists. These lists can then 
be used to run marketing campaigns and events thereby enabling marketing to 
partners.

■ Territory based security model - This release provides a territory based security 
model to access partner information. When a partner is created, the system 
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automatically identifies the channel manager(s) to be assigned based on the 
territory definition. Vendors can define territories and specify territory 
qualifiers, such as geography, partner type and so on. For example, territory A 
could mean all the states in the East Coast of the U.S. that have global partners 
(global membership type). While defining a territory, vendors can also specify 
the channel manager responsible for that territory. If for example, a territory 
(Dallas) has Greg defined as the channel manager. If the newly created partner 
(NP) is from Dallas, Greg is automatically assigned to NP as the channel 
manager by the system. Vendors can also manually assign users to partner 
organizations thereby bypassing the territory definition. Users with the 'Super 
User' role can access all partners irrespective of the territory definition.

■ Partner Lists - Oracle Partner Management integrates with Oracle Marketing to 
enable vendors to generate partner lists that can be used to run marketing 
campaigns and events.

Setting Up Programs
Programs are used to segment partners and provide them with different benefits. 
Vendors can create programs for existing partners as well as new partners. Vendors 
can also recruit and maintain partners with specific incentive packages. This helps 
increase and maintain a strong partner community that further helps them to 
increase overall market share and revenues.

This chapter provides information on setups required to create programs, program 
related profiles, concurrent programs, lookups, administration and security access 
required to access programs.

Setting Up Enrollments
Programs are created and pushed out to partners via the Available Programs bin in 
the partner dashboard. Partners can drill into details of a program. Once partners 
initiate the enrollment process, they are guided through a series of steps to provide 
more information.

This chapter provides information on enrollment related profiles, how to set up 
enrollment approvers, concurrent programs, lookups, and security required for 
program approvals.

Setting Up Opportunity Assignment
A sales opportunity is a qualified sales opportunity. When an opportunity is 
created, it is assigned to one or more sales representatives based on territory 
definitions. New opportunities can originate from leads, marketing campaigns or 
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can be manually entered. Sales representatives or channel managers can assign 
opportunities to partners.

An opportunity can be assigned to your direct or indirect sales channel.

■ Sales representatives from your organization can fulfill direct opportunities.

■ You can route indirect opportunities to partners for fulfillment.

While routing an opportunity to a partner, you must be able to identify the most 
appropriate partner based on pre-defined rules or you can manually search for a 
partner based on their skills and expertise.

When you assign an opportunity to partner, the partner can view details and accept 
it. At any time, the partner can also abandon the opportunity.

Automatic Partner Assignment
Oracle Partner Management provides an engine to identify the best partner(s) to 
fulfill each indirect opportunity by matching opportunity attributes with partner 
expertise. The engine operates on a schedule to assign indirect opportunities to 
partner(s). Once the engine identifies the best partner(s), the system starts a 
workflow process to notify the channel manager, require their approval, and notify 
partner contacts once the opportunity is offered to the partner.

Automatic Partner Search
Once matching rules are defined in the system, you can manually invoke the engine 
to find the best partner for fulfilling the opportunity. Once you submit the 
assignment to a partner, the system starts a workflow process to notify the partner 
and the channel manager that an opportunity is assigned.

Manual Partner Search
You can manually match opportunities by selecting a preferred partner or 
performing a manual search using partner profile attributes to identify the best 
partner. After you identify the best partner, you can submit the assignment. A 
workflow process drives approvals and notifications for channel manager and 
partner users.

The key features are:

■ Rule based engine automatically processes leads and assigns opportunities to 
partners based on opportunity criteria and partner profile.

■ Workflow based approval and notifications.
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■ Multiple routing types allows to assign opportunity to one or multiple partners, 
using serial, parallel or joint routing.

■ Ability to manually search for partners based on their profile

Setting Up Referral Management
Referral Management enables partners to refer business opportunities, that they 
cannot fulfill directly, to your organization. For example, the partner learns of an 
opportunity for a customer who is interested in a product that the reseller does not 
sell. In this scenario, partners can submit a referral to the vendor and receive a 
percentage of the revenue.

When partners submit a referral, it is routed to the appropriate approver(s). 
Approvers are notified of the referral and they review it and approve, reassign or 
decline it. When the referral is approved, the partner is compensated after the 
customer places an order. The commission is reviewed and approved internally and 
then sent to the partner for acceptance. After partners accept the commission, the 
vendor pays the commission.

Vendors and partners receive notifications about referral activity and can navigate 
directly from the notification into the associated referral. Notifications are 
configured by vendors and sent when the status changes, for example, when a 
referral is approved.

Vendors and partners can access a summary list of referrals that they have access to. 
They can build personal views to quickly find referrals that they are most interested 
in.

The key features are:

■ Partners can submit referrals online and track the progress of the referral from 
submission to acceptance to payment.

■ Configurable questionnaire to collect relevant information about a potential 
opportunity.

■ Workflow driven approvals and notifications - You can assign approvers based 
on multiple criteria, such as geography, product lines or partner types. Oracle 
Workflow is configured to send notifications to relevant people, at each step of 
the referral life cycle.

■ Flexible setups - Program managers can setup referral initiatives based on 
geography and/or product lines. Users can define different commission rates 
based on product lines.
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■ Channel Managers and Registration Managers can review submitted referrals, 
check for duplicates and approve or decline it.

■ Integration with TCA to verify and merge customer and contact information 
and maintain the integrity of your customer database.

■ Integration with Oracle Sales to automatically carry over referral information to 
the opportunity or lead record and through the sales cycle.

■ Integration with Oracle Trade Management to automate referral commission 
calculation and payment.

This chapter provides information on profiles, concurrent programs, lookups, 
security access required to access referrals, and dependencies.

Setting Up Deal Registration
When partners resell your products, there is often a conflict between your direct 
sales force and your partner network. Deal Registration enables partners to submit 
opportunities and receive your commitment not to compete directly and provide 
support on the deal. You increase partner loyalty and gain visibility into partner 
activity.

When partners submit a deal registration, it is routed to the appropriate 
approver(s). Approvers are notified of the deal registration and they review it and 
approve, reassign or decline it. When the deal registration is approved, a new 
opportunity is created in the system and assigned to the partners’ organization for 
fulfillment.

Vendors and partners receive notifications about deal registration activity and can 
navigate directly from the notification into the associated deal registration. 
Notifications are configured by the vendor and sent when the status changes, for 
example, when a deal registration is approved.

Vendors and partners can access a summary list of deal registrations that they have 
access to. Vendors and partners can build personal views to quickly find deal 
registrations that they are most interested in.

The key features are:

■ Partners can submit deal registrations online. Once the registration is approved, 
the partner can work on the indirect opportunity record that is automatically 
generated and assigned to the partner.

■ Workflow driven approvals and notifications - You can assign approvers based 
on multiple criteria, such as geography, product lines or partner types. Oracle 
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Workflow is configured to send notifications to relevant people, at each step of 
the deal life cycle.

■ Flexible setups - Program managers can setup deal initiatives based on 
geography and/or product lines.

■ Channel Managers and Registration Managers can review registered deals, 
validate information, check for duplicate deals, and approve or decline it. 

■ Integration with TCA to verify and merge customer and contact information 
and maintain the integrity of your customer database.

■ Integration with Oracle Sales to automatically carry over deal information to 
the opportunity record and through the sales cycle.

Setting Up Special Pricing Management
Special Pricing Management streamlines the submission, approval and tracking of 
special pricing requests as well as the submission, validation and tracking of claims.

Special Pricing Management enables you to automate and streamline the special 
pricing process in which your partners request discounts on sales deals. You can 
respond quickly and intelligently to your partners’ requests for special, discounted 
pricing, thus closing more sales and increasing partner loyalty.

When a partner submits a request, it gets routed to the appropriate approver(s). 
Approvers will be notified of the request and they review the request and approve 
or decline it. When a request is approved and the partner closes a sale, he/she can 
submit a claim to receive the discount you approved. The claim will be routed to 
the claim approver who will then validate the claim. When the claim gets approved, 
you can make the payment to the partner as credit or can issue a check. Partners can 
also check the status of claims online.

Special Pricing provides search capabilities that enables users to locate requests or 
perform analysis on special pricing activity. You can configure Oracle Workflow to 
organize the approval process for incoming requests including any number of 
levels of approvers.

You can configure notifications to be sent based on any status change so that all 
users are immediately notified via e-mail of important special pricing activity they 
should be aware of. You can access a summary list of all the special pricing requests 
that you have access to in the system, build personal views to quickly find the 
special pricing requests that you are most interested in.
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The key features are:

■ Partners can request special pricing, view the status of their special pricing 
request, and submit claims.

■ You can request special pricing on behalf of a partner.

■ You can review special pricing information and while approving a special 
pricing request, you can identify similar requests and link them.

■ You can automatically accrue liabilities on the maximum amount requested for 
similar requests. (optional)

■ You can gather competitive information for products. (Marketing)

■ You can create claims and see outstanding special pricing requests.

This chapter provides information on profiles, concurrent programs, lookups, and 
dependencies.

Setting Up Partner Funds Management
Partner Funds Management streamlines the submission, approval and tracking of 
fund requests as well as the submission, validating and tracking of claims. It 
enables you to better manage and distribute channel marketing funds to your 
channel partners. With a centralized marketing budgeting and claims management 
system, including a partner self-service interface to submit fund requests and 
claims, you can share channel marketing funds with your channel partners to 
motivate them, build loyalty and financially assist them with marketing activities 
that will further drive your sales. By assisting partners financially, a partner 
remains motivated and this helps in building loyalty as well. You can provide funds 
for a specific time period and base it on fiscal periods of your organization.

When a partner submits a request, it gets routed to the appropriate approver(s). 
Approvers will be notified of the request and they review the request and approve, 
decline, or return the request. When a request is approved and the partner executes 
the marketing activity, he/she can submit a claim to redeem money from you. The 
claim will be routed to the claim approver who will then validate the claim. When 
the claim gets approved, you can make the payment to the partner as credit or can 
issue a check. The system enables you to measure the effectiveness of your channel 
marketing expenditures by capturing expected performance on incoming requests 
and actual performance on the claims.

Partner Funds Management provides search capabilities that enables you to locate 
requests or perform analysis on marketing activity. You can configure Oracle 
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Workflow to organize the approval process for incoming requests including any 
number of levels of approvers.

You can configure notifications to be sent based on any status change so that all 
users are immediately notified via e-mail of any activity they should be aware of. 
You can access a summary list of all the fund requests that you have access to in the 
system, build personal views to quickly find the fund requests that you are most 
interested in, based on attributes like status or marketing activity.

You can set up a program benefit that enables partners enrolled in that program to 
request channel marketing funds.

The key features are:

■ Partners can request funds, review fund information, view fund status, submit 
collateral for approval, and submit claims.

■ Vendors can attach funds to partner programs, submit fund requests on behalf 
of a partner.

■ Vendors can define standard processes and for each activity type, they can 
define objectives, expense breakdown, approvals, and approvers.

■ Vendors can also create claims.

This chapter provides information on profiles, concurrent programs, lookups, 
geography and dependencies.
Introduction 1-13



Implementation Flow
1-14 Oracle Partner Management Implementation Guide



Mandatory Dependencies and Integra
2

Mandatory Dependencies and Integrations

This chapter provides an overview of mandatory dependencies and integrations 
needed to implement Oracle Partner Management. Topics included are:

■ Section 2.1, "Oracle E-business Suite Prerequisite Setup Overview"

■ Section 2.2, "Mandatory Dependencies"

■ Section 2.4, "Integrations"
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Oracle E-business Suite Prerequisite Setup Overview
2.1 Oracle E-business Suite Prerequisite Setup Overview
Oracle Partner Management has various prerequisite setups that range from 
supplying an underlying structure for Oracle Partner Management to those that 
extend its functionality and capabilities.

2.2 Mandatory Dependencies
Implementing these dependencies is required and must be complete before 
beginning an Oracle Partner Management implementation. For example, the Oracle 
Trading Community Architecture (TCA) provides a repository for customer and 
partner information. All customer and partner information used by Oracle Partner 
Management is stored in the TCA tables. Because this information is critical for 
Oracle Partner Management, TCA is a mandatory dependency, and must be setup 
properly.

The applications listed as mandatory must be setup prior to implementing Oracle 
Partner Management. Setups are generally partial and limited to basic functions 
that are specifically needed for Oracle Partner Management.

■ Section 2.2.1, "Oracle CRM Technology Foundation"

■ Section 2.2.2, "Setting Up Application Object Library"

■ Section 2.2.3, "Setting Up General Ledger"

■ Section 2.2.4, "Setting Up Oracle Human Resources"

■ Section 2.2.5, "Setting Up Oracle Inventory"

■ Section 2.2.6, "Setting Up Product Lifecycle Management"

■ Section 2.2.7, "Setting Up Oracle Receivables"

2.2.1 Oracle CRM Technology Foundation
Oracle CRM Technology Foundation provides a common infrastructure on which 
all CRM applications are built. By providing a set of application components, CRM 
Foundation ensures that all applications interact with key business objects in a 
consistent manner.

For more information about setting up CRM Foundation for Oracle Partner 
Management see:

■ Section 2.2.1.1, "Resource Manager"

■ Section 2.2.1.2, "Task Manager"
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■ Section 2.2.1.3, "1-to-1 Fulfillment"

■ Section 2.2.1.4, "Notes and Note Types"

■ Section 2.2.1.5, "Territory Manager"

■ Section 2.2.1.6, "Assignment Manager"

For detailed information about Oracle CRM Foundation see, Oracle CRM Application 
Foundation Implementation Guide.

2.2.1.1 Resource Manager
Resource Manager is mandatory for an Oracle Partner Management 
implementation. This component enables you to use application resources 
regardless of where they are created. Acting as a central repository - various types 
of resources, groups, teams, and roles can be created.

You can import resources such as employees, suppliers, parties, or partners, created 
in other applications. Once imported, the resource becomes available for other 
applications to use.

Resource Manager enables Groups, Roles, Role Types and Employee Import.

2.2.1.2 Task Manager
Task Manager is mandatory for an Oracle Partner Management implementation. It 
provides a mechanism for your application to respond to customer needs in a 
timely manner. Using Task Manager you can create, assign, manage, sort, and 
prioritize tasks. If implementing task transition rules, after defining a rule and 
assigning it an appropriate responsibility, set the following profile:

Task Manager: Default Task Status

If no rules are assigned to a responsibility, all statuses are displayed in the Status 
LOV. In this case, the Task Manager: Default Task Status does not need to be set.

2.2.1.3 1-to-1 Fulfillment
If you are using email, fax, print schedules, email notifications (or if you are using 
the features of email notifications on fulfillment rules) Oracle 1-to-1 Fulfillment is a 
mandatory setup. The fulfillment engine supports high volume electronic 
fulfillment of documents.

■ When implementing 1-to-1 Fulfillment the following conditions must be met: 
Fulfillment Server is created: A Fulfillment Server is an instance of the request 
processing software.
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■ Fulfillment Group is created: Fulfillment group is used to group agents (users) 
together.

■ JFT Fulfillment Admin role is assigned to the Implementor: This role gives 
access to the Fulfillment administration console for setting up fulfillment, 
creating master documents and viewing request history. This role and 
responsibility only needs to be assigned to a Marketing user only if he/she will 
also be administering the Fulfillment activities (for example, setting up 
Fulfillment servers, agents, etc.). Typically, only a Marketing Administrator is 
involved in these activities.

■ AMS: Enable Fulfillment is set to Yes.

2.2.1.4 Notes and Note Types
A complete notes implementation is optional. But some note functionality has to be 
set up to use Oracle Partner Management. This module is used to create, maintain, 
and share notes related to customers, opportunities, service requests, and other 
business objects.

Setting up note types is optional. Although Oracle Notes comes with a set of 
predefined note types, you can create customized note types. When using Oracle 
Partner Management, both the predefined set of notes and the customized notes are 
available. Refer to the Implementing notes section of the Oracle CRM Foundation 
Implementation Guide for additional information.

To create customized note types, use the following procedure:

Prerequisites
None.

Steps
1. Log into Oracle Forms with CRM Administrator responsibility and navigate to 

Notes Setup> Note Type Setup.

The Application Object Library: Note Types Lookups form opens.

2. Define a Lookup code and meaning.

3. Describe the Note Type meaning.

It is this description that will later be used to map the Note Type to the 
Marketing Object.

4. Add a short description and in the tag column enter a note.
2-4 Oracle Partner Management Implementation Guide



Mandatory Dependencies
5. Save your work.

6. To associate the Note Type with specific marketing objects, use the following 
procedure:

a. Navigate to Notes Setups > Source and Note Type Mappings.

b. Using the Source Object LOV, select the appropriate Marketing Object that 
will use this Note Type. For example, Campaign Schedule.

c. Using the Note Type LOV, select the new Note Type created. The Note 
Type LOV will display the text entered as the Note Type meaning.

d. Select an End Date for the Note Type Mapping.

e. Using the Application LOV, select Oracle Partner Management.

f. Save your work.

2.2.1.5 Territory Manager
Territory Manager is required for the channel manager dashboard since channel 
managers are assigned based on territories. Territory Manager is also required for 
referrals as claims are assigned based on territory definitions. It is also needed for 
opportunities and leads. 

Territory Manager provides an infrastructure to define territories based on flexible 
criteria, such as geography, zip code, area code. This engine creates automatic 
assignment of transactions across the entire CRM suite.

For example, leads and opportunities are routed through this engine to the 
appropriate sales professionals.

2.2.1.6 Assignment Manager
Implementing Assignment Manager is optional. The Assignment engine determines 
the best resource to be assigned to tasks based on availability and skill set. This 
engine is used by the various CRM modules to automatically assign tasks to a 
resource or a group of people.

Note: If a note type is not associated with a specific marketing 
object, it becomes available to all marketing objects.
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2.2.2 Setting Up Application Object Library
Oracle Applications Object Library (AOL) 11i enables a multiple language and 
currency setup for the Oracle Partner Management implementation. After being 
enabled, you can determine the set of languages and currencies to be used. 

For more information see, Oracle Applications Concepts and Oracle Applications System 
Administrator’s Guide.

2.2.3 Setting Up General Ledger
Basic accounting information for Oracle Partner Management is provided by Oracle 
General Ledger (GL). Because Oracle Inventory requires at least one organization 
and associated set of books, at least one business unit must be created in GL. 

For specific setup information see, Oracle General Ledger User Guide.

2.2.4 Setting Up Oracle Human Resources
Oracle Human Resources Management System (HRMS) stores information related 
to your organization. For an Oracle Marketing implementation, the following 
HRMS setups must be performed:

■ Section 2.2.4.1, "Determining the HRMS Navigation Path"

■ Section 2.2.4.2, "Creating Lookup Values for Organization Type"

■ Section 2.2.4.3, "Creating Locations"

■ Section 2.2.4.4, "Creating Business Groups"

■ Section 2.2.4.5, "Creating Organizations"

■ Section 2.2.4.6, "Assigning Security Profile"

■ Section 2.2.4.7, "Adding a Legal Entity, Operating Unit and HR Organization"

■ Section 2.2.4.8, "Creating A Business Unit"

■ Section 2.2.4.9, "Assigning Multi Org Responsibilities"

For information on how to perform these tasks, see Using Oracle HRMS - The 
Fundamentals.

2.2.4.1 Determining the HRMS Navigation Path
The responsibilities and navigation paths for performing HRMS tasks is different 
depending on the terms of your license (shared vs. full).
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■ Shared HRMS license: Create employees using CRM Foundation.

■ Responsibility: CRM Administrator

■ Navigation Path: CRM Foundation > Resource Manager > Maintain 
Employees > Employees

■ Full HRMS license: Create employees using HRMS.

■ Responsibility: HRMS Manager

■ Navigation Path: People > Enter and Maintain

2.2.4.2 Creating Lookup Values for Organization Type
In this step you are creating sub organization types. For example, if the 
organization is divided into business groups, then create an organization type 
called Business Group.

This procedure adds values for a specific lookup “Organization Types (ORG_
TYPE)”. If the organization is divided into subsidiaries, create an organization type 
called Subsidiary.

2.2.4.3 Creating Locations
In Oracle HRMS, you will set up each physical site where your employees work as a 
separate location. You can set up:

■ Global locations: Available in all Business Groups.

■ Business Group locations: Available in one Business Group.

Similarly, you enter the addresses of external organizations that you want to 
maintain in your system, such as employment agencies, tax authorities, and 
insurance or benefits carriers. When setting up internal or external organizations, 
you select from a list of these locations.

2.2.4.4 Creating Business Groups
The business group is the largest organizational unit representing the enterprise. A 
Business Group may correspond to a company or corporation, or in large 
enterprises, a holding or parent company. It can be an organization with a physical 
location, or it may be an abstract representation of a legal entity that employs 
people assigned to work in organizations beneath it.

A default business organization has been set up for you, therefore this step is not 
required for Oracle Partner Management to be fully operational. However, you 
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must set up an organization if you plan to use any financial ERP applications in the 
future.

2.2.4.5 Creating Organizations
The first organization to set up is the Business Group, all other organizations will 
fall below (will belong to) it. Below the Business Group, you represent the 
groupings in which employees work, such as branches, departments or sections, by 
means of internal organizations. To enable the assignment of employees to an 
internal organization, you classify it as an HR Organization.

2.2.4.6 Assigning Security Profile
In this step, you will be defining the security level for specific Partner 
Responsibilities. To do this, use the profile HR: Security Profile. This profile enables 
access (based on responsibility) to a single business group.

To assign the security profile use the following procedure:

Prerequisites
None.

Steps
1. Log into Oracle Forms with the System Administrator responsibility and 

navigate to Profile > System.

The Find System Profile Values window opens.

2. In the Application field enter Oracle Partner Management.

3. In the Responsibility field search and select the responsibility for which the 
profile is being set.

4. In the Profile field enter HR: Security%.

5. In the HR: Security Profile, at Site level, select an organization.

The organization selected is the business group that users will have access to. 
They will have access only to records within this business group.

6. Save your work.

Validate that the setting for HR: Business Group is the same organization as the 
HR: Security profile.
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2.2.4.7 Adding a Legal Entity, Operating Unit and HR Organization
To perform the HRMS task of creating a Legal Entity, Operating Unit, and 
Organization, follow the procedure below:

Prerequisite
Set of Books.

Steps
1. Log into Oracle Forms with the appropriate HRMS Manager responsibility and 

navigate to Work Structure > Organization > Description.

The Find Organization form opens.

2. Search and select your organization.

3. Place your cursor in the Organization Classification Name field.

4. Using the LOV select GRE/Legal Entity.

5. Select the Enabled radio button.

6. Save your work and close this form (the Organization form will still be open in 
the background).

7. Select Others.

8. Select GRE / Legal Entity.

9. Select a Set of Books (defined above).

10. Click OK.

11. Save your work.

12. Add an Operating Unit:

a. Under Organization Classifications Name, add Operating Unit.

b. Click the ellipsis to select a classification.

c. Select a Legal Entity.

d. Click Others.

e. Select Legal Entity Accounting.

f. Select a set of books.

g. Click OK.
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h. Enable by selecting the checkbox.

i. Save your work.

13. Add an HR Organization:

a. Under Organization classifications name, add HR Organization from the 
LOV.

b. Enable by selecting the checkbox.

c. Save your work.

d. Click Others to enter additional information.

e. Save your work.

14. Close the form.

2.2.4.8 Creating A Business Unit
To create a new Business Unit, use the following procedure:

1. Log into Oracle with the appropriate HRMS responsibility and navigate to 
Work Structure > Organization > Description.

2. Select New.

3. Fill in Name of Business Unit.

4. Select Type (Business Unit).

5. Select a Location.

6. Select an Organization Classification.

7. Select Internal or External.

8. Save your work.

2.2.4.9 Assigning Multi Org Responsibilities
Oracle Partner Management requires the implementation of a Multiple 
Organization Structure. Please refer to Multiple Organization in Oracle 
Applications for additional information.

You can assign Multi Org related profiles to a selected Oracle Partner Management 
responsibility. For example, MO: Operating Unit profile. This displays the 
appropriate Business Unit when using that responsibility.
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2.2.5 Setting Up Oracle Inventory
Oracle Inventory serves as the repository for items that can be used in Oracle 
Partner Management. Use Oracle Inventory to create new products or collateral. 
After creating new inventory products or items you can add them to a Marketing 
Campaign or Event. Products or items stored in Oracle Inventory reside in the 
MTL_SYSTEM_ ITEMS table.

Oracle Inventory requires one inventory organization to be identified. Typically this 
is the Master Inventory Organization. In a multiple operating unit environment, the 
Master Inventory Organization should consist of all the products from all the 
operating units, it serves as the highest organizational level.

If you need to separate products (sold from each operating unit) into different 
inventory organizations, create a separate inventory organization for each operating 
unit. These operating units should exist only as subsets of the Master Inventory 
Organization.

Implement Oracle Inventory as described in the Oracle Inventory Implementation 
Guide.

2.2.6 Setting Up Product Lifecycle Management
Oracle Partner Management derives its product data using the product catalog 
provided by Product Lifecycle Management (PLM). PLM provides a product 
hierarchy located in the OLTP schemas. This hierarchy is maintained by the user in 
a Product Catalog and is expanded to a de-normalized table (designed for efficient 
traversal) by the Sales and Marketing applications.

For information on defining product categories, see Oracle Advanced Product Catalog 
User Guide.

2.2.7 Setting Up Oracle Receivables
Oracle Partner Management uses Oracle Receivables to record customer 
information. Customer registration information is maintained in the Trading 
Community Architecture (TCA). TCA stores all customer, partner, prospect, and 
other customer related information in a single repository. This enables consistent 
message delivery across all channels.

At a minimum, you need to perform the required Oracle Receivables setups, 
defining system options including tax options and address validation, as described 
the Oracle Receivables User Guide.
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2.3 Creating the Implementation User
Each user (or type of user) has a specific collection of responsibilities. Before 
assigning responsibilities to a user, the employee must be created in HRMS. After 
the employee has been created, you can create the user and assign responsibilities 
and a default application ID.

To create marketing users, see the following:

■ Section 2.3.1, "Creating the Employee"

■ Section 2.3.2, "Defining a User by Adding Responsibilities"

■ Section 2.3.3, "Importing the Employee"

2.3.1 Creating the Employee
The first step in creating a user is creating the employee in HRMS.

Prerequisites
None.

Steps
1. Log into Oracle Forms with the HRMS Manager Responsibility and navigate to 

People > Enter & Maintain.

2. In the Find Person box, select New.

3. Enter relevant information and save your work.

A confirmation appears in the window.

4. Select Assignment and enter values in the Organization, Team/Group, 
Location, and Supervisor fields.

If a dialog box with Update and Correction buttons is displayed, select 
Correction to revise existing data and Update to create a new record.

5. Save your work.

A confirmation appears in the window.

6. Select Yes to use the new location.

7. Save your work.
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2.3.2 Defining a User by Adding Responsibilities
After creating the employee in HRMS, you can create an user account for the 
employee and add responsibilities to it.

Based on your functional requirements, add one or more of the following 
responsibilities to your user.

Prerequisites
Employee is created

Steps
1. Log into Oracle Forms with the System Administrator responsibility and 

navigate to Security > User > Define.

The Users window opens.

2. In the User Name field, enter a name. Also enter password and choose the 
employee.

3. In the Responsibilities block, assign the appropriate responsibilities to the 
Implementation User.

4. Save your work.

2.3.3 Importing the Employee
Use the following procedure to import the employee as a resource.

Prerequisites
Employee should exist.

Steps
1. Log into Oracle Forms with the CRM Administrator responsibility and navigate 

to Resource Manager > Maintain Resources > Import Resources.

2. Locate the employee.

3. Enter employee’s name in the name fields.

4. Select Search.

5. Select Create Resource.

6. Click OK to accept default values.
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7. Click Save Resource (record the transaction number).

2.4 Integrations
Table 2–1 describes the integration flow of Oracle Partner Management with other 
products.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description

Programs Oracle Content Manager When a vendor creates programs, he/she can 
create a summary of the program which 
reflects details of a program. The summary is 
HTML content that is displayed to partners to 
help them understand program requirements, 
benefits, and so on. The summary can be the 
setup type, name, program start and end 
dates, owner, partner type, country, language, 
and description. Program summary can be set 
up by navigating to the enrollment 
questionnaire and clicking on the Program 
Overview button.

Programs Oracle Contracts When partners enroll into a program, they 
might be expected to sign a contract. Global 
partners can be presented with contracts that 
differ from contracts presented to standard 
partners. Multiple contracts can be associated 
to a program. The contracts are tied to the 
member type. Oracle Partner Management 
leverages the Oracle Contracts Core 
functionality to create and attach one or more 
contract templates to each program.

Program 
Approval

Oracle Marketing For a program to be active, it needs to be 
approved. Approvers are set up using 
program types. When a user creates a 
program with a ‘program type’ and submits it 
for approval, a notification is sent to the 
approver associated with the program type. A 
sequence can be associated with approvers to 
route approval requests sequentially. The 
Oracle Marketing Framework (AMS: Generic 
Approval Framework) is used to route 
approval requests, notifications, and get 
approvals.
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Programs Oracle Advanced Pricing When partners enroll into a program, they are 
charged a price or a fee. Price lists are created 
in Oracle Advanced Pricing or Oracle Order 
Management based on the profile value ‘QP: 
Source System Code’ set in Oracle Partner 
Management at the application level. The 
value needs to be ‘Oracle Pricing’. Multiple 
prices can be defined by associating a 
program with multiple price lists. If multiple 
price lists are associated, vendors need to 
define precedence so that the appropriate 
price is selected. The multi-currency feature of 
Oracle Advanced Pricing enables price lists to 
select the appropriate price.

Programs Oracle Order 
Management

If a program is priced and a partner enrolls in 
it, a sales order is created using Oracle Order 
Management. Also, price lists are created in 
Oracle Advanced Pricing or Oracle Order 
Management based on the profile value ‘QP: 
Source System Code’ set in Oracle Partner 
Management at the application level.

Programs Oracle Inventory To support order creation, the program needs 
to be present as inventory item. So, when a 
program is created, an inventory item is also 
created. Hence, Oracle Inventory needs to be 
set up correctly.

Programs Oracle Trade 
Management

Oracle Trade Management is used to create 
offers to provide discounts, which in turn 
uses Oracle Advanced Pricing.

Enrollments Oracle Order 
Management

Oracle Order Management is used to process 
sales orders when a partner submits an 
enrollment request for a program that 
contains fees. It is used to process financial 
liabilities. Oracle Order Management is also 
used to process orders for different payment 
modes such as cash, check, credit card and 
purchase order

Enrollments Oracle iPayment Server If partners use the credit card payment mode 
to pay fees, the iPayment Server is used to 
process payment.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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Enrollments Oracle Receivables The payment billing address has to be 
validated against tax locations. For this, the 
address validation option in Oracle Accounts 
Receivables needs to be set up.

Enrollments Oracle Approvals 
Management

Approvers for enrollment requests are setup 
in Oracle Approvals Management.

Opportunity 
Management

Oracle Sales Online Opportunity management for partners 
leverages the Sales Online opportunity 
module to support the assignment of indirect 
opportunities to partners. With this extension, 
vendors can route opportunities to partners.

Opportunity 
Management

Oracle Leads 
Management

When a lead is created and the lead engine 
determines that it is a valid lead and should 
be channeled as indirect, the lead may be 
converted to an indirect opportunity and 
routed to partners by the partner-matching 
engine.

Opportunity 
Management

Oracle Marketing Users can create and execute an email 
campaign schedule as well a web campaign 
schedule to target partners. For campaigns 
targeted at partners that result in indirect 
opportunities, vendors can route these 
opportunities to partners that participated in 
the campaigns.

Opportunity 
Management

Oracle Inventory You can assign a product to an opportunity.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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Referral 
Management

Oracle Trade 
Management

Vendors can compensate partners through 
Oracle Trade Management in the areas of 
offers, budgets and claims.

Budget - Vendors can source the referral 
benefit from one or more fixed and active 
budgets to pay out the partner's 
compensation.

Offer - A Net Accrual Offer is created for each 
referral benefit using the budget specified in 
the benefit. All referrals created using this 
referral benefit accrue against this offer. The 
offer is created in the background when the 
benefit is activated.

Claims - A claim is generated by the system 
when a referred customer order is shipped. 
This is the means by which referral 
management system compensates a partner 
for referral submitted.

Referral 
Management

Oracle Approvals 
Manager

This is used to identify approvers for referrals 
submitted and also to identify the person 
responsible for checking customer duplicates 
and de-duplication on a referred customer.

Referral 
Management

Oracle Customer Data 
Quality Manager

Referral Management leverages TCA-DQM 
functionality to find potential customer or 
contact matches in the system for the referred 
customer and contact. This reduces the 
occurrences of creating duplicate parties in 
the system.

Referral 
Management

Oracle Territory Manager Territories are used to define the geographic 
boundaries for which the deal benefit is 
applicable. These territories are defined under 
trade management usage with transaction 
type ’Offers’. For this release only the 
’Country’ qualifier is supported.

Referral 
Management

Oracle Sales Online and 
Oracle Leads 
Management

Referrals, when approved, create leads or 
opportunities depending on the referral 
benefit. Referral is fully integrated with 
Oracle Sales Online and Oracle Leads 
Management and enables the cross navigation 
between a referral and a lead or opportunity.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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Referral 
Management 

Partner Programs Referral Management is implemented as a 
benefit that can be attached to any partner 
program. Partners, by enrolling into a 
program which has referrals as a benefit, gain 
access to the Referral Management 
functionality.

Referral 
Management 

Oracle Workflow Integration with Oracle Workflow enables 
vendors to configure e-mail notifications for 
each referral status change.

Deal 
Registration

Oracle Approvals 
Manager

This is used to identify approvers for deals 
submitted and also to identify the person 
responsible for checking customer duplicates 
and de-duplication on a registered customer.

Deal 
Registration

Oracle Territory Manager Territories are used to define the geographic 
boundaries for which the deal benefit is 
applicable. These territories are defined under 
trade management usage with transaction 
type ’Offers’. For this release only the 
’Country’ qualifier is supported.

Deal 
Registration

Oracle Customer Data 
Quality Manager

Deal Registration leverages the TCA-DQM 
functionality to find potential customer or 
contact matches in the system for the 
registered customer and contact. This reduces 
duplicate parties in the system.

Deal 
Registration

Oracle Sales Online Deals, when approved, create opportunities. 
Deal registration is fully integrated with 
Oracle Sales Online and allows the cross 
navigation between a deal and an 
opportunity.

Deal 
Registration

Partner Programs Deal Registration is implemented as a benefit 
that can be attached to any partner program. 
Partners, by enrolling into a program that has 
deals as a benefit, gain access to the Deal 
Registration functionality.

Deal 
Registration

Oracle Workflow Integration with Oracle Workflow enables  
configuration of e-mail notifications for each 
deal status change.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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Special Pricing 
Management- 
Offers

Oracle Trade 
Management

When a special pricing request is approved, 
an offer is generated. Offers are created in 
Oracle Trade Management and the types of 
offers are:

■ ScanData Offer - This offer is generated in 
the Existing Inventory scenario. The offer 
enables vendors to 'reimburse' partners 
for the discounted amount on products 
that partner have already bought.

■ Off Invoice Offer - This offer is generated 
in the New Inventory scenario. This offer 
acts as a pricing modifier for future 
orders. Vendors can see the Offer Type 
field during approval if the Ship from 
Stock check box is not selected. An 
authorization code is generated for the 
partner upon approval, which needs to 
be used when booking the order to 
receive the discount. If vendors specify 
this type of offer, partners do not have to 
submit a claim.

■ Accrual Offer - This offer is generated in 
the New Inventory scenario. This offer 
acts as a pricing modifier for future 
orders. Vendors can see the Offer Type 
field during approval if the Ship from 
Stock check box is not selected. An 
authorization code is generated for the 
partner upon approval, which needs to 
be used when booking the order to get 
the discount. If vendors specify this type 
of offer, partners have to submit a claim 
to receive the approved discount.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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Special Pricing 
Management - 
Budgets

Oracle Trade 
Management

A default budget can be set up for sourcing 
special pricing requests. When a default 
budget exists, the system generates a budget 
request for the requested amount upon 
submission. The Budget tab can be configured 
to appear/not appear for the approvers. 
When the budget tab appears, approvers can 
change the budget sourcing options. If the 
approvers do not change the sourcing option, 
system automatically adjusts the budget 
amount based on the approved amount. 
Approvers can source only from budgets they 
have access to.

Special Pricing 
Management- 
Claims

Oracle Trade 
Management

After a sale is completed at the discounted 
price, the partner can submit a claim to collect 
payment. Optionally claims can be submitted 
along with the sale data as a proof of 
performance through the Indirect Sales 
Management module of Trade Management. 
Claims are validated in Oracle Trade 
Management.

Claims have to be submitted in the same 
vendor organization as the special price 
request is approved. 

For information, see Oracle Trade Management 
Implementation Guide.

Special Pricing 
Management

Oracle Approvals 
Manager

This is used to identify approvers for special 
pricing requests submitted and also to 
identify the person responsible for checking 
customer duplicates and de-duplication on a 
referred customer.

Special Pricing 
Management

Oracle Customer Data 
Quality Manager

Special Pricing Management leverages 
TCA-DQM functionality to find potential 
customer matches in the system for the 
referred customer. This reduces the 
occurrences of creating duplicate parties in 
the system.

Partner Funds 
Management - 
Offers

Oracle Trade 
Management

When a fund request is approved, an offer of 
type lumpsum is generated. All lumpsum 
offers created use the seeded custom setup 
'Soft Fund - Lumpsum'.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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Partner Funds 
Management - 
Budgets

Oracle Trade 
Management

Budget request approval can be enabled or 
disabled for funds requests from the 'Soft 
Fund - Lumpsum' custom setup. Approvers 
would be able to source only from budgets 
they have access to.

Partner Funds 
Management - 
Claims

Oracle Trade 
Management

After a request is approved and the partner 
has executed the desired activity, they can 
submit a claim to collect payment. Claims are 
validated in Oracle Trade Management. 
Claims have to be submitted in the same 
vendor organization in which the fund 
request is approved. 

For information on claims, see Oracle Trade 
Management Implementation Guide.

Partner Funds 
Management

Oracle Approvals 
Manager

This is used to identify approvers for fund 
requests submitted.

Table 2–1 Integrations With Other Applications

Task/Flow Product Description
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User Management

This chapter provides information on user types and responsibilities. Topics 
included are:

■ Section 3.1, "Overview"

■ Section 3.2, "Responsibilities"

■ Section 3.3, "Setups"

■ Section 3.4, "Profile Options"

■ Section 3.5, "Lookups"
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3.1 Overview
User management is the process of registering a user and thereafter maintaining the 
user in the system by granting or revoking privileges, accounts, customer profile 
information, and party relationships based on a set of business requirements. User 
management involves registering new users, modifying existing users, approving 
or rejecting user approval requests, setting up enrollments and registration 
templates, assigning users to business accounts, and more. The technology stack for 
performing most of the background setups and processes for user management is 
supplied through the Oracle CRM Technology Foundation and Oracle Common 
Application Components.

Oracle Partner Management also has a comprehensive set of user management 
capabilities, including the ability to register users, configure registration pages, 
approve users, and manage user profile information.

For complete information on utilizing the capabilities of the Oracle CRM 
Technology Foundation and Oracle Common Application Components, see the user 
management chapters of:

■ Oracle Applications CRM System Administrator’s Guide

■ Oracle Common Application Components Implementation Guide

■ Oracle Common Application Components User Guide

3.2 Responsibilities
Responsibilities are set up as part of system administration and is used across the 
Oracle e-Business Suite to give functional access to applications. Channel managers, 
sales representatives etc. are assigned responsibilities when their accounts are 
created.

Partners are assigned responsibilities based on their program enrollments and 
geography through the responsibility mapping table. Channel administrators can 
set up different responsibilities for different program and geography combinations. 
Based on the geography and the program that a partner enrolls in, a partner is 
granted the responsibility (primary user or business user). When the channel 
administrator adds, changes or deletes a responsibility, the concurrent program ’PV 
- Assign/Revoke user responsibilities’ is automatically run to update partner 
responsibilities. The partner responsibilities are automatically updated when the 
channel administrator updates the responsibility tied with a rule.

For partners, responsibilities are determined based on the exact geographical region 
match, user type, and program. 
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In the Responsibility mapping screen, while selecting a responsibility, the LOV uses 
the following criteria to filter responsibilities:

■ Responsibility application has to be Oracle Partner Relationship Management 
for it to show up in the Responsibilities LOV in the Responsibility Mapping 
Rules UI.

■ PV: Is External Responsibility profile option needs to be set to Yes at the 
responsibility level for responsibilities that should show up in the 
Responsibilities LOV in the Responsibility Mapping Rules UI.

By default, a new partner user is assigned one of the responsibilities mentioned 
below, based on his/her user type:

■ Primary User: Partner Super User

■ Business User: Default Partner User

Newly registered partner users are assigned default responsibilities when the 
system cannot find any program responsibilities based on their enrollments into 
programs. These default responsibilities are figured out by matching the partner’s 
address to the closest geography match and user type of responsibility mapping 
rules without any program attached. Oracle Partner Management ships two default 
responsibility mapping rules with the default partner user responsibility, without 
any program attached, and geography defined as ’World’ and one for two partner 
user roles. 

3.3 Setups
The following sections provide information on setups that are required for setting 
up users:

■ Section 3.3.1, "Creating a Channel Manager"

■ Section 3.3.2, "Creating a Partner"

■ Section 3.3.3, "Converting a Customer to a Partner"

■ Section 3.3.4, "Partner Self Service Registration"

3.3.1 Creating a Channel Manager
For information on creating a channel manager, see Section 6.2.1, "Creating a 
Channel Manager".
User Management 3-3



Setups
3.3.2 Creating a Partner
In this release, a partner can be created in three ways:

■ Inviting them to enroll into programs.

■ Converting existing customers to partners. For information on how to convert 
existing customers to partners, see Section 3.3.3, "Converting a Customer to a 
Partner".

■ Partners can register themselves via the self-service registration process. For 
information on how partners can register themselves, see Section 3.3.3, 
"Converting a Customer to a Partner".

The channel manager or channel representative can invite new partners to enroll 
into a program. They can capture basic information about the partner organization, 
address details, partner contact details and program related information in which 
the channel manager or channel representative wants to enroll this organization. An 
invitation is sent to the newly created partner contact via e-mail.

Vendors can charge fees from partners for enrolling into a program and also offer 
discounts to attract partners. The discount can be a percentage amount or an 
absolute amount.

Use this procedure to invite a new partner.

Prerequisites
None.

Steps
1. Log in as a channel manager and navigate to Partners Quick Link > Partner 

Summary page.

2. Click Invite New Partner.

The Create Partner page appears.

3. Enter details in the Address and Contact Information region and click Next.

The Create User page appears.

4. Select a default currency.

5. Enter a login user name/password for the partner.

6. Select a user type.

The user types are Business and Administrator.
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7. Click Next.

The Invite Partner page appears.

8. Select a program from the Program Name drop-down list.

9. Enter any discounts if applicable.

10. Enter details in the Enrollment Fees region and click Invite Partner.

3.3.3 Converting a Customer to a Partner
You may have many customers and any customer can become a partner of your 
organization. You can convert an existing customer to a partner at any given point 
in time. You can choose any existing customer who is not yet a partner. Before 
converting a customer, you must decide the Partner type and Member type that the 
converted customer will fall under. When the customer is converted to a partner, 
the partner will be enrolled in the default program. After conversion, the partner 
will be directed to the Partner Details page.

Use this procedure to convert existing customers to partners.

Prerequisites
None.

Steps
1. Log in as a channel administrator and navigate to Partners > Convert Customer 

to Partner page.

The Partner Conversion page appears.

2. Select a customer from the Customer Name LOV (filtered on organizations 
without a partner relationship).

3. Enter partner specific information such as Partner Type and Member Type.

If you select the ’Subsidiary’ Member Type, the Global Partner LOV will be 
enabled.

Partner’s Channel Team

■ If you are a channel manager, you will be added to the partner's channel 
team in addition to the channel managers returned by the Territory 
Assignment Program.
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■ If you are not a channel manager, channel managers returned by the 
Territory Assignment Program will be assigned to the partner.

■ If the Territory Assignment Program does not return any channel manager, 
and the logged in user is not a channel manager the Default channel 
manager will be assigned to the channel team. For more information on the 
Territory Assignment Program, see Territory Assignment Program.

4. Click Convert to Partner to convert the customer to a partner.

Upon conversion, the partner should be enrolled in the Default Program set per 
the profile option. You can now manage the partner contact and their user 
information.

Territory Assignment Program
This release provides a territory based security model to access partner information. 
When a partner is created, the system automatically identifies the channel 
manager(s) to be assigned based on the territory definition. You can define 
territories and specify territory qualifiers, such as geography, partner type etc. for a 
territory. For example, territory A could mean all the states in the East Coast of the 
U.S. that have global partners (global membership type). While defining a territory, 
you can also specify the channel manager responsible for that territory. For 
example, territory A (Dallas) has Greg defined as the channel manager. If the newly 
created partner (NP) is from Dallas, Greg will automatically be assigned to NP as 
the channel manager by the system Territory definitions can change over time. You 
can also manually assign users to partner organizations thereby bypassing the 
territory definition. Users with the 'Super User' role can access all partners 
irrespective of the territory definition.

3.3.4 Partner Self Service Registration
Partners can register themselves or their organization from the ’Register Here’ link 
or by using any other custom link like 'Register My Partner Organization' provided 
on any page during implementation.

The registration process is initiated and the partner is guided through a series of 
steps to submit the company and user information. Once this information is 
submitted, Oracle Partner Management generates a user account for the partner. 
The partner is provided a user name and password to log into the partner 
dashboard. The partner receives an e-mail notification with user name, password 
and organization identifier number.

A partner registered here is always registered as a partner administrator.
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Partners can also create user accounts for users belonging to the organization using 
the self-registration process. Once the partner organization is registered, the partner 
administrator can create additional partner administrators or partner users.

Use the following procedure to register via self-service.

Prerequisites
None.

Steps
1. Log into Oracle iStore and select the Login icon. 

2. Click New User Registration.

3. Select the Register as a partner option.

4. Click Next.

5. Enter organization details such as company name, address etc.

6. Enter personal details such as name, address, user name and password etc.

7. Select one or more Partner Types that become part of the profile.

8. If the partner is a subsidiary partner, enter the identification information of the 
global partner.

Once the registration is successful the confirmation is displayed and partners 
can log into the partner dashboard using the newly created user account.

3.4 Profile Options
Table 3–1 lists the profile options that need to be set up for responsibilities.
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3.5 Lookups
Table 3–2 lists lookups that need to be set up for User Management.

Table 3–1 Profile Options

Profile Name

Required

-Yes/ 
Optional

Level - 

Site/ 
Application/ 
Responsibilit
y/User

Setting - 
Available 
setting 
choices Description

PV: Is External 
Responsibility

Yes Responsibility Value is 
set to Yes

Setting this value to ’Yes’ 
indicates that this 
responsibility can be 
assigned to an external 
user. For a responsibility 
to be displayed in the 
Responsibility LOV under 
’Responsibility Mappings’ 
this profile needs to be set 
to ’Yes’.

Table 3–2 Lookups

Lookup Type Value Description

PV_USER_ROLES BUSINESS

PRIMARY

ALL

Business User (Partner User)

Primary User (Partner 
Administrator)

All
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Setting Up Profile Attributes

This chapter provides information on attributes used during implementation. 
Topics included are:

■ Section 4.1, "Overview"

■ Section 4.2, "Partner Attributes"

■ Section 4.3, "Setting Up Custom Attributes"
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4.1 Overview
Attributes provide important characteristic information on Oracle Partner 
Management business entities such as partners, partner contacts, leads, 
opportunities and so on. This helps companies increase knowledge of their 
partners' demographics, contacts and capabilities, such as who they are, what they 
sell, where they sell, what industries they focus on, what certifications they have, 
and so on. Thus, attributes are set up to capture additional specific business 
information for a given business entity within Oracle Partner Management. 

To effectively manage partners and partner contacts, vendors need to collect an 
extended partner and contact profile. They can collect the profile information 
during the registration and enrollment process. The profile information can be 
updated by the partner and the channel manager and might require validation by 
the channel manager. 

Oracle Partner Management provides an extensible framework to manually or 
automatically capture any kind of information about your partners, including 
performance measures and data derived from external sources. After you have 
defined attributes, the channel manager or the partner can enter profile information 
while enrolling into programs. The framework supports fixed attributes, 
information entered by the partner or channel manager, and derived attributes, 
information calculated based on partner data and transactions. Channel managers 
can use this information to differentiate partners and provide better services, such 
as fund requests, incentives, and opportunities.

Features in this Release
■ Seeded Attributes - Vendors can track a partner’s performance using seeded 

attributes.

■ New Seeded Category - One new seeded category ’Marketing’ has been added 
to support new attributes that are seeded as well.

■ Performance attributes are seeded. Trends can be viewed by the time period for 
all performance attributes and trends can only be viewed from the performance 
tab.

■ Derived attributes support the ’List of Values’, ’Currency’, ’Date’, ’Percentage’, 
’Numeric’, and ’Text’ value types. The display style has been renamed to 'Value 
Type' for derived attributes. The ’List of Values’ value type is used when you 
use a derived attribute in a rule. If the value type is 'List of Values’, the user 
interface (UI) displays a drop-down list and users can select a value instead of 
entering it.
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■ A new value type, ’PERCENTAGE’ is added to the Text and Derived attribute 
types to support performance related attributes that are rendered with % 
appended to the value.

Vendors can also:

■ View a partner contact’s profile information.

■ Track attribute value history and view snapshots of attribute values.

■ Create profile attributes that require validation.

■ Allow attributes to be configured to be exposed to partners.

Attribute Value History and Snapshot of Attribute Values
Profile attribute values are constantly being updated by either partners, vendors, or 
programatically. Vendors can now track changes since attributes impact partner 
matching.

Vendors can see who made the change (user, or system), when the changes were 
made, and what the values are. For derived values, the attribute changes are 
logged, but not displayed.

Vendors can view a partner's attribute values any time. By selecting a date, the 
system returns a snapshot view of what the values were at that time.

Profile Attributes that Require Validation
Vendors can define a profile attribute that requires validation when a new value is 
entered. The partner submits the validation to the channel manager and the channel 
manager validates it. For more information, see Section 4.3, "Setting Up Custom 
Attributes".

4.2 Partner Attributes
Oracle Partner Management enables vendors to use profile attributes to segment 
their partners. Attributes can be used to create and track additional information 
about a partner or an opportunity. The application provides intelligent matching 
based on these profile attributes to ensure that opportunities are routed to the 
correct partner.

Attributes are available to a partner if the particular partner type has been specified 
while defining the attribute. Vendors can create attributes and flag it as ’require 
data validation’. This means that whenever a partner user adds or updates an 
attribute value, e-mail notifications are sent to channel managers of that partner. For 
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e-mail notifications to be sent, the profile ’PV: Enable Workflow To send e-mails’ 
must be set to Yes.

When an attribute is defined for the first time and the ’Expose to Partner’ check box 
is selected, the attribute is visible under the Company Profile.

Profile Attributes Types and Display Styles
Profile attributes can be grouped into different types and display styles. This 
ensures better quality of data and better integration with other parts of the 
application such as Enrollments.

Attributes that have display styles of radio button, drop-down, multi-select and 
check box can toggle between radio button and drop-down options, and between 
multi-select and checkbox options. Users can change the display styles from the 
Attributes Summary page or Attribute Details page by navigating to the 
Administration tab > Partner horizontal navigation link > Attributes side 
navigation link. For more information, see Section 4.3, "Setting Up Custom 
Attributes".

Table 4–1 lists all the attribute types and display styles.

Table 4–1 Attribute Types and Display Styles

Attribute Type Display Style Can Users Create?

List of Values 

List of Values 

List of Values 

List of Values 

List of Values 

List of Values 

Check Box

Multi Select

Percentage

Radio Button

Drop Down 

External LOV

Yes

Yes

Yes

Yes

Yes

No

Text Box

Text Box

Text Box

Text Box

Text Box

Text Box

Currency

Date

Numeric

Text

Percentage

Check Existence

Yes

Yes

Yes

Yes

Yes

No
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4.2.1 Attribute Categories
Attributes can be organized into different functional categories. 

In this release, one new category, ’Marketing’ has been added to support new 
attributes that are seeded. Vendors can set up new categories in Oracle Forms, by 
adding new lookup values to the lookup type ’Attribute Categories (PV_
ATTRIBUTE_CATEGORY_TYPE)’.

Users can create additional categories during and post implementation.

Seeded Attributes
Seeded attributes are identified by a ’*’ prefixing their name. Vendors can modify 
seeded attributes by:

■ Enabling or disabling seeded attributes

■ Changing the attribute category 

■ Changing the display style

■ Refreshing Frequency

Table 4–2 displays seeded attribute values that are grouped in the General, Sales, 
and Marketing categories.

Derived

Derived

Derived

Derived

Derived

Derived

Currency

Date

Numeric

Text

List of Values

Percentage

Yes

Yes

Yes

Yes

Yes

Yes

Table 4–1 Attribute Types and Display Styles

Attribute Type Display Style Can Users Create?
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Table 4–2 Seeded Attributes

Attribute Name Description Category Display Style Enabled For

Additional 
Channel Offering

Additional services provided by the 
partner (Implementation specific)

General Multi-Select Partner

Capacity Rating Partner's capacity rating 
(Implementation specific)

General Drop-down Partner

Claims Paid Total claim settlement amount paid 
for soft funds and special pricing 
request based on settlement date

Marketing Currency Trend

Claims Paid YTD Total claim amount paid for soft 
funds and special pricing request 
based on settlement date during the 
current fiscal year

Marketing Currency Partner

Country Countries that the partner has a 
presence in

General Multi-Select Partner

Customer Annual 
Revenue

Annual revenue of the partner as 
stored in TCA table

General Currency Partner

Deals Accepted                                              Total deal amount accepted based on 
deal creation date

Sales Currency Trend

Deals Accepted 
Count

Total number of deals accepted based 
on deal creation date

Sales Numeric Trend

Deals Accepted 
YTD

Total deal amount accepted based on 
deal creation date during the current 
fiscal year

Sales Currency Partner, KPI

Deals Close Rate Deals Closed Count/Deals Accepted 
Count

Sales Percentage Partner

Deal Closed Amount of total number of closed 
opportunities, based on the date the 
deal status changes to 'Closed. 
Opportunity Won’

Sales Currency Trend

Deals Closed 
Count

Total number of closed opportunities 
based on the date the deal status 
changes to 'Closed. Opportunity Won'

Sales Count Trend

Deals   Closed 
YTD

Amount of total number of closed 
opportunities, where the deal status 
changes to 'Closed. Opportunity Won' 
during the current fiscal year

Sales Currency Partner
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Deals Submitted 
Count

Total number of deals that are not in 
draft status based on deal creation 
date

Sales Count Trend

Deals Submitted 
YTD Count

Total number of deals that are not in 
draft status based on deal created 
during the current fiscal year

Sales Count Partner

Deals accepted 
YTD count

Total number of deals accepted based 
on deal created during the current 
fiscal year

Sales Count Partner, KPI

Functional 
Expertise

Partner expertise with regards to 
vendor product or service offering

General Multi-Select Multi-Select

Funds Paid Total settlement amount paid for fund 
requests based on the settlement date

Marketing                                                                                                        Currency Trend

Funds Paid YTD Total settlement amount paid for fund 
requests based on settlement date 
during the current fiscal year

Marketing                                                                                                        Currency Partner, KPI

Funds Requested Total amount requested for fund 
requests based on the submitted date

Marketing                                                                                                        Currency Trend

Funds Requested 
YTD

Total amount requested for fund 
requests based on the submitted date 
during the current fiscal year

Marketing                                                                                                        Currency Partner, KPI

Geographic 
Coverage

Partner's Geographic Coverage 
(Implementation specific)

General Multi-Select Partner

Inactive Partners Total number of active partners that 
have not placed an order (where 
partner is the 'sold-to') in the time 
span specified by the profile ' PV: 
Inactive Partners Time Window'

General Count KPI

Indirect Sales Total amount based on the transaction 
date. This information is captured by 
Oracle Trade Management from the 
Point-of-Sale system

Sales Currency Trend

Indirect Sales Prior 
year

Total amount based on transaction 
date during last fiscal year. This 
information is captured by Oracle 
Trade Management from the 
Point-of-Sale system

Sales Currency Partner

Table 4–2 Seeded Attributes

Attribute Name Description Category Display Style Enabled For
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Indirect Sales YTD                              Total amount based on transaction 
date during the current fiscal year. 
This information is captured by 
Oracle Trade Management from the 
Point-of-Sale System

Sales Currency Partner, KPI

Industry                                   Partner's Industry (Implementation 
specific)

General Multi-Select Partner

Last Order Date Date of the last order where partner is 
the 'Sold to' party base on last ordered 
date

Sales Date Partner

New Partners Total number of partners created in 
the time span specified by the profile ' 
PV: New Partners Time Window'

General Count KPI

Open Claims Total amount remaining for all open 
claims generated from referral, soft 
funds and special pricing

Marketing                                                                       Currency Partner, 
Trend,KPI

Open 
Opportunities

Total amount of open indirect 
opportunities that a partner is 
working on

Sales Currency Partner, 
Trend,KPI

Open 
Opportunities 
Count

Total number of open indirect 
opportunities that a partner is 
working on

Sales Count Partner, 
Trend,KPI

Opportunities 
Won

Total amount of indirect opportunities 
that a partner has won based on 
decision date

Sales Currency Trend

Opportunities 
Won Prior year

Total amount of indirect opportunities 
that a partner has won based on 
decision date during the last fiscal 
year

Sales Currency Partner

Opportunities 
Won YTD

Total amount of indirect opportunities 
that a partner has won based on 
decision date during the current fiscal 
year

Sales Currency Partner

Opportunity 
Acceptance Rate

Number of opportunities accepted by 
partner or the number of 
opportunities offered to partner

Sales Percentage Partner, KPI

Table 4–2 Seeded Attributes

Attribute Name Description Category Display Style Enabled For
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Opportunity Close 
Rate

Number of opportunities won by the 
partner or the number of 
opportunities accepted by the partner

Sales Percentage Partner, KPI

Partner Enrollment 
Date 

Partner enrollment date General Date Partner

Partner Level  Partner level (Implementation 
specific)

General Drop-Down Partner

Partner Member 
Type 

Partner member type (Standard, 
Global, Subsidiary)

General Radio Button Partner

Partner Name Partner Name General Text Partner

Partner Type Partner type (End user, Original 
Equipment Manufacturer, Prospect, 
Distributor, Reseller). Users can 
define additional types

General Check Box Partner

Partnership 
Activity

Partnership Activity (Implementation 
specific)

General Multi-Select Partner

Product Categories 
for Special Pricing     

Product categories that a partner is 
authorized to submit special pricing 
requests for (Implementation specific)

General Multi-Select Partner

Products Bought 
Last Year 

List of products bought by the partner 
in the last twelve months. (from the 
current date) This is captured by 
taking union of products on all orders 
shipped last year where Partner is the 
'Bill to' party

Sales List Partner

Products Sold Last 
Year 

List of all products sold by the partner 
in the last twelve months. (from the 
current date) This metric is calculated 
by taking union on products on all 
line items maintained in the POS table 
against the given partner

Sales List Partner

Referral 
Commission Paid                                    

Total commission amount paid based 
on the date the referral status changes 
to 'Closed. Fee Paid'

Marketing                                                                       Currency Trend

Referral 
Commissions Paid 
YTD 

Total commission amount paid based 
on the date the referral status changes 
to 'Closed. Fee Paid' during the 
current fiscal year

Marketing                                                                       Currency Partner, KPI

Table 4–2 Seeded Attributes

Attribute Name Description Category Display Style Enabled For
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4.2.2 Seeded Attributes - LOVs
LOV seeded attributes require the customer to set up a range of values. 

The values can be set up:

■ INTERNALLY: Enter attribute values by navigating to Administration > 
Partner horizontal navigation link > Attributes side navigation link > View 
Values link in Summary Page. For more information, see Section 4.3, "Setting 

Referrals Accepted                                        Total referral amount accepted based 
on referral creation date

Marketing                                                                       Currency  Trend

Referrals 
Submitted Count       

Total number of referrals that are not 
in draft status based on referral 
creation date

Marketing                                                                       Count Trend

Referrals accepted 
YTD

Total referral amount accepted based 
on referral creation date during the 
current fiscal year

Marketing                                                                       Currency Partner, KPI

Referrals accepted 
YTD count

Total number of referrals accepted 
based on referral creation date during 
the current fiscal year

Marketing                                                                       Count  Partner, KPI

Referrals 
submitted YTD 
count

Total number of referrals that are not 
in draft status based on referral 
creation date during the current fiscal 
year

Marketing                                                                       Count    Partner

Sales Total amount of all orders shipped 
where a partner is the 'sold-to' party, 
based on the order date

Sales Currency Trend

Sales Prior Year Total amount of all orders shipped 
where a partner is the 'sold-to' party, 
based on order date during the prior 
fiscal year

Sales Currency Partner

Sales YTD                                                   Total amount of all orders shipped 
where a partner is the 'sold-to' party 
based on order date during the 
current fiscal year

Sales Currency Partner, KPI

State States that the partner has a presence General Multi-Select Partner

Total Partners                     Total number of partners managed General              Count  KPI

Table 4–2 Seeded Attributes

Attribute Name Description Category Display Style Enabled For
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Up Custom Attributes". For information on the LOV set up, see the LOV setup 
required column in the table below.

■ LOOKUP VALUES: Specify the lookup type. Enter attribute values based on its 
LOV source.

Table 4–3 describes the seeded LOV attributes in Oracle Partner Management. The 
table lists all attributes whose possible values come from some ’list of values’ which 
may be a lookup, view, and so on. This enables users to know where the values are 
coming from and where they can add more values. As indicated in the column 
’LOV Setup Required’, some attributes require set up.

Table 4–3 Seeded LOV Attributes

Attribute Name
Display 
Style

LOV 
setup 
required LOV Source Enabled For

Functional 
Expertise

Multi-Select - ENI_PROD_DEN_HRCHY_PARENTS_V 
WHERE PURCHASE_INTEREST = 'Y' 
AND (DISABLE_DATE IS NULL OR 
DISABLE_DATE > SYSDATE)

Partner

Product Categories 
for Special Pricing

Multi-Select - ENI_PROD_DEN_HRCHY_PARENTS_V 
WHERE PURCHASE_INTEREST = 'Y' 
AND (DISABLE_DATE IS NULL OR 
DISABLE_DATE > SYSDATE)

Partner

Partner Type Check Box Y INTERNAL Partner

Country Multi-Select - FND_TERRITORIES_VL Partner, 
Opportunity

Industry Multi-Select Y LOOKUP ( PRM_IND_CLASSIFICATION_
TYPE)

Partner, 
Opportunity

Partner Member 
Type

Radio Button Y INTERNAL Partner

Geographic 
Coverage

Multi-Select Y INTERNAL Partner, 
Opportunity

Additional Channel 
Offering

Multi-Select Y INTERNAL Partner, 
Opportunity

Partnership Activity Multi-Select Y INTERNAL Partner, 
Opportunity
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Campaign External 
LOV

- AMS_P_SOURCE_CODES_V WHERE 
SC.STATUS IN ('ACTIVE', 
'ONHOLD','COMPLETED') AND 
SC.SOURCE_TYPE IN 
('EVEH','EVEO','CAMP','CSCH')

Opportunity

Capacity Rating Drop Down Y INTERNAL Partner, 
Opportunity

Partner Level Drop Down Y INTERNAL Partner, 
Opportunity

State Multi-Select - AR_LOCATION_VALUES WHERE 
LOCATION_SEGMENT_QUALIFIER = 
'STATE’

Partner, 
Opportunity

Customer External 
LOV

- ASF_CUSTOMER_LOV_V WHERE 
PARTY_TYPE IN ('ORGANIZATION', 
'PERSON')

Opportunity

Opportunity Status Drop Down - AS_STATUSES_VL WHERE ENABLED_
FLAG = 'Y' AND OPP_FLAG = 'Y

Opportunity

Product Category Multi-Select - ENI_PROD_DEN_HRCHY_PARENTS_V 
WHERE PURCHASE_INTEREST = 'Y' 
AND (DISABLE_DATE IS NULL OR 
DISABLE_DATE > SYSDATE)

Opportunity

Sales Channel Drop Down - ASO_I_SALES_CHANNELS_V WHERE 
ENABLED_FLAG = 'Y’

Opportunity

Sales Stage Drop Down - AS_SALES_STAGES_ALL_VL WHERE 
ENABLED_FLAG = 'Y' AND SYSDATE 
BETWEEN START_DATE_ACTIVE AND 
NVL(END_DATE_ACTIVE, SYSDATE)

Opportunity

Offer External 
LOV

- AMS_P_SOURCE_CODES_V Opportunity

Win Probability Drop Down - AS_FORECAST_PROB_ALL_VL WHERE 
ENABLED_FLAG = 'Y'AND ((SYSDATE 
BETWEEN START_DATE_ACTIVE AND 
END_DATE_ACTIVE) OR(SYSDATE > 
START_DATE_ACTIVE AND END_
DATE_ACTIVE IS NULL))

Opportunity

Table 4–3 Seeded LOV Attributes

Attribute Name
Display 
Style

LOV 
setup 
required LOV Source Enabled For
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4.2.3 Setting Up Refresh Frequency
For all attributes that are enabled for partner and partner trends, vendors can define 
how frequently attributes need to be collected or calculated for each partner. This 
information is used by both the ’PV: Refresh Partner Trend Values’ and ’PV: 
Refresh Attribute Text Table’ concurrent programs.

Navigate as a channel administrator to Partner > Profile Attributes. For each 
attribute (that is enabled for partner or partner trend), you can see the ’refresh 
frequency’ link from where you can view details. If the particular attribute you have 
selected is enabled for both, partner and partner trends, you can set intervals for 
both.

Attributes without a refresh frequency are refreshed whenever the concurrent 
programs run.

The refresh types are: 

■ Hour - Refresh if the last refresh exceeds ’x’ hours

■ Day - Refresh if the last refresh exceeds ’x’ days

Sales Methodology Drop Down - AS_SALES_METHODOLOGY_VL WHERE 
SYSDATE BETWEEN START_DATE_
ACTIVE AND NVL(END_DATE_ACTIVE, 
SYSDATE)

Opportunity

Customer/Account 
Type

Drop Down - LOOKUPS (CUSTOMER_ACCOUNT_
TYPE)

Opportunity

Routing Status Drop Down - LOOKUPS (PV_ROUTING_STAGE) Opportunity

Customer Category Drop Down - AR_LOOKUPS WHERE LOOKUP_TYPE = 
'CUSTOMER_CATEGORY' AND 
ENABLED_FLAG = 'Y'

Opportunity

Products Bought 
Last Year

Multi-Select - MTL_SYSTEM_ITEMS_B WHERE 
ORGANIZATION_ID = FND_
PROFILE.VALUE('ORG_ID')

Partner

Products Sold Last 
Year

Multi-Select - MTL_SYSTEM_ITEMS_B WHERE 
ORGANIZATION_ID = FND_
PROFILE.VALUE('ORG_ID')

Partner

Table 4–3 Seeded LOV Attributes

Attribute Name
Display 
Style

LOV 
setup 
required LOV Source Enabled For
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■ Week - Refresh if the last refresh was before ‘x’ weeks. Note: 1 week is not 7 
days. For example, if the refresh frequency was set to 1 week, and the last 
refresh was on Friday and if the concurrent program was run on Monday, it 
will refresh since the week has changed.

■ Month - Refresh if the last refresh was before ‘x’ months.

4.2.4 Performance Attributes
Performance attributes are used to track a partner’s performance. These attributes 
are seeded and numeric in nature. For example, currency amounts, quantity or 
ratios (percentages). Some measures are cumulative and some are not. For example, 
sales figures are cumulative as vendors can add up the sales for each month to 
arrive at the sales figures for a whole year. Open opportunities count is not 
cumulative as vendors cannot add up the number of open opportunities for each 
month to arrive at the open opportunities count for a year, that is, opportunities 
that were open in January may already be closed in March.

Each seeded performance attribute is used to support one or more of the following 
metrics:

■ Partner Trend

■ Partner Performance

■ Partner Group Performance

Each of the metrics represent data collected at different levels of granularity with 
Partner Trend being the most granular wherein data is collected by partner by 
month, Partner Performance wherein data is collected by partner, and Partner 
Group Performance wherein data is computed real-time by a group of partners. 
These metrics form a hierarchy with Partner Trend attributes at the lowest level and 
the Partner Group Performance attributes at the highest level. Each of the 
performance attributes are linked to one, more or all levels of performance metrics. 
For example, ’Open Opportunities Count’ attributes is computed at all the three 
levels, that is, partner group performance, partner performance and partner trend.

Partner Performance
This is displayed in the Performance tab of the partner detail page and tracks the 
performance metric of an individual partner. These measures are calculated by the 
concurrent program 'PV - Refresh attribute text table'.
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Partner Trend
This is displayed in the ’View Trends’ UI which is accessible from the Performance 
tab. This tracks performance for a partner by month and the ’View Trends’ user 
interface provides this data at a monthly, quarterly, or yearly level. 

The concurrent program 'PV: Refresh Partner Trend Values' calculates these 
measures. The data stored is summarized by partner by month. 

Partner Group Performance
These measures are displayed in the Key Metrics bin on the Channel Manager 
dashboard and are computed in real-time to display the aggregated performance 
metrics of partners they directly manage via the channel team or indirectly 
managed as implemented through the resource group hierarchies. 

Channel representatives or channel managers can view the aggregated performance 
metrics of partners that they directly manage via the channel team or partners that 
they indirectly manage as implemented through the resource group hierarchies. 

4.2.5 Concurrent Programs
The following are concurrent programs that are required to run for profile 
attributes.

■ The Workflow Notification Mailer program should be running if vendors want 
e-mail notifications to be sent.

■ PV: Refresh Partner Trend Values - This program calculates the partner trend 
performance measures summarized at a monthly level.

■ PV: Refresh Attribute Text Table - This program allows the attribute details for 
a particular partner to be used in the matching process and to calculate the 
performance and derived attributes for each partner. There are two options for 
running this program - Full Refresh or New Partners Only. The ’Full Refresh’ 
option is the default option. The ’New Partners Only’ option picks up all the 
newly created partners since the last refresh of this type. The last refresh date is 
stored in the profile 'PV: Refresh Search Attributes Last Update Date'.

Table 4–4 provides the parameters of the PV: Refresh Partner Trend Values 
concurrent program.
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For currency measures, this concurrent program converts all currency to the 
currency stored in the profile PV: Common Currency for Rules Engines. If this 
profile is not set, it defaults to USD.

Table 4–5 provides the parameters of the PV: Refresh Attribute Text Table 
concurrent program.

For currency measures, this concurrent program converts all currency to the 
currency stored in the profile PV: Common Currency for Rules Engines. The default 
value is ’USD’.

4.3 Setting Up Custom Attributes
Use attributes to create and track additional information about a partner or an 
opportunity. Then, run partner matching to find the best match.

Table 4–4 PV: Refresh Partner Trend Values 

Parameter Description

Start from Beginning of 
Month

Identifies the starting month to refresh (only applies to 
measures that are cumulative). Non-cumulative measures are 
always calculated for the current month only.

To Ending of Month Identifies the ending month to refresh (only applies to 
measures that are cumulative). Non-cumulative measures are 
always calculated for the current month only.

New Partners Only If ’Yes’, then only process for new partners. New partners are 
defined as partners created after the last refresh run of this 
concurrent program (stored in the profile 'PV: Partner Trend 
Last Refresh').

Ignore Refresh Interval If ’Yes’, process all attributes even though the time interval 
from the last refresh have not exceeded the refresh interval set 
for some attributes.

Table 4–5 PV: Refresh Attribute Text Table

Parameter Description

New Partners Only Only process for new partners. New partners are defined as 
partners created after the last refresh run of this concurrent 
program (stored in the profile 'PV: Refresh Search Attributes 
Last Update Date').
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Attributes are defined during the implementation process. Additional attributes can 
be added, or removed by the channel administrator.

Use this procedure to add or remove attributes.

Prerequisites
None.

Step
1. Log in as the channel administrator and navigate to Profile Attributes > 

Attributes - Overview page.

2. Click Create.

The Create Attribute page appears.

3. Select an attribute type from the Attribute Type drop-down list.

This determines how the values are presented. The choices are List of Values, 
Derived, and Text Box.

4. Select a display style from the Display Style drop-down list.

5. Enter a name, description and select a category from the Category drop-down 
list.

6. Select the Status as Active or Inactive.

7. Select the Expose to Partner check box to make the attribute visible in the 
Company Profile tab in the partner dashboard.

8. Select the Requires Data Validation check box to indicate that any updates to 
this attribute requires proof. Email notifications are sent to channel managers of 
the partner informing them that their partner has updated the attribute value.

9. Select the appropriate Related To check box.

The check boxes are entities for which attributes have to be enabled. For 
example, if it is selected for Partner, the attribute is enabled for Partner Profile 
windows and users can set values of attributes for partners. The available 
entities are Partner, Partner Contact, Opportunity, Lead Referral, Deal 
Registration.

10. Select a particular Country or accept the default as All.

11. Specify any of the following partner types to which this attribute applies.
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Reseller, Original Equipment Manufacturer, Prospect, Distributor, End User, 
All.

12. Enable the attribute for either the Locator check box or the Matching Services 
check box.

If the attribute type is LOV and text, the extra fields are No Of Lines (for 
Multi-Select and String display styles), Character Width (for String and 
currency display styles), Decimal Points (for Currency and Number display 
styles), Total (for Percentage display styles), and Value Type (for Number 
display styles). 

If the attribute type is Derived in the Other Information Section, a table is 
displayed with a text box to enter SQL text for all the entities that this attribute 
is checked for. Users can enter SQL text so that they can validate and update.

13. Click Create.

14. In the Attributes - Overview page, click the profile attribute name hyperlink.

The Attribute Detail page appears.

15. Click Profile Attribute Values to add attribute values.

The Attribute Details - Properties page appears.

16. Enter a value in the Attribute Value field.

17. Enter a description in the Description field.

18. Select the Inactive check box to make the attribute inactive.

19. Click Apply to save your changes.

Table 4–6 describes seeded LOV attributes in Oracle Partner Management.
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Table 4–6 Profile Options

Profile Name Level Default Default Value Description

OS: Forecast Calendar Site None - This profile sets the accounting calendar 
that is used to determine the start and end 
dates for the company's fiscal year. 

OS: Default Period Type 
for Currency Conversion

Site None - Default Period Type for Currency 
Conversion

PV: Common Currency 
for Rules Engines

SARU None - Used by the concurrent program 'PV: 
Refresh Partner Trend Values ' and 'PV 
Refresh Attribute Text Table' to convert and 
store all currency attributes in this currency. 
This enables currency comparison to be 
performed accurately.

PV: Partner Trend Last 
Refresh

- - - Not updatable by the users. Used by Refresh 
Partner trend concurrent program to 
determine the last incremental refresh time.

PV: Refresh Search 
Attributes Last Update 
Date

- - - Not updatable by the users. Used by Refresh 
Partner trend concurrent program to 
determine the last incremental refresh time.

PV: Vad/Partner Full 
Access To Profile 
Screens 

SARU Site N This profile determines whether a partner or 
distributor can update their company 
profile and their own profile information 
from the partner dashboard.

PV: Attribute Percentage 
Total

SARU Site 100 For attributes with percentage display style, 
when users enter percentage for each item, 
the system validates that the sum of all the 
percentages add up to the number stored in 
this profile.
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5

Setting Up the Partner Dashboard

This chapter provides information on how to set up the partner dashboard. Topics 
included are:

■ Section 5.1, "Overview"

■ Section 5.2, "Configuring the Partner Dashboard"

■ Section 5.3, "Best Practices"

■ Section 5.4, "Bins"

■ Section 5.5, "Partner and User Registration"

■ Section 5.6, "Program Enrollment"

■ Section 5.7, "Profile Options"

■ Section 5.8, "Templates"

■ Section 5.9, "Users and Security"
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Overview
5.1 Overview
The partner dashboard is the single entry point for all transactions on the vendor 
system. From the dashboard, partners can:

■ Enroll into partner programs.

■ Manage their memberships including upgrades and renewals.

■ Manage transactions such as viewing the catalog, placing orders, managing 
sales opportunities, and accepting opportunities.

■ Submit referrals, register deals, request for funds, request for special pricing 
requests, and create quotes.

■ Maintain the partner contact and company profile.

■ View their notifications.

■ Access content published by the vendor.

The partner dashboard displays a summary of transactions and partners can click a 
link to navigate to the functional system. The list of transactions available depends 
on the program enrollments and role. For example, if they are authorized to resell a 
vendor's products, they are assigned sales opportunities.

5.2 Configuring the Partner Dashboard
The partner dashboard is set up by configuring sites. Oracle Partner Management is 
integrated with Oracle iStore to provide a partner dashboard.

A site is any site that the site administrator (manager) creates using the Oracle 
iStore Site Administration UI. To create a speciality site, the administrator must 
map the site to a partner responsibility and save it. Multiple specialty sites can exist 
within one site, as each site-responsibility combination is considered a specialty site. 
Speciality sites can be assigned to groups. The ’Partner’ group is shipped out of the 
box to facilitate customers to group partner sites into a single group.

The root section of a site is called a dashboard (or home page).

5.2.1 Creating a Site
Use this procedure to create a site.
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Prerequisites
1. Log into Oracle iStore as the administrator and navigate to the Catalog tab > 

Catalog Hierarchy page.

2. Select the ’Root’ section for Oracle Partner Management and click the Create 
Section icon in the Sections column.

The ’Root’ section is seeded. The Create Section page appears.

3. Enter necessary details and click Apply. 

Ensure that the status is ’Published’ and the dates are active. The Update 
Section: Details page appears.

4. To associate a template with the section, select the Templates side navigation 
link.

The Update Section: Layout page appears.

5. In the Layout region, from the Select Layout LOV, select a layout that you want 
to apply to the above created section and click Go. The layout determines the 
bins that should be to displayed on the left and right side of the dashboard. The 
values are: Configurable Layout and Fixed Layout.

■ If you select the Configurable Layout, perform the following steps to map 
the bins to templates. The templates are seeded in Oracle iStore.

a. In the Mapping region, select a template from the Layout Component 
Templates LOV and map it to a layout component.

b. Click Apply.

■ If you select the Fixed Layout, you must map the bin JSPs to templates. You 
cannot see the Mapping region because the templates are already 
positioned and the layout cannot be configured.

a. Navigate to Advanced tab > Template Manager > Templates page.

b. Select Programmatic Access Name from the Search field and enter 'STORE_
CTLG%' and click Go.

All seeded locations are displayed.

c. Click Update for the 'Bin Left 1' record.

d. In the Update Template page, click Add Source File.

e. In the Add Source File page, in the Source File Name filed, enter the JSP for 
Quick Links, for example, bin-ibeCAcdQuickLinkBin.jsp·
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f. Select the above created site from the Site drop-down list and click Apply.

The Update Template page appears with the JSP mapped to the bin.

6. Select the Display Layout side navigation link.

The Update Section: Display Template page appears. This page displays the 
format of the center bin only.

7. From the 'Select a Display Template' drop-down list, select 'Component for 
Section Contains Navigational Subsections Only' and click Go.

A section called 'Section Contains Navigational Subsections Only' appears in 
the bottom with different display templates.

Some templates are shipped to customers. The templates enable customers to 
select how they would like to view content in the center. Customers can use the 
following templates to display content:

■ ’Multilevel Subsection list with Content' under Component for section 
contain navigation subsections only: This template is specifically designed 
to show subsections within a section, along with content mapped to content 
components at the section level.

■ 'Section detail' under section containing products only: This template is 
only available for configurable layout. This template is specifically designed 
to show section details, along with content mapped to content components 
at the section level.

8. Select the 'Multilevel Subsection List' template to be used in subsections and 
click Apply.

The display template for the section is selected.

For information on center template, see Oracle iStore Implementation Guide.

Steps
1. Navigate to the Sites tab and click Create a Site and enter necessary details.

2. In the Catalog Root Section filed, select the section created above.

Select the ’Restrict customer access by responsibility’ check box.

Do not select the ’Allow un-registered users to browse the site’ check box.

3. Click Apply.

A site is created and the Update Site: Details page appears.
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4. Click the Responsibility side navigation link.

The Site ABC: Supported Responsibilities page appears. Customers can access 
the site through these responsibilities.

5. Click Add Responsibility.

6. In the Search and Select: Responsibility page, select any responsibility and click 
Select.

The responsibility is added to the site and only users with this responsibility 
can access the site.

7. In the Site Display Name field, enter a unique name. 

The name should help in identifying that the site is applicable to partners.

8. In the Site ABC: Supported Responsibilities page, click the Assign Groups icon.

9. In the Update Site: Assign Groups page, select a group from the Unassigned 
Groups section and click Move to move it to the Assigned Groups section.

10. Click Apply.

The responsibility and site is assigned to the selected groups and partners can 
view sites that they have access to, through the responsibilities that they have 
received by enrolling into a program.

5.2.2 Partner Dashboard Template Layout
Figure 5–1 displays the seeded partner dashboard template layout with top 
header, menu and bottom header locations.
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Figure 5–1 Partner Dashboard Template Layout

■ The top header layout component renders <html>, <head> tags. Customers can 
add any thing that they would like to see before rendering the menu. It 
provides an area for global icons, sections, and company logo located at the top 
of the page.

■ The menu layout component renders logos, global icons, and the menu.

■ The bottom header layout component renders </html> tags.

■ The Top, Left 1-7, Middle 1-4 , Right 1-7, Bottom and Center layout components 
do not have templates mapped for the ’Configurable Layout’. 
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■ To map a template for Top, Left 1-7, Middle 1-4 , Right 1-7, and Bottom 
layout components, navigate to Catalog > Section > Section Details > 
Templates > Layout > Configurable Layout.

■ To map a template for the Center layout component, see Steps 6, 7 and 8 of 
the procedure, Creating a Site.

5.3 Best Practices
Customers can implement the partner dashboard as they wish. Oracle Partner 
Management provides some seeded bins and they can plug the bins in any 
dashboard.

Using the ’Configurable Layout’, you can create an effective partner dashboard for 
your partners. You can easily modify the seeded template by changing the style 
sheet and mapping your branding. The seeded dashboard allows you to deliver 
content to your partner using the central section and provide access to the 
transactional system by mapping the seeded bins (my opportunity, quick links and 
manage my partner bins) to the left and right locations. You can also use the 
locations on the left and right to map the Available programs, upgrade, renewal 
bins. You can also support registration through the registration global icon to 
support self service registration.

The template for self service registration is also seeded to provide a best practice 
example for the registration and enrollment flows.

For example,

■ One location delivers the links for navigation to the transactional system.

■ Another location delivers messages for partners via integration with Oracle 
E-merchandising.

■ Another location enables vendors to deliver content by leveraging Oracle 
Content Management (OCM) and Oracle iStore (Section Hierarchy 
functionality).

■ The dashboard displays a summary of transactions and partners can click a link 
to navigate to the functional system. The list of transactions available depends 
on the partner enrollments and the role. For example, if a partner is authorized 
to resell a vendor's products, the partner is assigned sales opportunities for 
fulfillment.
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5.4 Bins
When a partner first logs into the dashboard, they can see bins such as Quick Links 
bin, Renewals bin, Upgrade bin, Available Programs bin, and My Opportunities bin 
if the customer has set them up. For partners to be able to view the bins, you must 
map the seeded templates. Each bin is defined as a template. Some bins are 
provided to customers so that they can map the bins to any template-site 
combination, during implementation.

The following bin templates are shipped out of the box. Customers need to map 
these bin templates to appropriate locations for the ’Configurable Layout’.

■ Quick Links

■ Renew Programs

■ Upgrade Programs

■ Available Programs

■ My Opportunities

■ Manage My Partners

■ Welcome

■ Marketing Posting

■ Partner Group

■ Store Group

5.4.1 Quick Links
This bin provides links to referrals, deal registrations, opportunities, special pricing, 
claims, fund requests, and messages. The list is based on vendor implementation 
and the partner responsibility.

The transaction records within each area, depend on the following:

■ Partner benefits - Partners have to be entitled to use each type of benefit. The 
benefits displayed to the partner users in the Quick Links bin are controlled 
using responsibilities. The list of links available in the bin depends on the 
current responsibility assigned to the user and the functions and menus 
attached to that responsibility. For the links to appear in the Quick Links bin the 
following setup needs to be done:

1. Define a menu that contains all functions, exposed to the partner user.
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2. Specify this menu name as the value for the responsibility level profile 
option 'IBE: Quick Links Menu' that is assigned to the user. This menu 
specified in the profile should be one of the sub menus under the root 
menu.

■ User role within the partner organization - Partners can access transactions that 
they created or are assigned to them. For example, if an opportunity is assigned 
to a partner, the partner can see that opportunity. If a partner created a referral, 
he/she can view the referral. Partner administrators can access all transactions 
created by any user or, transactions assigned to any user, within their 
organization.

5.4.2 Renew Programs
This bin displays programs that are up for renewal. The bin is available only to 
partner administrators to assist them manage their memberships. The partner 
administrator can review programs and start the enrollment process by clicking the 
Program Name link. The renew option appears to the user when the program is up 
for renewal. The default value is set to 60 days before membership expires.

5.4.3 Upgrade Programs
This bin displays programs that partners can upgrade to. The bin is available only 
to partner administrators to assist them manage their memberships. The partner 
administrator can review programs and start the enrollment process by clicking the 
Program Name link.

5.4.4 Available Programs
This bin provides the ability to view program details and start the enrollment 
process. The bin is displayed only to the partner administrator. The link on the 
program name navigates to the program details page. If the user clicks on the 
’Enroll’ button, they can navigate to the questionnaire page for enrolling in that 
program.

5.4.5 My Opportunities
This bin is displayed to partners who have offered opportunities in the queue to 
accept and where the routing status is ’Offered’. Partners can navigate to the 
opportunity link to go to the Opportunity Detail page and view details of the 
opportunity. They must have the permission OPPTY_CONTACT to view this bin.
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5.4.6 Manage My Partners
This bin displays the Invite New Partner and View Partner links for distributors. 
Distributors must have the ’Channel Manager’ role or ’Channel Representative’ role 
to see this bin. Distributors should also have the ’PV_INVITE_NEW_PARTNER’ 
permission to see the ’Invite New Partner’ link in this bin.

5.4.7 Welcome
This bin displays a welcome message with the user name and allows users to switch 
accounts if they have multiple accounts. User can switch between accounts before 
enrolling into a program or before submitting a referral to use a particular account.

For more information, see Oracle iStore Implementation Guide.

5.4.8 Marketing Posting
This bin displays marketing postings. E-Merchandising banners are used to deliver 
marketing messages to partners who can click on the bin to see more details about 
the marketing campaign.

For information on the implementation steps necessary for this bin, see Oracle iStore 
Implementation Guide.

5.4.9 Partner Group
Oracle iStore seeds a bin template which displays sites associated to the group, 
Partners. To display this group, map the logical template, PARTNER_GROUP_
BIN_IBEWC, to the bin layout component of your choice. 

For more information about the bin template, see Seeded Bins in the Oracle iStore 
Implementation Guide.

5.4.10 Store Group
For information on this bin, see the Oracle iStore Implementation Guide.

5.4.11 Bin JSPs -Template Mapping
Table 5–1 indicates the templates and the corresponding bin JSP's which can be 
customized as per guidelines in the Oracle iStore Implementation Guide.
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The Quick Links and Marketing Postings bin are part of Oracle iStore. The 
Renewals, Upgrades, Available Programs and My Opportunities bins are included 
in Oracle Partner Management. These bins display content only to authenticated 
partner users. These bins do not display content for guest users even when the bins 
are mapped to sites that can be browsed by guest users.

The following APIs can be used to get data for the respective bins. Java Class is 
oracle.apps.pv.enrollment.bin.BinContent.

■ public Vector newPrograms(…)

■ public Vector renewable_programs(…)

■ public Vector upgradable_programs(…)

■ public Vector incomplete_programs(…)

For the Opportunity bin, the api is in: 
oracle.apps.pv.bin.MyOfferedOpptyBinDataSource and the method is public Vector 
getBinData(…)

5.5 Partner and User Registration
Partners can register themselves or their organization from the 'Register' global icon 
or link or using 'New User Registration' link in the sign-in page or by using any 
other custom link like 'Register My Partner Organization' provided on any page 
during implementation.

Table 5–1 Bin JSPs

Template Bin JSP Name

Available Programs Bin pvxCPvdPrgmNewBin.jsp

Renew Programs Bin pvxCPvdPrgmRenewBin.jsp

Upgrade Programs Bin pvxCPvdPrgmUpgradeBin.jsp

My Opportunities Bin pvxCPvdMyOffrdOppBin.jsp

Manage My Partner Bin pvxCPvdMngPrtnrBin.jsp

Accessible Stores Bin ibeCAcdGroupSiteBin.jsp

Emerchandising Postings Bin amsWebPlacement.jsp

Welcome Bin ibeCAcdWelcome.jsp
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The registration process is initiated and the partner is guided through a series of 
steps to submit company and user information. Once this information is submitted, 
Oracle Partner Management generates a company and user account for the partner. 
The partner is given a user name and password, which, he/she selects during 
registration and then receives a notification about it.

A partner user registered using this process, is always registered as a primary user. 
Default roles and responsibilities are granted to a partner user upon the completion 
of the registration flow.

When a partner registers:

■ A party record is created for the organization

■ A party record is created for the contact

■ A ’partner of’ relationship is created

■ A ’contact of’ relationship is created

■ Based on territories, the channel manager is identified and assigned to the 
partner. A channel team is assigned to the partner based on the territory setup. 
The channel team is a set of channel manager(s), who manages the partner.

■ For directly managed partners, channel managers are vendor employees.

■ For indirectly managed partners, channel managers are employees or 
vendor employees or both.

Territory Assignment Program
This release provides a territory based security model to access partner information. 
When a partner is created, the system automatically identifies the channel 
manager(s) to be assigned based on the territory definition. Vendors can define 
territories and specify territory qualifiers for a territory. The qualifiers are: 

■ Area Code

■ City

■ Company Annual Revenue

■ Country, County

■ Customer Category

■ Number of Employees

■ Partner Level
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■ Partner Name

■ Partner Name Range

■ Partner Type

■ Postal Code

■ Province

■ State

For example, territory A could mean all the states in the East Coast of the U.S. that 
have global partners (global membership type). While defining a territory, they can 
also specify the channel manager responsible for that territory. For example, 
territory A (Dallas) has Greg defined as the channel manager. If the newly created 
partner (NP) is from Dallas, Greg is automatically assigned to NP as the channel 
manager by the system. Territory definitions can change over time. Vendors can 
also manually assign users to partner organizations in addition of the territory 
definition. Users with the 'Super User' role can access all partners irrespective of the 
territory definition.

Partners can also create user accounts for users belonging to the existing 
organization using the self-registration process or the primary user can create 
additional users by logging into the application and navigating to the Profile > 
Administration > Contact Management UI.

Users of an existing organization that are created through self service registration 
are always assigned business user roles. The primary user can switch these users to 
primary users from Profile > Administration > Contact Management > drilling the 
contact name > Roles UI.

Once the partner organization is registered, the primary user (Partner 
Administrator) can create additional primary users or business users.

The User Management framework of the Oracle E-Business Suite manages partner 
registrations. Registration involves the creation of a user and company account and 
collecting general data from partners. User management allows prospective 
partners to use the self-registration process to register their company as a partner. 
During self-registration, partner users can also register themselves as the contacts of 
the organization by providing their details.
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5.5.1 Enabling User Types
The following user types must be enabled using the CRM HTML administrator 
responsibility for registering partner organizations and partner users through user 
registration.

■ IBE_PARTNER_BUSINESS to register partner users of an existing partner 
organization.

■ IBE_PARTNER_PRIMARY to register a new partner and primary user of 
partner organization.

Use this procedure to enable the user types.

Prerequisites
None.

Steps
1. Login as the system administrator into the CRM Admin Console and navigate 

to Users tab > Setup > User Types.

2. Enable the following user types, only if you have Oracle Partner Management 
11.5.10 or a higher version is installed.

■ IBE_PARTNER_BUSINESS

■ IBE_PARTNER_PRIMARY

For more information, see Oracle iStore Implementation Guide.

5.6 Program Enrollment
In the previous release, the enrollment flow provided a set of screens that could be 
configured to allow the partner to enroll in a program.

■ Customers could not easily format enrollment pages or brand enrollment pages 
based on partner classifications.

■ Customers could not easily add additional content to enrollment pages.

In this release, Oracle Partner Management leverages the template management 
framework to address these usability concerns. The registration framework 
supports enrollments. The enrollment pages are embedded in the registration flows. 
Users can now enroll into a program from the partner dashboard provided by a 
common foundation component called ’Template Management Framework’.
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Figure 5–2 displays the enrollment flow template with top header, menu and 
bottom header locations.

Figure 5–2 Enrollment Flow Template

■ The top header renders <html>, <head> tags. Customers can add any thing that 
they would like to see prior to menu rendering in this page.

■ The Left 1, Left 2, Left 3, Left 4, Right 1, Right 2, Right 3, Right 4, Center 1, 
Center 2, Center 3 and Center 4 templates are part of the Layout template.

■ The layout template includes the content rendering part of the enrollment flow.

■ The bottom header renders </html> tags.

Enrollment pages do not have the menu section hierarchy. So, the menu template 
renders logo, global icons and a thin menu bar without any section hierarchy.

Each page in the enrollment flow has different data that needs to be processed 
when user clicks the Next button. Hence, each page in the enrollment flow has 
separate container pages. To minimize the amount of work when a customer wants 
to customize the layout, the same layout template is present across all the pages in 
the enrollment flow. Any change in the layout template is reflected immediately in 
all the pages of the enrollment flow. 
Setting Up the Partner Dashboard 5-15



Profile Options
The Enroll Now, Questionnaire, Questionnaire Summary, Contract, Payment 
Address, Payment Information, Payment Confirmation and Thank you pages are 
container templates.

Figure 5–3 illustrates the container templates mentioned above.

Figure 5–3 Container Templates

5.7 Profile Options
Table 5–2 indicates the profile options that can be setup for each of the partner 
responsibilities.
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Table 5–2 Profile Options

Profile Name

Required- 
Yes/ 
Optional

Level - Site/ 
Application/ 
Responsibility/Use
r

Setting - 
Available 
setting 
choices Description

PV: Default 
Vendor 
Organization

Yes This can be set up at 
the application or 
site level if there is 
only one internal 
vendor organization 
that should be used 
to create partner of 
relationship.

- Needs to be set up for the default 
responsibility, when registering a new 
partner.

Used during the self-service registration and 
Customer to Partner conversion to identify 
which internal organization should be used 
for creating partner-of relationship between 
partner and vendor internal organization.

FUNCTION_
SECURITY_
REGION

Yes Responsibility PV_
PARTNER
_FUNC_
SEC_
REGION 

Needs to be setup for the Partner Super User 
responsibility if this responsibility is used.

IBE: Enable 
Shopping Cart 
Global Icon

Optional SARU No Used to disable the Shopping Cart global 
icon for partner sites. This needs to be 
turned off at partner site responsibility.

IBE: Enable 
Order Tracker 
Global con

Optional - No Used to disable the Order Tracker global 
icon for partner sites. This needs to be 
turned off at partner site responsibility.

IBE: Enable 
Quick Search

Optional - No Used to disable quick search for partner 
sites. This needs to be turned off for the 
partner site responsibility.
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5.8 Templates
The following templates are used in partner specific profiles pages in the partner 
dashboard:

IBE: Use Web 
Placements

Yes - - Needs to be set to ’View eMerchandising 
Postings’ in the marketing postings bin.

The Marketing postings bin requires 
additional implementation steps to see the 
eMerchandising postings in the partner site.

For more information, see Oracle iStore 
Implementation Guide.

IBE: Quick 
Links Menu

Yes Responsibility - This is a mandatory profile if the Quick 
Links bin needs to be displayed when 
logging in with a particular responsibility.

Needs to be setup to the correct FND menu 
from which quick links are rendered. This 
needs to be setup at responsibility level for 
partner site responsibility. 

Partner Super User responsibility should 
have this profile option setup as Partner 
User Sub Menu.

IBE_USE_
ORDER_
TRACKER

Optional SARU - The order tracker icon is displayed by 
default in the global icons section of any 
site. The icon can be disabled using this 
profile.

This profile has the site level value seeded 
as 'Yes'.

Customers can turn off this profile at the 
application level if Oracle Partner 
Management and Oracle iStore are not 
implemented together in one site.

If Oracle iStore and Oracle Partner 
Management are both implemented, this 
profile should be set to ’No’ at the partner 
responsibility level.

Table 5–2 Profile Options

Profile Name

Required- 
Yes/ 
Optional

Level - Site/ 
Application/ 
Responsibility/Use
r

Setting - 
Available 
setting 
choices Description
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■ Sales Preferences: Template to view the sales preferences page. Navigate via the 
Profile icon > My Profile > Preferences.

■ Update Partner Profile: Template to view the partner organization’s profile 
page. Navigate via the Profile icon > Company Profile > Company Information 
> Profile tab.

■ Update User Profile Page: Template to view the contact’s Update Profile page. 
Navigate via the Profile icon > My Profile > Personal Information > Profile tab.

■ View Channel Team for Partner: Template to view the channel team page. 
Navigate via the Profile icon > Company Profile > Channel Team.

■ View Current Partner Memberships: Template to view the memberships page. 
Navigate via the Profile icon > Company Profile > Memberships.

■ View Partner Profile: Template to view the partner organization’s profile page. 
Navigate via the Profile icon > Company Profile > Company Information > 
Profile tab.

■ View User Profile Page: Template to view the contact’s profile. Navigate via the 
Profile icon > My Profile > Contact Information > Profile tab.

■ Update User Profile: Template for the contact update profile. Navigate via the 
Profile icon > Administration > Contact Management > Details > View Profile.

■ View User Profile: Template to view the contact’s profile. Navigate via the 
Profile icon > Administration > Contact Management > Details > View Profile.

The following templates are used in partner registration flow. For information on 
how these templates are used, see Oracle iStore Implementation Guide.

■ Processing page for partner types during registration: Processing page template 
to process user selected partner type and member type during self registration 
of partner primary user. 

■ Displays partner types during registration: Template for displaying partner 
type and member type during self registration of partner primary.

■ Displays user preferences during registration: Template for displaying user 
currency during self registration of partner primary user, business user, user 
management, user creation and user update page in the partner dashboard 
profile.
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5.9 Users and Security
Access to the partner dashboard is controlled based on user types, responsibilities, 
permissions, and roles.

User Types
The user types are:

■ Primary users have the administrative functionality which is granted through 
the use of permissions and roles.

■ Business users can only access the user profile, preference and view their 
company profile.

Access to partner data depends on the following:

■ Prerequisite: The vendor must be a resource with a channel representative or a 
channel manager role.

■ A vendor user can see partner data if:

■ The vendor user is on the channel team of a partner 

■ The vendor user is the manager of a user who is on the channel team (this 
means both the manager of the group where the vendor is defined as a 
member and the manager of a parent group)

■ The vendor user has the VIEW_ALL_PARTNERS permission.

Responsibilities
The two partner responsibilities supported in this release are:

■ Default Partner User: This responsibility is used to display the partner 
dashboard to the partner user after the partner has registered but before the 
partner has enrolled in a program. After a partner enrolls in a program, Oracle 
Partner Management removes the preliminary partner user responsibility and 
assigns the responsibility of the program.

■ Partners with the ’Default Partner User’ responsibility can only see the 
Available Programs bin. They cannot see the Quick Links bin since no 
menu is attached to this responsibility. They cannot see the Upgrade and 
Renewal bins as they are not enrolled into any program. Since the partner 
does not have offered opportunities, he/she cannot see the Offered 
Opportunities bin.
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■ Partner Super User: This responsibility includes the superset of all 
functionalities offered to partners. Partners can either be regular partners or 
distributors. Distributors are different from regular partners as they manage 
some partners on behalf of the vendor. Menus tied with the ’Partner Super 
User’ responsibility can be used as a reference to create menus for custom 
responsibilities.

For defining menus that can be used with the Quick Links bin, see Oracle iStore 
Implementation Guide.

Permissions
A permission is a privilege that is granted to a user. It grants access to a resource. 
Resources are application elements such as JSP pages, objects, or methods of objects. 
A permission is implemented as a string. If a resource is protected by a permission, 
any user accessing the resource must have the permission required to access it. 
Permission names are case-sensitive. Permissions cannot be directly assigned to 
users. Instead, permissions are grouped into roles and roles are then assigned to 
users.

For information on creating permissions, see CRM System Administrator’s Guide.

Users with the following permissions can access partner data:

■ PV_INVITE_NEW_PARTNER: This permission is attached to a role and 
assigned to a primary user (when they get assigned the ’Channel Manager role 
or the ’Channel Representative’ role) by default.

■ PV_UPDATE_ALL_PARTNERS: This permission enables the user to view and 
update partner details.

■ PV_VIEW_ALL_PARTNERS: This permission enables the user to view all 
partner records. If an internal user is assigned this permission, the profile 
information includes the complete partner profile. If an external user is 
assigned this permission, the profile information includes only the profile 
attributes defined as 'visible to the partner'.

Roles
A role is a group of permissions which can be assigned to a user. Like permissions, 
roles are implemented as strings. Role names are not case-sensitive.

For example, there is a JSP page "abc.jsp" that requires the permission "PERM_
ABC." A user logs in and tries to access abc.jsp, but he or she cannot do that unless 
he or she has the permission "PERM_ABC." You want the user to be able to access 
the page, so you assign the role "ROLE_ABC" (which contains permission "PERM_
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ABC") to the user. When given the appropriate role, the user is able to access the 
page.

For information on creating roles, see CRM System Administrator’s Guide.

A role type (JTF_RS_ROLE_TYPE) has to be defined and then JTT roles have to be 
defined. Resources have to be created and roles must be attached to resources. A 
resource can be a resource, group and a team. Groups and teams can be added to 
this resource.

The JTA roles are:

■ CHANNEL_MANAGER

■ CHANNEL_REP

The JTT roles are:

■ CHANNEL_MANAGER

■ CHANNEL_ADMIN_UPDATE

■ CHANNEL_ADMIN_VIEW

Oracle Partner Management will ship the following roles that are used in the user 
registration process and the partner dashboard:

■ PV_PARTNER_PRIMARY_USER

■ PV_PARTNER_BUSINESS_USER

Table 5–3 lists permissions that are seeded with the Primary User (PV_PARTNER_
PRIMARY_USER) role:

Table 5–3 Permissions of the PV_PARTNER_PRIMARY_USER Role

Permission Name Description

PV_PARTNER_
USER

Indicates that the user is a partner user.

PV_MY_
CONTACT_
PROFILE

Provides access to the partner’s profile. Navigate via the Profile icon > 
My Profile > Personal Information > Profile tab.

PV_SALES Provides access to view sales preferences. Navigate via the Profile icon 
> My Profile > Preferences.

PV_PARTNER_
UPDATE_
PROFILE

Provides access to update a partner’s organization information. 
Navigate via the Profile icon > Company Profile > Company 
Information > Profile tab.
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Table 5–4 lists permissions that are seeded with the Business User (PV_PARTNER_
BUSINESS_USER) role:

PV_PARTNER_
VIEW_PROFILE

Provides access to view a partner’s organization information. 
Navigate via the Profile icon > Company Profile > Company 
Information > Profile tab.

PV_VIEW_
MEMEBERSHIPS

Provides access to view partner memberships. Navigate via the Profile 
icon > Company Profile > Memberships.

PV_CHANNEL_
TEAM

Provides access to view a partner’s channel team. Navigate via the 
Profile icon > Company Profile > Channel Team.

PV_CONTACT_
PROFILE

Provides access to view a contact’s profile information. Navigate via 
Profile icon > Administration > Contact Management > Detail > View 
More Details button.

PV_OPPTY_
CONTACT

This is used to identify the partner contacts during opportunity 
routing.

PV_REF_COMP_
APPROVER

This is defined for partners who can accept compensation. This 
permission enables partners to view and accept compensation for 
referrals.

PV_REFERRAL_
SUPERUSER

This a ’Super User’ permission defined for referral management. It can 
be assigned to vendors and partners. Vendors with this permission 
can view and update all referrals. Partners with this permission can 
view, update, and accept compensation for referrals for their 
organization.

PV_DEAL_
SUPERUSER

This is a ’Super User’ permission defined for deal registration. It can 
be assigned to vendors and partners. Vendors with this permission 
can view and update all deals. Partners with this permission can view 
and update all deals for their organization.

Table 5–4 Permissions of the PV_PARTNER_BUSINESS_USER Role

Permission Description

PV_PARTNER_USER Indicates that the user is a partner user.

PV_MY_CONTACT_
PROFILE

Provides access to the partner’s profile. Navigate via the Profile 
icon > My Profile > Personal Information > Profile tab.

PV_VIEW_
MEMEBERSHIPS

Provides access to view partner memberships. Navigate via the 
Profile icon > Company Profile > Company Information > 
Profile tab.

Table 5–3 Permissions of the PV_PARTNER_PRIMARY_USER Role

Permission Name Description
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Oracle iStore Permissions
Table 5–5 lists the Oracle iStore permissions for the for the PV_PARTNER_
PRIMARY_USER and PV_PARTNER_BUSINESS_USER roles.

PV_SALES Provides access to view sales preferences. Navigate via the 
Profile icon > My Profile > Preferences.

PV_PARTNER_VIEW_
PROFILE

Provides access to view a partner’s organization information. 
Navigate via the Profile icon > Company Profile > Company 
Information > Profile tab.

PV_CHANNEL_TEAM Provides access to view a partner’s channel team. Navigate via 
the Profile icon > Company Profile > Channel Team.

Table 5–5 Oracle iStore Permissions

Permission Role Description

IBE_INT_ASSIGN_
ROLES

PV_PARTNER_
PRIMARY_
USER 

Assigns roles in the User Management 
screens.

IBE_INT_PRIMARY_
USER

PV_PARTNER_
PRIMARY_
USER 

Identifies a user as primary user in the 
Administration screens.

IBE_INT_ORG_
DETAILS

PV_PARTNER_
PRIMARY_
USER

Provides permissions to view organization 
details in the Company Profile screens.

IBE_INT_USER_
MANAGEMENT

PV_PARTNER_
PRIMARY_
USER

Provides access to User Management screens.

Table 5–4 Permissions of the PV_PARTNER_BUSINESS_USER Role

Permission Description
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IBE_VIEW_NET_PRICE PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Allows a user to see all prices (that is, list 
prices, discount prices and net prices), 
instead of just Retail Price/Your Price in the 
shopping cart and Order Tracker pages. This 
permission does not affect the user’s ability to 
view prices in the catalog.This permission 
also controls the pricing agreement, 
promotion code, and commitment 
functionalities in Oracle iStore.

For users without this permission, it is 
recommended that they also not have the 
following permissions IBE_CHECKOUT, 
IBE_CREATE_ORDER, IBE_CREATE_
RETURN, or IBE_VIEW_ORDER.

IBE_INT_ORG_EMAIL_
ADDRESSES

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Allows to view company contact information.

IBE_INT_UPDATE_
ORG_DETAILS

PV_PARTNER_
PRIMARY_
USER

Permission to update organization details in 
the Company Profile screens.

IBE_INT_CONTACT_
DETAILS

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

This permission is currently not supported. 
Although they may appear in some seeded 
user roles, they are non-functional.

IBE_INT_ORG_
ADDRESS_BOOK

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Permission to view company address book in 
the Company Profile screens.

Table 5–5 Oracle iStore Permissions

Permission Role Description
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IBE_INT_ORG_TELEX_
NUMBERS

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Permission to view telex numbers of the 
company in the Company Profile screens.

IBE_CHECKOUT PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Allows a user to see and use the Checkout 
button in shopping cart.

IBE_ASK_SALES_
ASSISTANCE

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Allows a user to request sales assistance in 
the checkout phase, and to disagree with 
terms and conditions. If a user does not have 
this permission, the ’Need Salesrep 
Assistance’ button in the Order Review page, 
and the ’I disagree - Need Assistance’ button 
is not displayed.

IBE_INT_
ADMINISTRATORS

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Gives users permission to view primary users 
of the organization in the Company Profile 
screens.

IBE_INT_ROLE_
MANAGEMENT

PV_PARTNER_
PRIMARY_
USER

Gives users permission to create and update 
roles in the Role Management screens.

IBE_INT_MANAGE_
CONTACT_INFO

PV_PARTNER_
PRIMARY_
USER

Gives users permission to update, create, and 
delete corporate addresses, e-mail addresses, 
phone numbers, and telex numbers in the 
Company Profile screens.

IBE_INT_MANAGE_
CONTACT

PV_PARTNER_
PRIMARY_
USER

Gives users permission to update, create, and 
delete corporate addresses, e-mail addresses, 
phone numbers, and telex numbers in the 
Company Profile screens.

IBE_INT_ASSIGN_
ACCOUNTS 

PV_PARTNER_
PRIMARY_
USER

Gives users permission to assign accounts in 
the User Management screens.

Table 5–5 Oracle iStore Permissions

Permission Role Description
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IBE_INT_PENDING_
APPROVAL

PV_PARTNER_
PRIMARY_
USER

Gives users permission to approve users of 
the organization in the Pending Approval 
screens.

IBE_CREATE_BILLTO_
CONTACT_ADDRESS

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Allows the user to create a new address 
associated with the bill-to contact which will 
have a bill-to relationship with the bill-to 
contact.

IBE_CREATE_SHIPTO_
CONTACT_ADDRESS

PV_PARTNER_
PRIMARY_
USER 

PV_PARTNER_
BUSINESS_
USER

Allows the user to create a new address 
associated with the ship-to contact which will 
have a ship-to relationship with the ship-to 
contact.

Table 5–5 Oracle iStore Permissions

Permission Role Description
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Setting Up the Channel Manager Dashboard

This chapter provides information on how to set up the channel manager 
dashboard. Topics included are:

■ Section 6.1, "Overview"

■ Section 6.2, "Setups"

■ Section 6.3, "Profile Options"

■ Section 6.4, "Concurrent Programs"

■ Section 6.5, "Lookups"

■ Section 6.6, "Users and Security"
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6.1 Overview
The channel manager dashboard provides vendors an easy to use, configurable user 
interface to help them with day to day responsibilities. It provides them with a 360 
degree view of their partners and activities, thereby enabling them to make 
informed decisions.

The key features of the dashboard are:

■ Dashboard User Interface (UI) - The dashboard UI includes a Key Metrics bin, 
Charts and Graphs indicating the sales performance of partners, Quick Links 
bin, and saved search results where vendors can personalize their search and 
save it. They can personalize the view of the dashboard and thus make it more 
efficient for their needs.

■ Key Metrics bin - This bin provides a consolidated view of partners. The key 
metrics have been seeded (as derived attributes) and vendors can view 
attributes, how they relate to their partners and make informed decisions. They 
can also customize the key metrics view by enabling different attributes.

■ Partner Query tool - Vendors can perform advanced searches based on profile 
attributes. They can customize the criteria by adding or removing search 
attributes to tailor their search. Oracle Partner Management integrates with 
Oracle Marketing to enable them to generate partner lists. These lists can then 
be used to run marketing campaigns and events thereby enabling marketing to 
partners.

■ Territory based security model - This release provides a territory based security 
model to access partner information. When a partner is created, the system 
automatically identifies the channel manager(s) to be assigned based on the 
territory definition. Vendors can define territories and specify territory 
qualifiers, such as geography, partner type etc. for a territory. For example, 
territory A could mean all the states in the East Coast of the U.S. that have 
global partners (global membership type). While defining a territory, they can 
also specify the channel manager responsible for that territory. For example, 
territory A (Dallas) has Greg defined as the channel manager. If the newly 
created partner (NP) is from Dallas, Greg is automatically assigned to NP as the 
channel manager by the system territory definitions can change over time. 
Vendors can also manually assign users to partner organizations thereby 
bypassing the territory definition. Users with the 'Super User' role can access all 
partners irrespective of the territory definition.
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■ Partner Lists - Oracle Partner Management integrates with Oracle Marketing to 
enable vendors to generate partner lists that can be used to run marketing 
campaigns and events.

6.2 Setups
The following sections provide information on setups that are required for the 
Channel Manager Dashboard:

■ Section 6.2.1, "Creating a Channel Manager"

■ Section 6.2.2, "Setting Up Resource Teams"

■ Section 6.2.3, "Assigning User Management Roles (JTT Roles) to Vendor Users 
(Employees)"

■ Section 6.2.4, "Territory Management Setup for Oracle Partner Manager 
Territory"

■ Section 6.2.5, "Setting Up Graphs in the Channel Manager Dashboard"

■ Section 6.2.6, "Workflow Business Event"

6.2.1 Creating a Channel Manager

Prerequisites
None.

Steps
1. Log into Oracle Forms as the HR Manager and add an employee to Oracle 

Human Resources.

2. Switch to the ’System Administrator’ responsibility and navigate to Security 
>User >Define.

3. Create a user name and password for the employee created in step 1.

4. Assign default responsibilities to the employee.

5. Switch to the ’CRM Resource Manager’ responsibility and navigate to Maintain 
Resources > Resources.

6. Select a resource by finding an existing resource by entering a resource name in 
the ’Find Resource’ pop-up window or by creating a new resource for an 
existing ’Employee’ or a ’Party’.
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7. In Resource Search Result window, click Resource Details.

8. Enter required information about the resource. 

9. Ensure that a user is already created for this resource and tied to this resource.

10. Define the Role Type ’Partner Relationship Management’ and associate the role 
of either 'Channel Manager’ or ’Channel Representative’ to the resource.

11. Save the resource setup.

6.2.1.1 Setting Up Resource Group Hierarchy 
Resource group hierarchies can be setup for vendors. Managers of the vendor user's 
group and managers of the parent groups have the same privileges as that of the 
vendor user. For example, if the vendor user is a channel manager, the manager of 
the vendor user's group can view all requests made by the channel manager's 
partner. In all cases, any user who can view a request can add notes to a request. 
Any user who can update a request can only update certain fields, which is 
controlled by the request status.

Prerequisites
None.

Steps
1. Log in to Oracle Forms as a CRM Resource Manager and navigate to Maintain 

Resources > Resources.

2. The Define Group window pops-up. Enter all the required details about a 
group by entering the group name, description, and so on.

3. Enter ’Partner Relationship Management’ usage under Usages sub-tab.

4. Add individual resources with ’Channel Manager’ or ’Channel Representative’ 
role as members of that group. These individual resources may be an employee 
of a vendor organization or a party.

5. Define ’Partner Relationship Management’ role type and ’Channel Manager’ or 
’Channel Representative’ role by clicking Member Role. 

If this group is a child group, attach the parent group information under 
Parent Groups sub-tab.

If this group is a parent group, add the child group information under 
Child groups sub-tab.
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6. Save the data.

6.2.2 Setting Up Resource Teams

Prerequisites
None.

Steps
1. Log into Oracle Forms as a CRM Resource Manager and navigate to Maintain 

Resources > Teams.

2. In the Define Teams window, enter all the required details about a team by 
entering team name, description, and so on. 

3. Enter ’Partner Relationship Management’ usage under Usages sub-tab.

4. Add member details by adding either the individual resources or group 
resources with ’Channel Manager’ or ’Channel Representative’ role.

5. Define ’Partner Relationship Management’ role type and ’Channel Manager’ or 
’Channel Representative’ role by clicking the member role button.

6. Save the data.

6.2.3 Assigning User Management Roles (JTT Roles) to Vendor Users (Employees)

Prerequisites
None.

Steps
1. Log into the self-service application as a user with the ’CRM HTML 

Administration’ responsibility and navigate to Setup > Users > Registration.

2. Select User Maintenance.

3. Enter the user name (Vendor employee) in ’Enter Search Criteria’ for User name 
field item and click Go.

4. Click on the hyper-linked user name given under User Name column in the 
displayed table. The ’User Details’ page appears with a ’Roles’ button.
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5. Click Roles. The User-Role Mapping page appears with ’Available Roles’ and 
’Assigned Roles’ shuttle box.

6. Assign any or the combination of required roles mentioned below:

■ PV_CHANNEL_ADMIN_UPDATE

■ PV_CHANNEL_ADMIN_VIEW

■ PV_CHANNEL_MANAGER

7. Click Update to save your changes.

6.2.4 Territory Management Setup for Oracle Partner Manager Territory
The following sections provide information on setting up Territory Management for 
Oracle Partner Manager Territory:

■ Setting Up Qualifiers

■ Setting Up Territories

6.2.4.1 Setting Up Qualifiers
Use the following procedure to set up Qualifiers.

Prerequisites
None.

Steps
1. Log in to Oracle Forms as a CRM Administrator and navigate to Territory 

Manager > Territory Administration.

2. Highlight the ’Administration’ sub-menu in the top menu list.

3. Click on ’Setup Qualifiers’ sub-menu, the Setup Qualifiers window appears.

4. Select Oracle Partner Manager usage from the list available on Usage field item 
in Find Qualifiers section of the Setup Qualifiers window.

5. Click Find. It displays all the partner qualifiers related to Oracle Partner 
Manager territory. 

6. Enable or disable the seeded partner qualifiers based on the business 
requirements.
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7. After making the changes in the seeded partner qualifiers, click Update 
Qualifiers to save your changes.

6.2.4.2 Setting Up Territories
Use the following procedure to set up Territories.

Prerequisites
None.

Steps
1. Log in to Oracle Forms as a CRM Administrator and navigate to Territory 

Manager > Territory Administration > Oracle Partner Manager.

2. Create a new territory by clicking the ’+’ sign by highlighting the ’Oracle 
Partner Manager’ territory or modify an existing territory by double clicking on 
an existing territory.

3. Executing the previous step results in popping-up a ’Territory Details’ form.

4. Define a territory by entering valid values to Name, Description, Start Date, 
Parent, Rank, and Winners etc. under Overview sub-tab. Ensure that the 
transaction type is ’Partner’.

5. Click the Transaction Qualifiers sub-tab to define all partner related transaction 
qualifiers for this territory by assigning the proper transaction qualifier values.

6. Click the Resources sub-tab to attach resources that have the channel manager 
or channel representative resource roles. A resource selected can be an 
individual, a resource group or a resource team. Each resource selected must 
have the access type as Partner.

7. Save the changes.

Note: After defining new territories or updating existing 
territories, the territory administrator has to execute the concurrent 
request program ’Generate Territory Packages’. The parameter 
values to this concurrent program must have ’Oracle Partner 
Manager’ as usage and ’Partner’ as transaction type. The new 
territory definitions are available for partners channel team 
assignment only after the concurrent request is executed 
successfully.
Setting Up the Channel Manager Dashboard 6-7



Setups
6.2.5 Setting Up Graphs in the Channel Manager Dashboard
For the graphs in the channel manager dashboard to be displayed correctly, the 
’Accounting Calendar’ must be set up and then the ’Refresh AS period days’ 
concurrent program must be run. 

To set up the calendar, log into Oracle Forms as the General Ledger Super User and 
navigate to Setup > Financials > Accounting > Calendar.

The ’as_period_days’ table is populated based on the calendar setup. Since the 
x-axis labels for graphs are obtained from the ’as_period_days’ table the above two 
setups are important. 

6.2.6 Workflow Business Event
A business event is any event, which might be of interest to customers or 
development teams. For example, the creation of a partner might be a business 
event. The assignment of opportunity to a partner might be another example of a 
business event.

6.2.6.1 Workflow Event Subscriptions
Event Subscriptions to a business event typically perform any or all of the following 
actions:

■ Execution of custom pl/sql code

■ Sending the business event to a predefined workflow process

■ Asynchronous messaging using Oracle Advanced Queuing

Event subscriptions can be enabled or disabled using a user interface. You do not 
have to change the code.

Oracle Partner Management provides features to assign indirect opportunities to 
partners, invite partners to enroll into a program and tools to determine 
performance of partners. Partner transactions like opportunity assignment, 
program enrollment etc. requires the partner status to be active. To determine if a 
partner is active, the following conditions need to be true:

■ Relationship between partner and vendor status is active and relationship is not 
end dated.

■ Partner Organization status is active.

■ Vendor Organization status is active.

■ Resource record tied to the partner is active in CRM resource manager.
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Whenever the partner status changes (from active to inactive or vice-versa), an 
Oracle Workflow business event is raised to indicate a change in the status of the 
partner. Customers can subscribe to the partner status business event to take 
appropriate action using the ’Define Business Event Subscriptions’ UI available 
under the Workflow Administrator Event Manager responsibility. The Workflow 
Business Event is seeded in the ’Add Business Event/Event Group’ UI available 
under Workflow Administrator Event Manager responsibility as follows:

Event Organization Update
Every time any organization related partner qualifier (for example, Partner name, 
Annual revenue, Number of employee, Customer category and so on) values 
change, a workflow business event 'oracle.apps.ar.hz.Organization.update' is raised 
to indicate that the organization information is updated.

Table 6–1 lists the subscription setup details for an organization.

Column Name Value

Internal Name oracle.apps.pv.partner.Profile.updateStatus

Display Name oracle.apps.pv.partner.Profile.updateStatus

Description This event is raised every time the partner status changes.

Status Enabled

Owner Name Oracle Partner Relationship Manager

Owner Tag PV

Customization Level Limit

Table 6–1 Subscription Setup Details

Column Name Value

System SEED11.WORLD

Source Type Local

Event Filter oracle.apps.ar.hz.Organization.update

Source Agent -

Phase 50

Status Enabled

Rule Data Key
Setting Up the Channel Manager Dashboard 6-9



Setups
Event Partysite Update
Every time any party site related partner qualifier (for example, Identifying_
address_flag, status and so on) value changes, a workflow business event 
'oracle.apps.ar.hz.PartySite.update' is raised to indicate that the party site 
information is updated. 

Table 6–2 lists the subscription setup details for a party site.

Customization Level Limit

Rule Function pv_tap_bes_pkg.organization_update_post

Workflow Type -

Workflow Process -

Out Agent -

To Agent -

Priority Normal

Parameters -

Owner Name Partner Relationship Manager

Owner Tag PV

Description Create a changed partner record in PV_TAP_BATCH_CHG_
PARTNERS table, whenever there is an updation in 
organization related partner qualifiers, resulting in 
re-definition of Channel team for that Partner Organization.

Table 6–2 Subscription Setup Details

Column Name Value

System SEED11.WORLD

Source Type Local

Event Filter oracle.apps.ar.hz.PartySite.update

Source Agent -

Phase 50

Status Enabled

Table 6–1 Subscription Setup Details

Column Name Value
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Event Location Update
Every time any location related partner qualifiers (For example: City, County, 
Country, Postal code, Province, State and so on.) value changed, a workflow 
business event 'oracle.apps.ar.hz.Location.update' is raised to indicate that location 
information got updated. A code attached to the Rule function of the subscription 
executes.

Table 6–3 lists the subscription setup details for a location.

Rule Data Key

Customization Level Limit

Rule Function pv_tap_bes_pkg.partysite_update_post

Workflow Type -

Workflow Process -

Out Agent -

To Agent -

Priority Normal

Parameters -

Owner Name Partner Relationship Manager

Owner Tag PV

Description Create a changed partner record in the PV_TAP_BATCH_
CHG_PARTNERS table, whenever there is a change in the 
organization party site related partner qualifiers, resulting in 
re-definition of Channel team for that Partner Organization.

Table 6–3 Subscription Setup Details

Column Name Value

System SEED11.WORLD

Source Type Local

Event Filter oracle.apps.ar.hz.Location.update

Table 6–2 Subscription Setup Details

Column Name Value
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Event Contact Point Update
Every time any contact point related partner qualifiers (for example, Area Code) 
change, a workflow business event 'oracle.apps.ar.hz. ContactPoint .update' is 
raised to indicate that contact point information is updated.

Table 6–4 lists the subscription setup details for a contact point.

Source Agent -

Phase 50

Status Enabled

Rule Data Key

Customization Level Limit

Rule Function pv_tap_bes_pkg.location_update_post

Workflow Type -

Workflow Process -

Out Agent -

To Agent -

Priority Normal

Parameters -

Owner Name Partner Relationship Manager

Owner Tag PV

Description Create a changed partner record in PV_TAP_BATCH_CHG_
PARTNERS table, whenever there is an updation in 
organization location related partner qualifiers, resulting in 
re-definition of Channel team for that Partner Organization.

Table 6–4 Subscription Setup Details

Column Name Value

System SEED11.WORLD

Source Type Local

Event Filter oracle.apps.ar.hz.ContactPoint.update

Table 6–3 Subscription Setup Details

Column Name Value
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6.3 Profile Options
Table 6–5 lists the profile options that need to be set up for the Channel Manager 
Dashboard.

Source Agent -

Phase 50

Status Enabled

Rule Data Key

Customization Level Limit

Rule Function pv_tap_bes_pkg. contactpoint update_post

Workflow Type -

Workflow Process -

Out Agent -

To Agent -

Priority Normal

Parameters -

Owner Name Partner Relationship Manager

Table 6–5 Profile Options

Profile 
Name

Required
- Yes/ 
Optional

Level - 

Site/ 
Application/ 
Responsibility/
User

Setting - 
Available 
setting 
choices Description

PV: New 
Partners 
Time 
Window

Yes Site

Application

Responsibility

User

Numeric 
value. 

Seeded Value 
= 30

This is used in the Key metrics 
bin in the New Partners statistics. 
The bin shows the count of 
partners registered in the system 
in the last 'N' days where 'N' is 
the seeded profile value.

Table 6–4 Subscription Setup Details

Column Name Value
Setting Up the Channel Manager Dashboard 6-13



Concurrent Programs
6.4 Concurrent Programs
Table 6–6 lists concurrent programs that need to be run for the Channel Manager 
Dashboard.

PV: 
Inactive 
Partners 
Time 
Window

Yes Site

Application

Responsibility

User

Numeric 
value. 

Seeded Value 
= 90

This is used in the Key metrics 
bin in the Inactive Partners 
statistics. The bin displays the 
count of partners in the system 
that have not placed any orders in 
the last 'N' days where 'N' is the 
seeded profile value.

PV: 
Territory 
Assignm
ent 
Online

Yes Site

Application

Responsibility

User

Yes/No.

Seeded Value 
= Yes

If the value is set to ’Yes’, the 
channel team assignment is 
performed real time during 
Partner Create/Update.

If the value is set to ’No’, the 
channel team assignment is 
performed with the submission of 
a concurrent request program 
’PV: Channel Team Assignment 
for Partners in 
TOTAL/INCREMENTAL Mode’.

It is recommended to set this 
profile option to ’No’, if 
importing large volume of 
partners from an external system.

Table 6–5 Profile Options

Profile 
Name

Required
- Yes/ 
Optional

Level - 

Site/ 
Application/ 
Responsibility/
User

Setting - 
Available 
setting 
choices Description
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Table 6–6 Concurrent Manager Program

Name of the program

Required - 
Yes or 
Optional Description

Generate Territory Packages Yes After defining new territories or updating 
existing territories, the territory 
administrator has to execute this 
concurrent program. The parameter 
values to this concurrent program must 
have ’Oracle Partner Manager’ as usage 
and ’Partner’ as transaction type. The new 
territory definitions are available for 
partners channel team assignment only 
after the concurrent request is executed 
successfully.

PV: Channel Team 
Assignment for Partners in 
TOTAL/INCREMENTAL 
Mode

Yes Parameter Name: Mode

Parameter Possible Values:TOTAL, 
INCREMENTAL

Run this concurrent program in TOTAL 
mode if you have installed Oracle Partner 
Management 11.5.10 for the first time or 
have just upgraded to Oracle Partner 
Management 11.5.10. Vendors must define 
territories before running this program in 
the TOTAL mode. This concurrent 
program assigns channel team to all 
partners in the system based on the 
territory definition. They may also want to 
consider running this concurrent program 
in TOTAL mode, if there is a significant 
change in your territory definition.

Frequency: Once after upgrading 
to/installing Oracle Partner Management 
11.5.10 or every time the territory 
definition undergoes a major change.
Setting Up the Channel Manager Dashboard 6-15



Concurrent Programs
PV: Channel Team 
Assignment for Partners in 
TOTAL/INCREMENTAL 
Mode

Yes Run this concurrent program in 
INCREMENTAL mode if you have set the 
profile option PV: Territory Assignment 
Online to ’No’ and added new partners, 
or, updated existing partners' territory 
qualifier values. Vendors must run this 
concurrent program in the 
INCREMENTAL mode, as it is possible 
that the partner territory qualifier values 
such as partner organization name, 
address and phone can be modified in 
other Oracle Application Modules such as 
Oracle Sales Online, Oracle Receivables 
and so on 

Frequency: Every day (minimum)

PV: Define Channel team for 
specific territories

Yes Parameter Name: Territory 1 … Territory 
20

Parameter Possible Values: Choose a 
territory name from the list of values.

Run this concurrent program whenever 
there is a change in assignment of channel 
managers (resources) to a territory (that is, 
to take care of organization changes such 
as the current channel manager assigned 
to the territory leaves the organization 
and a new channel manager is assigned to 
the territory) or there is a change in 
territory transaction qualifier values (that 
is, a territory may originally be defined to 
take care of partners in California state in 
the United States and now you changed 
the definition to take care of Partners of 
type Resellers in California state in the 
United States).

Frequency: Every time there is a change in 
territory setups.

Table 6–6 Concurrent Manager Program

Name of the program

Required - 
Yes or 
Optional Description
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PV: Update Partner Status Yes To determine if the status of a partner is 
active, all of the following conditions must 
be true:

1. Relationship between partner and 
vendor status is active and relationship is 
not end dated.

2. Partner Organization status is active.

3. Vendor Organization status is active.

4. Resource record tied to the partner is 
active in CRM resource manager.

Checking for partner status in all the 
above-mentioned places causes significant 
performance issues. To address this issue 
the PV_PARTNER_PROFILE table is 
enhanced and STATUS column has been 
added. This column allows to have the 
definition of Partner Status in one place 
and helps improve the performance. Also 
whenever the partner status changes, a 
Workflow Business Event is raised to 
enable the other modules in Oracle 
Partner Management and other product 
teams and customers to subscribe to the 
business event to perform necessary 
action as well.

This concurrent program needs to be 
scheduled to update the partner status 
periodically. Between the concurrent job 
executions, it may be possible for the partner 
status to be in an inconsistent state as the 
partner data can be updated through other 
Oracle Application product UIs.

Use the log file of the concurrent program 
to find out additional information when 
the concurrent program return status is 
error or warning.

Frequency: Every day (minimum)

Table 6–6 Concurrent Manager Program

Name of the program

Required - 
Yes or 
Optional Description
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6.5 Lookups
Table 6–7 lists lookups that need to be set up for the Channel Manager Dashboard.

Refresh AS period days Yes For the graphs in the dashboard and View 
trends to be displayed correctly, 
’Accounting Calendar’ must be set up and 
this concurrent program must be run. The 
as_period_days table is populated based 
on the calendar setup. For setting up the 
calendar, log into Oracle Forms as the 
General Ledger Super User and navigate 
to Setup > Financials > Accounting > 
Calendar.

Table 6–7 Lookup Values

Lookup Name

Lookup Type - 
System/

Extensible/

User Value Description

PV_INTERACTION_
OBJECT_TYPE

System ENRQ

GENERAL

MEMBERSHIP

OPPORTUNITY

PVDEALRN

PVREFFRL

SOFT_FUND

SPECIAL_PRICE

Enrollment Request

General

Membership

Opportunity

Deal Registration

Referral

Soft Fund Request

Special Pricing 
Request

Table 6–6 Concurrent Manager Program

Name of the program

Required - 
Yes or 
Optional Description
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6.6 Users and Security
Access to partner data is controlled with the help of Resource Roles (JTA), User 
Management Permissions and through a partner's channel team. 

Roles
A role type (JTF_RS_ROLE_TYPE) has to initially be defined and then JTT roles 
have to be defined. Resources have to be created and roles must be attached to 
resources. A resource can comprise of a resource, group and a team. Groups and 
teams can be added to this resource.

PV_
TRANSACTIONS

System TRANS_CLAIMS

TRANS_DEAL

TRANS_FUND

TRANS_OFFER

TRANS_OPPTY

TRANS_ORDERS

TRANS_REF

TRANS_SPR

Claims

Deal Registrations

Fund Requests

Offers

Opportunities

Orders

Referrals

Special Pricing 
Requests

PV_
CMDASHBOARD_
GRAPH

System M

Q

Monthly

Quarterly

PV_TREND_DATE_
RANGE

System B5YEAR

L2YEAR

LYEAR

YTD

Last 5 Years

Last 2 Years

Last Year

YTD

PV_TREND_
PERIOD_TYPE

System MONTH

QUARTER

YEAR

Month

Quarter

Year

Table 6–7 Lookup Values

Lookup Name

Lookup Type - 
System/

Extensible/

User Value Description
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The following resource roles determine if the logged in user is a channel manager:

■ CHANNEL_MANAGER

■ CHANNEL_REP

The JTT roles are:

■ CHANNEL_MANAGER

■ CHANNEL_ADMIN_UPDATE

■ CHANNEL_ADMIN_VIEW

Permissions
Users with the following permissions can access partner data:

■ PV_UPDATE_ALL_PARTNERS

■ PV_VIEW_ALL_PARTNERS

■ PV_INVITE_NEW_PARTNERS

The 'PV: Invite Partner' and 'PV: Invite New Partner' permissions are attached to a 
role and assigned to a primary user by default. The above permissions can be 
assigned to any user if desired.

The 'View All Partners' permission enables user to view all partner records. If an 
internal user is assigned this permission, the profile information includes the 
complete partner profile. If an external user is assigned this permission, the profile 
information includes only the profile attributes defined as 'visible to the partner'.

Table 6–8 lists resource roles and User Management permissions that determine 
how channel manager’s can access a partner’s data in the Channel Manager 
Dashboard.
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Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description

Vendor 
Employee

Channel 
Manager

Y N N N Can view and 
update all partners 
that are managed 
by the logged in 
user and as well as 
partners that are 
managed by 
channel managers 
or channel 
representatives 
reporting to the 
logged in user. 

Cannot invite new 
partners to join a 
program.

Vendor 
Employee

Channel 
Manager

Y Y N/A N Can view and 
update any 
partners in the 
system.

Cannot invite new 
partners to join a 
program.
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Vendor 
Employee

Channel 
Manager

Y N Y N Can view any 
partners in the 
system.

Can update only 
those partners that 
are managed by the 
logged in user and 
partners that are 
managed by 
channel managers 
or channel 
representatives 
reporting to the 
logged in user.

Cannot invite new 
partners to join a 
program.

Vendor 
Employee

Channel 
Manager

Y N Y Y Can view and 
update all the 
partners that are 
managed by the 
logged in user and 
partners that are 
managed by 
channel managers 
or channel 
representatives 
reporting to the 
logged in user. 

Can invite new 
partners to join to a 
partner program.

Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description
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Vendor 
Employee

Channel 
Manager

Y Y N/A Y Can view and 
update any 
partners in the 
system.

Can invite new 
partners to join a 
program.

Vendor 
Employee

Channel 
Manager

Y N Y Y Can view any 
partners in the 
system.

Can update only 
those partners that 
are managed by the 
logged in user and 
as well as the 
partners that are 
managed by the 
channel managers 
or channel 
representatives 
reporting to the 
logged in user.

Can invite new 
partners to join to a 
partner program.

Vendor 
Employee

Channel 
Rep

N N N N Can view and 
update only the 
partners that are 
managed by the 
logged in user. 

Cannot invite new 
partners to join to a 
partner program.

Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description
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Vendor 
Employee

Channel 
Rep

N Y N/A N Can view and 
update any 
partners in the 
system.

Cannot invite new 
partners to join to a 
partner program.

Vendor 
Employee

Channel 
Rep

N N Y N Can view any 
partners in the 
system.

Can update only 
those partners that 
are managed by the 
logged in user.

Cannot invite new 
partners to join a 
program.

Vendor 
Employee

Channel 
Rep

N N N Y Can view and 
update all the 
partners that are 
managed by the 
logged in user. 

Can invite new 
partners to join to a 
partner program.

Vendor 
Employee

Channel 
Rep

N Y N/A Y Can view and 
update any 
partners in the 
system. Can invite 
new partners to 
join to a partner 
program.

Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description
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Vendor 
Employee

Channel 
Rep

N N Y Y Can view any 
partners in the 
system.

Can update only 
those partners that 
are managed by the 
logged in user.

Can invite new 
partners to join a 
program.

Vendor 
Employee

Any other 
role

Y N N N/A Can view partners 
that are managed 
by the channel 
managers or 
channel 
representatives that 
report to the 
logged in user.

The logged in user 
cannot update 
partner details. 

The logged in user 
cannot invite new 
partners to join A 
program.

Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description
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Distribut
or

Channel 
Manager

Y N/A N/A N Can view only the 
partners that are 
managed by the 
logged in user and 
as well as the 
partners that are 
managed by the 
channel managers 
or channel 
representatives 
reporting to the 
logged in user.

Cannot invite new 
partners to join a 
program.

Distribut
or

Channel 
Manager

Y N/A N/A Y Can view only the 
partners that are 
managed by the 
logged in user and 
as well as the 
partners that are 
managed by the 
channel managers 
or channel 
representatives 
reporting to the 
logged in user.

Can invite new 
partners to join a 
program.

Distribut
or

Channel 
Rep

N N/A N/A N Can view only the 
partners that are 
managed by the 
logged in user. 

Cannot invite new 
partners to join to a 
partner program.

Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description
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Distribut
or

Channel 
Rep

N N/A N/A Y Can view only the 
partners that are 
managed by the 
logged in user. 

Can invite new 
partners to join a 
program.

Distribut
or

Any Other 
Role

N/A N/A N/A N/A No access to 
partner details.

Distribut
or

Any Role N/A N/A N/A N/A No access to 
partner details.

Table 6–8 Roles and Permissions 

User 
Type

Resource 
Role

Manager 
in 
Resource 
Group 
Hierarchy

PV: 
Update 
All 
Partners

PV: View 
All 
Partners

PV: 
Invite 
New 
Partners Description
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7

Setting Up Programs

This chapter provides information on setups required for Programs. Topics 
included are:

■ Section 7.1, "Overview"

■ Section 7.2, "Setups"

■ Section 7.3, "Profile Options"

■ Section 7.4, "Concurrent Programs"

■ Section 7.5, "Lookups"

■ Section 7.6, "Interaction with Other Modules"

■ Section 7.7, "Security"
rams 7-1



Overview
7.1 Overview
Programs are used to segment partners and provide them with different benefits. 
Vendors can create programs for existing partners as well as new partners. Vendors 
can also recruit and maintain partners with specific incentive packages. This helps 
increase and maintain a strong partner community that further helps in increasing 
overall market share and revenues.

Vendors can also customize programs to recruit new partners and motivate existing 
partners. Programs can be created for groups of partner types, for example, 
Resellers, Value Added Resellers (VAR), Distributors, and so on.

Vendors can organize and offer specific benefits to partners. Benefits such as sales 
opportunities, product information, marketing collateral, services, and training can 
be grouped within a program. Partners can gain access to the benefits by enrolling 
into a program that provides these benefits.

With this release, vendors can provide some additional benefits with a program. 
They are:

■ Referrals - A partner refers business to the vendor and gets compensated when 
the referral is converted to an order.

■ Deal Registrations - A partner registers a deal with the vendor for 
non-competition purposes.

■ Special Pricing Requests - A partner requests for discounts for newly purchased 
inventory or to move existing inventory.

■ Fund Requests - A partner can request for funds to carry out certain marketing 
activities.

7.2 Setups
The following sections provide information on setups that are required for this 
functionality.

Programs provide a basis to effectively segment and manage partner interactions 
across the Oracle e-Business Suite.

Creating a program involves:

1. Setting up program types and approvers

2. Using the AMS: Generic Approval framework for approvals

3. Creating an inventory item
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Programs can be targeted for different partner types using program types. Program 
types are created in the Administration tab. For a program to be active, it needs to 
be approved. Approvers are setup using program types and a sequence can be 
associated with approvers to route approval requests sequentially. The ‘AMS: 
Generic Approval Framework’ is used to route approval requests, notifications, and 
get approvals. 

For more information on the framework, see Oracle Marketing User Guide.

If a program is priced and a partner enrolls in it, a sales order is created using 
Oracle Order Management. To support order creation, the program needs to exist as 
an inventory item. So, when a program is created, an inventory item also gets 
created. Hence, Oracle Inventory needs to be set up correctly. 

The setups needed to be able to create programs are:

■ Section 7.2.1, "Setting Up Program Types"

■ Section 7.2.2, "Setting Up Program Approvers"

■ Section 7.2.3, "Setting Up Payment Options"

■ Section 7.2.4, "Setting Up Locking Rules"

■ Section 7.2.5, "Setting Up Mandatory Rules"

■ Section 7.2.6, "Setting Up Program Overview"

■ Section 7.2.7, "Setting Up Contracts"

■ Section 7.2.8, "Setting Up Price Lists"

■ Section 7.2.9, "Setting Up Requirements"

■ Section 7.2.10, "Setting Up Benefits"

■ Section 7.2.11, "Mapping Responsibilities"

7.2.1 Setting Up Program Types
A ‘program type’ is a combination of partner types. Only partners of selected 
partner types, can enroll in a program. Program types are created to control 
approval routings. 

Prerequisites
None.
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Steps
1. Log in as the channel administrator and navigate to Programs > Program Types 

> Partner Program Types page.

2. Click Create Type.

The Create Partner Program Type page appears.

3. Enter appropriate details and save your changes.

7.2.2 Setting Up Program Approvers
For a program to be active, it needs to be approved. Approvers are setup using 
program types. When a user creates a program with a ‘program type’ and submits it 
for approval, a notification is sent to the approver associated with the program 
type. A sequence can be associated with approvers to route approval requests 
sequentially. The Oracle Marketing Framework (AMS: Generic Approval 
Framework) is used to route approval requests, notifications, and get approvals. 

For more information on the framework, see Oracle Marketing Implementation Guide.

Approvers are setup while creating a program type. 

Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to the Programs > Program 

Types > Partner Program Types page.

2. Click Create Type.

The Create Partner Program Type page appears. 

3. In the Approvers region in the Create Partner Program Type page, select an 
approver using the User/Role LOV.

Approvers should have the responsibility 'Workflow User Web Application' to 
enable them to approve or reject a program. 

4. Enter other details appropriately and save your changes.
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7.2.3 Setting Up Payment Options
When partners enroll into a program, they have to pay a fee. They can pay by cash, 
credit, check or a purchase order. The method of payment depends on the 
geographical region that a partner is located in. When a partner enrols in a program 
that requires a fee, payment methods based on this setup are displayed to them.

Payment methods are set up based on geographical regions and do not differ even 
if programs are available in different regions. Customers can thus use a common 
payment method for all programs.

Use this procedure to add a payment rule to specify available payment methods by 
geographic regions. 

Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to the Programs > Payment 

Methods > Payment Option Details page.

2. Click Add Payment Rule. 

The Payment Options Details page appears. Select a geographic region and 
specify applicable payment methods and click Apply. 

3. Save your changes.

7.2.4 Setting Up Locking Rules
While creating a partner or a program, certain fields such as program level and 
program status must be locked depending on the program status. Locking rules can 
be created to select fields that should be locked to prevent updates. Since fields 
related to a partner or a program transit from one status to another, certain aspects 
of the fields must be locked to prevent modification in the future. Locking rules 
determine fields that are no longer updatable as a partner or program related field 
achieves a new status.

Prerequisites
None.
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Steps
1. Log in as the channel administrator and navigate to Programs > Locking Rules 

> Locking Rule page.

2. Select an object type, attribute and status from the respective drop-down lists.

3. In the Locking Rule region, specify fields that should be locked in a particular 
program status. 

4. Save your changes.

7.2.5 Setting Up Mandatory Rules
While creating a program and defining program characteristics, certain fields such 
as program start date and program name are required to be filled. Mandatory rules 
are created to select fields that are mandatory to be filled before a program can be 
created. 

Mandatory rules are created in the Administration tab.

Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Programs > Mandatory 

Rules > Mandatory Rule page.

2. Select an object type and attribute from the respective drop-down lists.

3. In the Mandatory Rule region, specify fields that are mandatory.

4. Save your changes.

7.2.6 Setting Up Program Overview
When a vendor user creates programs, they can create a summary (program 
overview) of the program which reflects details of a program. The summary is 
HTML content that is displayed to partners to help them understand program 
requirements, benefits, and so on. The summary can be the setup type, name, 
program start and end dates, owner, partner type, country, language, and 
description. Program summary can be set up by navigating to the enrollment 
questionnaire and clicking on the Program Overview button. The content is stored 
in/retrieved from Oracle Content Manager (OCM) and has to be approved before it 
can be publicly available.
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Use this procedure to grant access privileges to vendor users (to create a JTA 
resource group and include vendors in the group) to create, update or approve 
program summary.

Prerequisites
Grant access privileges in OCM.

Steps
1. Log into the HTML application with the Content Super User responsibility.

2. Navigate to the 'PV_PRGM' directory  under root.

3. Click on Folder properties.

4. Choose Access Control as 'Override'.

5. In the Permissions section , click on add another row and choose type and add 
the user/group/responsibility to the permission list and  grand required 
priveleges by and click Apply.

For more information, see Oracle Content Manager Implementation Guide.

7.2.7 Setting Up Contracts
When partners enroll into a program, they might be expected to sign a contract. 
Global partners can be presented with contracts that differ from contracts presented 
to standard partners.

Multiple contracts can be associated to a program. The contracts are tied to the 
member type. Oracle Partner Management leverages the Oracle Contracts Core 
functionality to create and attach one or more contract templates to each program. 

A contract template can be attached to a program based on geography, program 
and a partner’s membership type in a program. When partners from these 
geographies enroll into the program, they are expected to sign the corresponding 
contracts.

Partners who subscribe to programs, can review terms and conditions associated 
with the contract template attached to this program and decide to accept, reject or 
print and fax the signed copy later.

For a contract to be available in Oracle Partner Management, users must create a 
contract template under the ’Partner Contracts’ category.
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In Oracle Partner Management, the contract template is displayed and not the 
actual contract. Vendors attach this contract template to a program. Once the 
partner clicks on Accept/Print and Fax/Reject during the enrollment, anew contract 
is created.

Use the following procedure to create a new contract template.

Prerequisites
None.

Steps
1. Log into Oracle Forms as a Contracts Administrator and navigate to Oracle 

Contracts > Contracts Navigator window > Tools.

2. Launch Contracts. The Oracle Contracts window appears.

3. Select the Contract Navigator tab and from the menu bar, select Tools > New to 
create a new contract template.

The Create a New Contract window appears.

4. Select ’Partner Contracts’ as the category and click Create.

The Contracts Authoring window appears.

5. In the Contract Number field, enter a contract number to identify the template.

6. Select the Sell option from the Intent drop-down list.

7. In the Details tab, select a group name from the Group Name drop-down list.

8. From the menu bar, select Actions > Save as Template.

The Save As Template dialog box appears. 

9. Enter a name in the Template Name field.

10. Save your changes.

Guidelines
In some situations you can open an existing contract and save it as a template. 
When you open a template within the Contract Authoring window you see the 
Template Name as a field instead of a Contract Number.

For more information on the Contracts Module, see Oracle Contracts Core User Guide.
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7.2.8 Setting Up Price Lists
When partners enroll into a program, they are charged a price or a fee. A price is 
defined by associating a program with a price list. Different price lists can be 
associated to a program using the ‘Pricing & Payments’ side navigation link. The 
side navigation link appears only when the 'Membership Fee Required' check box is 
selected for that program. 

Pricelists are created in Oracle Advanced Pricing or Oracle Order Management 
based on the profile value ‘QP: Source System Code’ set in Oracle Partners at the 
application level. The value should be ‘Oracle Pricing’. New pricelists can be 
created by logging in to the application and navigating to the Pricelist Setup 
window. 

Multiple prices can be defined by associating a program with multiple price lists. If 
multiple price lists are associated, vendors need to define precedence so that the 
appropriate price is selected. The multi-currency feature of Oracle Advanced 
Pricing enables price lists to select the appropriate price.

For more information, see Oracle Advanced Pricing User’s Guide.

7.2.9 Setting Up Requirements
When a program is created, requirements can be specified with it to qualify a 
partner. When a partner enrolls into this program, requirements are used to 
determine if the partner qualifies to enroll into the program.

Vendors must define a qualification pass/fail score for the partner enrollment 
application. Qualification rules can be defined for each program and the rules 
evaluate the partner's enrollment questionnaire. 

Vendors can view if a partner has passed or failed the base criterion that is set for 
the program. The enrollment request approver can override the system generated 
result as and if necessary.

Before defining a requirement, attributes must be set up in the Administration tab.

Use the following procedure to create a new benefit.

Prerequisites
None.

Steps
1. Log in as the channel manager and click the Program Quick link.
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The Partner Programs page appears.

2. Click a program name hyperlink. 

The Edit Program page appears. 

3. Click the Requirements side navigation link and add attributes or program 
prerequisites as requirements.

4. Save your changes.

7.2.10 Setting Up Benefits
Benefits are associated with a program and when a partner enrolls into the 
program, they can avail these benefits. Some of the benefits helps partners refer 
leads, register deals, request funds, access quotes, opportunities, submit special 
price requests and so on. 

Benefits can be categorized into benefit types, viz. Deal Registration, Lead Referrals, 
Soft Funds, and Others. 

The benefit framework provides an ability to: 

■ Store high-level benefit information in one place

■ Present a summary view of these benefits available for partners

■ Create 'Others' benefits

■ Associate these benefits with a program.

The channel administrator can also create benefits of type 'Others’ and associate 
these benefits with a program. Most of the benefits are defined in other modules 
such as Deal Registration, Lead Referrals, and Soft Funds except the 'Others' benefit 
type. Once these benefits are associated to a program, the partner is given these 
benefits upon their successful membership. The channel administrator can review 
all the benefits in the Benefits Administration screen. They can drill down to these 
benefits to view benefit specific details like soft funds, or lead referrals. 

The channel administrator can create any benefit for a chosen benefit type by 
navigating to the corresponding benefit creation window. Only benefits in the 
’Inactive’ or ’Drafts’ state have the ’Trash’ icon enabled. When a benefit is active, it 
cannot be deleted unless the status is updated to ’Inactive’.

Use the following procedure to create a new benefit.
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Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Programs > Benefits > 

Benefit Administration page.

2. Select a benefit type from the Create Benefit drop-down list and click Go. 

The Benefits Creation page appears.

3. Enter a benefit name and select a benefit status and click Apply.

Only benefits with the ’Inactive’ or ’Draft’ status has the ’Remove’ icon enabled. 
When a benefit is active, it cannot be deleted unless the status is updated to 
inactive.

7.2.11 Mapping Responsibilities
Responsibilities are set up as part of system administration and is used across the 
Oracle e-Business Suite to give functional access to applications. Channel managers 
and sales representatives are assigned responsibilities when their accounts are 
created.

Partners are assigned responsibilities based on their program enrollments and 
geography through the responsibility mapping table. Channel administrators can 
set up different responsibilities for different program and geography combinations. 
Based on the geography and the program that a partner enrolls in, a partner is 
granted the responsibility (primary user or business user). When the channel 
administrator adds, changes or deletes a responsibility, the concurrent program ’PV 
- Assign/Revoke user responsibilities’ is automatically run to update partner 
responsibilities, that is , partner responsibilities are automatically updated when the 
channel administrator updates the responsibility tied with a rule.

For partners, responsibilities are determined based on the exact geographical region 
match, user type and program. 

In the Responsibility mapping screen, while selecting a responsibility, the LOV uses 
the following criteria to filter responsibilities:

■ Responsibility application has to be Oracle Partner Relationship Management 
for it to show up in the Responsibilities LOV in the Responsibility Mapping 
Rules UI.
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■ PV: Is External Responsibility profile option needs to be set to Yes at the 
responsibility level for responsibilities that should show up in the 
Responsibilities LOV in the Responsibility Mapping Rules UI.

By default, a new partner user is assigned one of the responsibilities mentioned 
below, based on his/her user type:

■ Primary User: Partner Super User

■ Business User: Default Partner User

Newly registered partner users are assigned default responsibilities when the 
system cannot find any program responsibilities based on their enrollments into 
programs. These default responsibilities are figured out by matching the partner’s 
address to the closest geography match and user type of responsibility mapping 
rules without any program attached. Oracle Partner Management ships two default 
responsibility mapping rules with the default partner user responsibility without 
any program attached, and geography defined as ’World’ and one for two partner 
user roles.

Use this procedure to map responsibilities.

Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Programs > Responsibility 

Mappings > Responsibility Mapping Overview page.

2. Click Create Mapping to add new responsibilities.

The Create Responsibility Mapping Setup page appears.

3. Select a geography level from the Geography drop-down list. Based on the 
geography level, select a geographical location from the location LOV.

4. Optionally, you can select a program name. Select a user role : All (for both 
business and admin users) , Business User or Partner User.

5. Select a responsibility name from the Responsibility LOV.

6. Click Apply to save your changes.
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7.2.12 TCA Events and Subscriptions

1. Creating or Updating Relationships
In TCA, for global and subsidiary relationships, the relationship name used is 
PARTNER_HIERARCHY. To keep the member type up-to-date, the following TCA 
event subscriptions are registered for CREATE/UPDATE of the relationship status. 

1. oracle.apps.ar.hz.relationship.update

2. oracle.apps.ar.hz.relationship.create

2. Change in Partner Address
If the address of a partner changes, a TCA event subscription is registered to update 
the partner user responsibilities. 

■ oracle.apps.ar.hz.location.update

The above subscription is seeded out of the box.

Setup
Run the concurrent program ’Workflow Agent Listener’ with the parameter ’WF_
DEFERRED’. Set this up to run every hour. This concurrent program is seeded in 
the request group of the responsibility ’System administrator’. When this 
concurrent program is executed, every subscription from every instance of events in 
the DEFERRED queue at that moment is executed. The Workflow Agent Listener 
concurrent program is shipped as 'DISABLED'.

7.2.13 Partner Invitations
Workflow sends out invitations to all the primary users of the partner organization. 
The workflow item type for this is PV: Partner Program Notifications and the 
workflow process used in the above item type is EVENT_NOTIF_PROCESS . This 
item type can be customized as needed.

7.3 Profile Options
Table 7–1 lists the profile options that need to be set up for Programs.
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Table 7–1 Profile Options

Profile Name

Required

-Yes/ 
Optional

Level - 

Site/ 
Applicatio
n/ 
Responsib
ility/User

Setting - 
Available 
setting 
choices Description

PV: Default 
Program for 
New Partner

Optional Site - When this profile option is 
set, every time a new partner 
is created in the system, the 
partner gets automatically 
enrolled into this program 
after registration.

AMS : Item 
Validation 
Master 
Organization

Yes S/A/R/U Organization 
Name

Inventory Organization in 
which a program is created 
as the inventory item.

PV: System 
Login URL

Yes Site http://serv
ername:port
/OA_
HTML/jtflog
in.jsp

This url is embedded in the 
program enrollment related 
workflow notification sent to 
partner and vendor users. 
The approver can view 
details of the program from 
this link.

PV:Self Service 
URL with 
Workflow 
Notification

Yes Site http://serv
ername:port
/OA_
HTML/US/ICX
INDEX.htm

This url is embedded in the 
program approval request 
notification sent to vendor 
users.

PV: Is External 
Responsibility

Optional Responsibil
ity

Yes/No If this profile is set to 'yes' for 
a given responsibility, the 
system displays this 
responsibility in the LOV on 
the program benefits page. If 
this profile is set to 'no' for a 
given responsibility, system 
does not display the 
responsibility in the LOV on 
the program benefits page.
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PV: iStore 
Login URL

Yes Site http://Mach
ine 
Name:Port 
No/OA_
HTML/ibeCAc
dLogin.jsp?
ref=ibeCZzd
Minisites.j
sp?grp=PART
NER

This profile is to get the 
partner iStore login in 
workflow notifications. This 
should be set with the 
machine name and port 
number.

IBC: Use 
Access Control

Optional Site Null or No Setting value to 'No' or 'Null' 
skips the security check in 
Oracle Content Management 
while creating the content 
for program through 
Summary window.

See also Setting Up Program 
Overview.

QP: Source 
System Code

Yes Site/Appl/
User

’Oracle Pricing’ 
at Oracle 
Partner 
Management 
application 
level

Oracle Pricing: This value 
indicates that only price lists 
are created from 'Oracle 
Pricing' are recognized while 
associating the price list with 
the Partner Program object.

Table 7–1 Profile Options

Profile Name

Required

-Yes/ 
Optional

Level - 

Site/ 
Applicatio
n/ 
Responsib
ility/User

Setting - 
Available 
setting 
choices Description
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7.4 Concurrent Programs
Table 7–2 lists concurrent programs that need to be run for Programs.

PV: 
Concatenated 
Inventory Flex 
Segments for 
Program

Yes R/A/S Free flow text This value is used to 
populate the key flexfeild 
segment values while 
creating the program as an 
inventory item internally. 
The value should be in the 
format:

Segment1.Segment2.Segmen
t3.Segment4 etc. (Etc.is just 
to denote as many segments 
as implemented). Here 
Segment1, 2,3… should be 
the values of the key 
flexfield segments that are 
used for inventory item 
creation from program. The 
delimiter should be the one 
that inventory uses to define 
the segments. One of the 
segment values should have 
the code PV_PRGM_FLEX_
CODE. This code is replaced 
with first five characters of 
program name concatenated 
with program_id while 
creating the inventory item. 
So, for example, the value 
could be 
US.SOFTWARE.EBUS.PV_
PRGRM_FLEX_CODE 
where US, SOFTWARE are 
key flexfield segment Values 
and '.' is delimiter.

Table 7–1 Profile Options

Profile Name

Required

-Yes/ 
Optional

Level - 

Site/ 
Applicatio
n/ 
Responsib
ility/User

Setting - 
Available 
setting 
choices Description
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7.5 Lookups
Table 7–3 lists lookups required for setting up Programs.

Table 7–2 Concurrent Programs

Concurrent 
Program Description

PV: Close Ended 
Programs and 
Memberships

This concurrent program is optional and updates the status to 
’Closed’ for all programs with program end date in the past of 
current system date.

PV: Refresh Partner 
Program Eligibility

Partner eligibility to enroll into a program based on the prerequisites 
is evaluated by this concurrent program. Run this atleast once a day 
to keep partner eligibility to enroll in a program up-to-date.

If this concurrent program is not run, the new partner program 
created is only available for new partners and not for existing 
partners.

PV - Update user 
resp when resp 
mapping is created 
or deleted

This concurrent program is required. Any change in the 
responsibility mapping setup affects the responsibilities that get 
assigned to partner users. There is no fixed frequency.

Table 7–3 Lookups

Lookup Type Value Description

PV_BENEFIT_TYPE PVDEALRN

PVREFFRL 

OZFSFBEN

OTHERS

STORES

Deal Registration

Referrals

Soft Funds

Other benefit types

Stores

PV_BENEFIT_STATUS ACTIVE

INACTIVE

DRAFT

FAILED_VALIDATION

INACTIVE

PENDING

Active

Inactive

Draft

Failed Validation

Inactive

Pending

PV_LOOKUPS - The Benefit Type drop down gets 
lookup values from this lookup 
type.
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7.6 Interaction with Other Modules
This section lists interactions with other Oracle Partner Management flows and 
other Oracle E-Business Suite products.

■ Oracle Content Manager - When vendors create a program, they can create a 
summary of the program which reflects details of a program. The summary is 
HTML content that is displayed to partners to help them understand program 
requirements, benefits, and so on. The summary can be setup type, name, 
program start and end dates, owner, partner type, country, language, and 
description. Program summary can be set up by navigating to the enrollment 
questionnaire and clicking on the Program Overview button.

■ Oracle Contracts - When partners enroll into a program, they might be expected 
to sign a contract. Global partners can be presented with contracts that differ 
from contracts presented to standard partners. Multiple contracts can be 
associated to a program. Contracts are tied to the member type. Oracle Partner 
Management leverages the Oracle Contracts Core functionality to create and 
attach one or more contract templates to each program. 

■ Oracle Marketing - For a program to be active, it needs to be approved. 
Approvers are set up using program types. When a user creates a program with 
a ‘program type’ and submits it for approval, a notification is sent to the 
approver associated with the program type. A sequence can be associated with 
approvers to route approval requests sequentially. The Oracle Marketing 
Framework (AMS: Generic Approval Framework) is used to route approval 
requests, notifications, and get approvals. 

PV_PROGRAM_
BENEFITS

AOF

FPD

IBB

IQW

PH

PN

PWK

RN

Access to Online Forms

Free Product Demo

Invitations to Business Briefings

Invitations to Quarterly Workshops

Partner Helpdesk

Partner Newsletter

Partner Welcome Kit

Regular Newflashes

Table 7–3 Lookups

Lookup Type Value Description
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■ Oracle Advanced Pricing - Pricelists are created in Oracle Advanced Pricing or 
Oracle Order Management based on the profile value ‘QP: Source System Code’ 
set in Oracle Partner Management at the application level. The value needs to 
be ‘Oracle Pricing’. Multiple prices can be defined by associating a program 
with multiple price lists. If multiple price lists are associated, vendors need to 
define precedence so that the appropriate price is selected. The multi-currency 
feature of Oracle Advanced Pricing enables price lists to select the appropriate 
price.

■ Oracle Order Management - If a program is priced and a partner enrolls in it, a 
sales order is created using Oracle Order Management. Also, pricelists are 
created in Oracle Advanced Pricing or Oracle Order Management based on the 
profile value ‘QP: Source System Code’ set in Oracle Partner Management at 
the application level.

■ Oracle Inventory - To support order creation, the program needs to be present 
as inventory item. So, when a program is created, an inventory item is also 
created. Hence, Oracle Inventory needs to be set up correctly. 

■ Oracle Trade Management - Oracle Trade Management is used to create offers 
to provide discounts, which in turn uses Oracle Advanced Pricing.

7.7 Security
When a program is created, it must be approved by valid individual(s) within the 
vendor organization before a partner enrolls in it. Approvers are set up while 
creating a program type and can be designated by name or role. They receive either 
an e-mail or notification alerting them to review programs and approve them. 
When a program is submitted for approval, a notification is sent to the approver 
associated with the program type. A sequence is associated with approvers to route 
program approval requests sequentially. The Oracle Marketing Framework (AMS: 
Generic Approval Framework) is used to route approval requests, notifications, and 
get approvals. 

For more information on the framework, see Oracle Marketing Implementation Guide.

Approvers should have the responsibility 'Workflow User Web Application' to 
enable them to approve or reject a program. 
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8

Setting Up Enrollments

This chapter provides information on setups required for Program Enrollments. 
Topics included are:

■ Section 8.1, "Overview"

■ Section 8.2, "Setups"

■ Section 8.3, "Profile Options"

■ Section 8.4, "Concurrent Programs"

■ Section 8.5, "Interaction with Other Modules"

■ Section 8.6, "Security"
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8.1 Overview
Oracle Partner Management enables a partner to be part of a vendor’s indirect sales 
force by enrolling into programs designed by the vendor. Programs provide a basis 
for vendors to effectively segment and manage partner interactions. Vendors can 
group programs to target certain partner segments. Enrolling into these programs 
provide the utility to simplify a partner’s relationship with a vendor.

Partners can enroll into a program and can get a membership into the program. 
They can enroll into a program through the Available Programs Bin or enroll into 
programs that have been initiated by a distributor. This means that while creating 
the program, the distributor would have selected the option to be able to invite 
partners to enroll into programs.

During the enrollment process, the partner can review the contract template 
attached to a program and agree or disagree with the contract. The partner can also 
choose to print and fax or mail a signed copy of the contract later, and continue 
with the enrollment process.

8.2 Setups
The following sections provide information on setups that are required for 
Enrollments:

■ Section 8.2.1, "Setting Up Address Validation"

■ Section 8.2.2, "Setting Up Oracle Order Management"

■ Section 8.2.3, "Setting Up Oracle iPayment Server"

■ Section 8.2.4, "Setting Up Runtime Variables"

■ Section 8.2.5, "Setting Up Tax Rules"

■ Section 8.2.6, "Setting Up Approvers using Oracle Approvals Management 
(AME)"

8.2.1 Setting Up Address Validation
The receivables address validation system option needs to be set up as address 
validation is required for payment. Billing address is validated against tax locations 
that are set up in Oracle Receivables. 

For more information on how to set up the address validation system option, see 
the Oracle Receivables User Guide.
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8.2.2 Setting Up Oracle Order Management
All the required Order Management setups need to be completed before using the 
enrollment payment pages. 

For information on the list of Order Management setups, see Oracle Order 
Management Suite Implementation Guide and Oracle Order Management User Guide.

8.2.3 Setting Up Oracle iPayment Server
The Oracle iPayment server needs to be set up for using the credit card payment 
method. 

For information on how the payment server needs to be set up, see Oracle iPayment 
Implementation Guide.

8.2.4 Setting Up Runtime Variables
The jtt_cookie_path and jtt_cookie_domain java runtime variables need to be set up 
properly for transferring user cookie from https server to http server and vice versa. 
This is so that users need not explicitly enter user name and password again when 
switching from https to http and vice versa. This setup is needed only if payment 
pages need to be secure and rest of the pages need to be non secure.

For information on how to use the java run time variables, see JTT documentation.

8.2.5 Setting Up Tax Rules
Tax rules need to be set up for calculating tax for membership fee. 

For information on how rules should be set up, see the Oracle Receivables Tax Guide.

8.2.6 Setting Up Approvers using Oracle Approvals Management (AME)
A partner joins a program by filling out all the required information in the 
enrollment form and at the end of the process, a Thank You page is displayed. At 
this point, the enrollment request is submitted for approval. A For Your 
Information (FYI) notification is sent by the system to the approver and the 
approver logs into the application and approves/rejects the request.

Setting up Approver for Enrollment requests
This has to be done through Oracle Approvals Management module. 
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1. Log in to self-service application as a user who has AME Application 
Administrator responsibility. 

2. Click AME Application Administrator > Approvals. This brings up the AME 
page.

The Transaction Type used for Enrollment Approvals is PV: Partner Program 
Enrollment Requests (internally it is ENRQ).

Attributes Tab
Click Attributes and select the above transaction type from the drop-down. You can 
see the mandatory and non-mandatory attributes pre-defined for the enrollment 
request approvals. You may not need to add new attributes. For information on 
adding new attributes, see Oracle Approvals Management Implementation Guide. You 
can only add non-mandatory attributes. 

You can also look at how the existing non-mandatory attributes are defined and 
click Add Attribute and provide a new name. If the attribute's value is based on a 
query, you need to provide the query based on the syntax defined in the Oracle 
Approvals Management Implementation Guide. 

For example, a query for the Attribute COUNTRY.

Seeded attributes:

Zip Code, Program Name, PV: PARTNER PROGRAM ENROLLMENT TYPE, 
Country, PROGRAM TYPE, IS_END_USER, IS_OEM, IS_PROSPECT, IS_
RESELLER, IS_VAD

Conditions Tab
Click the Conditions tab and select the above transaction type from the drop-down 
list. Click Add Conditions and select Ordinary.

Select the attribute on which you want to set a condition. For example, select 
Program_Name and provide an attribute value. This should match the program 
name your company has created through the Create Program window in the Oracle 
Partner Management application.

Approval Tab
There is no set up required for this. But the approval type for enrollment approvals 
is approval-group chain of authority (chain of authority includes an approval 
group).
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Groups Tab
Click Create Group. This takes you to the detail window. Click Add Approver. 
Search for an approver and click Continue and then click Create Member. If there 
is more than one approver, pick the order in which the approvals has to be 
performed.

Rules Tab
1. Click the Rules tab and select the above transaction type from the drop-down. 

Click Add a Rule. 

2. Enter a description and select Rule Type as list-creation-rule. Select the start 
date and end date appropriately. Click Continue.

3. Select Approval Type as 'Chain of authority includes an approval group and 
click Continue. 

4. Select an Approval group from the drop-down and click Continue.

5. Select ’None’ for constraints and click Continue.

Select Ordinary-Condition attributes. Note that this is a multi-select box. So, if you 
are planning to create a rule based on more than one condition, select attributes you 
are basing the conditions on and click Continue. This brings up a window that 
displays all the conditions created through the Conditions tab for all the selected 
attributes.

Select the conditions you want to associate with this rule and click Continue. A 
message ’The rule you entered has been created’ appears.

The partner enrollment request should now be routed to the approvers set up in the 
rule.

Test Tab
In the Test tab, select your transaction type and select ’Create a test transaction’. 
Click Continue and select Requestor Type as ’None’. Click Continue and provide 
the same attribute value that you gave in the conditions tab and check for the rule 
you defined in the List-Creation Rule. Click View Approver List to view the 
approver list.

Admin Tab
There is a simple set up to define an admin user for your transaction type PV: 
Partner Program Enrollment Requests. This user receives a workflow notification 
from Oracle Approvals Management module, if there is any error in AME.
Setting Up Enrollments 8-5



Profile Options
Select ’Update a transaction types configuration-variable values’ and click 
Continue. Click adminApprover: the person or user that AME identifies as the next 
approver when it raises an exception. Click Continue and query for an approver 
and assign the approver. The admin user should fix the issue in AME and run the 
concurrent program PV: Process the errored enrollment requests for approval. This 
re-submits the enrollment request so that the approval is routed to the correct 
business user.

8.3 Profile Options
Table 8–1 lists the profile options that need to be set up for Enrollments.

Table 8–1 Enrollment Profiles

Option

Required 
- Yes/ 
Optional

Level
Available 
setting choices Description

PV: Default 
Enrollment 
Request 
Approver

Yes Site/Appli
cation

- When AME does not return an 
approver, the enrollment 
request would be in queue of 
this approver.

PV: Program 
Enrollment 
Request 
Reminder 
Notification 
Duration

Yes Site/Appli
cation

15 Reminder duration in days. If 
action is not taken within this 
interval, reminder notification 
is sent after every interval.

PV: Allow 
Approval 
Without 
Contract

Yes Site Yes/No Yes: During enrollment request 
approval, system allows the 
approver to approve the 
request even though the 
contract is not signed (online or 
hardcopy) by the partner.

No: During Enrollment request 
approval, system does not 
allow the approver to approve 
the request if the contract is not 
signed (online or hardcopy) by 
the partner.
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PV: Default 
Salesperson 
used for 
Orders

Yes Site Should be the 
salesperson name 
picked up from 
the LOV.

This person is associated while 
creating the order in Order 
Management for partner 
enrollment. You can select a 
dummy salesperson if you do 
not want the sales quota to be 
associated to this salesperson 
for partner enrollments.

PV: Order 
Cancel 
Reason

Yes Site All the available 
cancel reason 
codes from OM 
cancel lookup 
(CANCEL_
CODE)

This profile option value is 
used as cancel reason when an 
order needs to be cancelled 
either because a partner user 
cancelled an enrollment 
request when he is in the 
payments section or because 
the approver rejected a 
enrollment request submitted 
by a partner.

PV: Non 
Shippable 
Order 
Transaction 
Type For 
Partner 
Program 
Enrollment 
Requests

Yes Site All the available 
transaction types 
for ORDER type 
(OE_ORDER_
TYPES_V view)

Since the orders are non 
shippable and invoiceable 
orders, profile option value has 
to be one of the BILL ONLY 
transaction types with invoice 
option enabled. This is used as 
transaction type for creating 
orders.

PV: Max 
number of 
credit card 
authorizatio
n

Optional Site A number is 
expected

If the credit card authorization 
fails for these many times 
consecutively, the partner is 
not allowed to change payment 
information. If this profile 
value is not set, the number is 
defaulted to 3. 

OM: 
Payment 
method for 
Credit Card 
Transactions

Yes Site, 
Applicatio
n,Responsi
bility, and 
user

Default method 
for credit card 
transactions

This credit card transaction 
method is used to figure out 
merchant ID from Receivables, 
which is required when getting 
credit card authorizations from 
iPayment.

Table 8–1 Enrollment Profiles

Option

Required 
- Yes/ 
Optional

Level
Available 
setting choices Description
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8.4 Concurrent Programs
Table 8–2 lists the concurrent programs that need to be run for Enrollments.

PV: Secure 
URL

Optional Site This profile 
option needs to 
be set to secure 
server and port 
that should be 
used in payment 
pages

If this profile is set, payment 
pages use this secure (https) 
server and port. Otherwise, the 
regular port in payment page is 
used. Example of this profile 
option value: 
http://qapache.us.oracl
e.com:2000/OA_HTML/

PV: Non 
Secure URL

Optional Site This profile 
option needs to 
be set to non 
secure server and 
port that should 
be used after 
processing 
payment

If the profile is set, the server 
and profile mentioned is used 
to switch to non secure url once 
payment has been processed. 
Otherwise, the same port that 
is used in payment pages are 
used. Example of this profile 
option value: 
http://qapache.us.oracl
e.com:1111 /OA_HTML/

Table 8–2 Concurrent Programs

Concurrent 
Program Description

PV: Send enrollment 
notifications to 
partner user

This concurrent program sends out the following program related 
notifications to partners based on the program definition.

Renewal notifications: This notification is sent out to partners if their 
membership is about to expire or has expired (based on program 
criterion).

Contract not received: This notification is sent out to partners if they 
have opted to fax a copy of the partnership contract and the vendor 
has not received it within specified time period.

Table 8–1 Enrollment Profiles

Option

Required 
- Yes/ 
Optional

Level
Available 
setting choices Description
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8.5 Interaction with Other Modules
This section lists interactions with other Oracle Partner Management flows and 
other Oracle E-Business Suite products.

■ Oracle Order Management - Oracle Order Management is used to process sales 
orders when a partner submits an enrollment request for a program that 
contains fees. It is used to process financial liabilities. Oracle Order 
Management is also used to process orders for different payment modes such as 
cash, check, credit card and purchase order.

■ Oracle iPayment Server - If partners use the credit card payment mode to pay 
fees, the iPayment Server is used to process payment.

■ Oracle Receivables - The payment billing address has to be validated against tax 
locations. For this, the address validation option in Oracle Accounts Receivables 
needs to be set up.

■ Oracle Approvals Management - Approvers for enrollment requests are setup 
in Oracle Approvals Management.

PV: Expire Ended 
Program 
Memberships, and 
Renew Early 
Renewed Program 
Memberships

This concurrent program updates the membership status to 
'Expired' for all partner organizations with membership end date 
(for one or more programs) in the past of current system date, and 
updates the membership status to ’Renew’ for all early renewals 
whose start date is in the past. After this program is run, if a global 
membership expires and if there are subsidiary program 
memberships, the subsidiary program memberships also expire.

PV: Process the 
errored enrollment 
requests for 
approval

Enrollment requests initiated by partners may not get routed for 
approval if the AME application errors out due to some reason. This 
concurrent program processes such enrollment requests and routes 
them to appropriate approver(s).

PV - Assign/Revoke 
user responsibilities

This concurrent program is used to assign or revoke responsibilities 
of partner users based on their organization’s memberships. There is 
no fixed frequency.

Table 8–2 Concurrent Programs

Concurrent 
Program Description
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8.6 Security
Administrators can see all enrollment requests in the system, whereas other users 
can only see the enrollment requests for which they are approvers, or the 
enrollment requests submitted by partners to which they have access. 

Administrator user is the user who has the resource role of ’PV_VENDOR_
ADMINISTRATOR’. Associate this role to the resource by querying the resource.

Prerequisites
Associate the ’PV_VENDOR_ADMINISTRATOR’ role to the resource by querying 
the resource.

Steps
1. Log into Oracle Forms as the channel administrator and navigate to Resource 

Manager > Maintain Resources > Resources.

2. Fill in the resource details, and find the resource.

3. Click Resource Details.

4. In the Roles tab, associate the above role by adding a new row with role type as 
Oracle Partner Management, and Role as Partner Vendor Administrator.

5. Save the details.
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Setting Up Opportunity Assignment

This chapter provides information on setups required for Opportunity Assignment. 
Topics included are:

■ Section 9.1, "Overview"

■ Section 9.2, "Setups"

■ Section 9.3, "Profile Options"

■ Section 9.4, "Concurrent Programs"

■ Section 9.5, "Interaction with Other Modules"

■ Section 9.6, "Seeded Data"

■ Section 9.7, "Users and Security"
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9.1 Overview
A sales opportunity is a qualified sales opportunity. When an opportunity is 
created, it is assigned to one or more sales representatives based on territory 
definitions. New opportunities can originate from leads, marketing campaigns or 
can be manually entered. Sales representatives or channel managers can assign 
opportunities to partners.

Sales channels can be direct or indirect.

■ Sales representatives from your organization can fulfill direct opportunities.

■ You can route indirect opportunities to partners for fulfillment.

While routing an opportunity to a partner, you must be able to identify the most 
appropriate partner based on pre-defined rules or you can manually search for a 
partner based on their skills and expertise.

Automatic Partner Assignment
Oracle Partner Management provides an engine to identify the best partner(s) to 
fulfill each indirect opportunity by matching opportunity attributes with partner 
expertise. The engine can operate in a batch mode without requiring manual 
intervention or be manually invoked by the sales representative that decides to 
submit the opportunity to the partner. 

Automatic Partner Search
To match partners to indirect opportunities, define partner matching rules. The 
highest matching rule is selected by the partner matching engine. Once you submit 
the assignment to a partner, the system starts a workflow process to notify the 
partner and the channel manager that an opportunity is assigned.

Manual Partner Search
You can manually match opportunities by selecting a preferred partner. While 
performing a manual search, you can use partner profile attributes to identify the 
best partner.

9.1.1 Routing Types
Oracle Partner Management supports several routing types:

■ Serial: The system generates a list of partners. The opportunity is offered to one 
partner at the time. If the highest ranking partner declines it, the opportunity is 
offered to the second ranking partner and so on until a partner accepts it.
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■ Single: This is a subset of the Serial routing type. The opportunity is routed 
only to one partner.

■ Multiple Serial: This is a variation of the single routing and you can create an 
ordered list of partners. The opportunity is offered to the first partner for 
review. If the partner accepts it, the assignment is successful. If the partner 
declines it, it is offered to the second partner in the list for review. You need to 
select at least two partners from the partner LOV window.

■ Multiple-Parallel: You can also broadcast the opportunity to multiple partners 
for review at the same time. However, only the partner who accepts it first, 
wins the opportunity. If you want to do multiple matching, you need to select 
at least two partners from the partner LOV window.

■ Joint: This option supports collaborative selling. The opportunity is offered to 
multiple partners for fulfillment. The partners come together and bring their 
expertise to win the deal.

9.2 Setups
The following sections provide information on setups that are required for 
Opportunity Assignment:

■ Section 9.2.1, "Setting Up Partner Matching Rules"

■ Section 9.2.2, "Setting Up Manual Matching Options"

■ Section 9.2.3, "Setting Up Timeouts"

■ Section 9.2.4, "Setting Up Channel Types"

■ Section 9.2.5, "Setting Up Status Notification"

9.2.1 Setting Up Partner Matching Rules
Automatic partner matching requires rules so that the system can make correct 
decisions.

This feature enables vendors to match partners to indirect opportunities based on 
partner matching rules. The rule can be selected by the partner matching engine 
based on the criteria specified in the opportunity selection section of the rule, or the 
rule can be decided based on the profile option ’PV: Rule for Automatic Matching’. 
The partners selected can then be added to the partner assignment list of an indirect 
opportunity and then routed to the partners using the routing process.

Use this procedure to set up rules.
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Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Opportunity Routing > 

Partner Matching Rules.

The Partner Matching Rules page appears.

2. Click Create.

The Create Partner Matching Rule page appears.

3. Enter rule attributes such as name, start and end dates, precedence and select 
the currency.

The rule currency identifies the currency used for each currency condition that 
is added to the rule. The higher precedence rule is evaluated before lower 
precedence rules when the partner matching engine is trying to identify the 
most appropriate rule to apply for each opportunity.

If the default owner is not correct, select a different owner.

4. Click Create to display the Partner Matching Details page.

Navigate to the Edit Matching Rule page and access the following links:

■ Opportunity Selection: For more information, see Add Opportunity 
Selection Criteria to the Partner Matching Rule.

■ Partner Selection: For more information, see Add Partner Selection Criteria 
to the Partner Matching Rule.

■ Matching Criteria: For more information, see Add Matching Criteria to the 
Partner Matching Rule.

■ Geo-Proximity: For more information, see Add Geographic Proximity to the 
Partner Matching Rule.

■ Tiebreak: For more information, see Add Tiebreak Criteria to the Partner 
Matching Rule.

■ Routing: For more information, see Add Routing Information to the Partner 
Matching Rule.
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9.2.1.1 Add Opportunity Selection Criteria to the Partner Matching Rule
Vendors can identify the most appropriate rule to apply for each opportunity, based 
on the conditions specified. Once the rule is identified, that rule is used to identify 
the matching partners based on the partner selection, matching criteria, 
geo-proximity and tiebreak.

Use this procedure to add opportunity selection criteria to the rule. You can select 
attributes and assign a condition and a value to the attribute.

Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps
1. In the Opportunity Selection page, click Add Attributes.

2. The Attribute Page appears. On the Attribute Page complete the following:

1. The first drop-down lists the attribute categories. Select the category if you 
know it or select the blank option to display all attributes. This refreshes the 
page with attributes that belong to the selected category.

2. Now, select the attribute that needs to be added from the second drop- 
down list. This again refreshes the page with appropriate conditions for 
that attribute and values. The conditions field displays different values 
depending on the attribute selected. The condition values supported are as 
follows:

■ Attribute of display style: Number or Currency or date

Condition values: Between, Equals, Greater Than, Greater Than or Equals, 
Is Not Null, Is Null, Less Than, Less Than or Equals, and Not Equals

■ Attribute of display style: Text

Condition values: Equals, Is Not Null, Is Null, and Not Equals

■ Attribute of display style: Check Existance

Condition values: Is Not Null, and Is Null

3. Select the appropriate condition.

The values section can render as a text field, or as a table or as a table with a 
LOV option.

■ If it is a text, enter appropriate values.
Setting Up Opportunity Assignment 9-5



Setups
■ If it is a table, check the values that you wish to add.

■ If it is a table with an LOV option, use the LOV to add the values you need 
to add.

4. Click Apply to add this attribute or click Apply And Add Another to add 
this Attribute and display a new Attribute page.

5. Click Cancel to return to the Opportunity Selection page.

9.2.1.2 Add Partner Selection Criteria to the Partner Matching Rule
The conditions specified in the partner selection section, define the pool of partners 
after which one or more partners are selected based on matching criteria, 
geoproximity and tiebreak.

Use this procedure to add partner selection criteria to the rule. You can select 
attributes and assign a condition and a value to the attribute.

Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps
1. In the Partner Selection page, click Add Attributes.

2. The Attribute Page appears. On the Attribute Page complete the following:

1. The first drop-down lists the attribute categories. Select the category if you 
know it or select the blank option to display all attributes. This refreshes the 
page with attributes that belong to the selected category.

2. Now, select the attribute that needs to be added from the second 
drop-down. This again refreshes the page with appropriate conditions for 
that attribute and values. The conditions field displays different values 
depending on the attribute selected. The condition values supported are as 
follows:

■ Attribute of display style: Number or Currency or date

Condition values: Between, Equals, Greater Than, Greater Than or Equals, 
Is Not Null, Is Null, Less Than, Less Than or Equals, and Not Equals

■ Attribute of display style: Text

Condition values: Equals, Is Not Null, Is Null, and Not Equals

■ Attribute of display style: Check Existance
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Condition values: Is Not Null, Is Null

3. Select the appropriate condition.

4. The values section can render as a text field, or as a table or as a table with a 
LOV option.

■ If it is a text, enter appropriate values.

■ If it is a table, check the values that you wish to add.

■ If it is a table with an LOV, option use the LOV to add the values you need 
to add.

5. Click Apply to add this attribute or click Apply And Add Another to add 
this Attribute and display a new Attribute page.

6. Click Cancel to return to the Partner Selection page.

9.2.1.3 Add Matching Criteria to the Partner Matching Rule
This step helps vendors to refine the partner search. For example, the user can 
decide that the customer address has to be in the same state as the partner address 
or the customer industry needs to match the partner's target industry.

Once a rule is identified (via evaluation of opportunity selection) and the pool of 
partners defined (via evaluation of partner selection), the matching criteria section 
allows to specify how to use information from the opportunity as search criteria on 
partner profile to identify the best matching partner(s).

Use this procedure to add matching criteria to the rule. In this step, you relate 
attributes selected for the opportunity to attributes selected for the partner.

Prerequisites
Attributes for both the opportunity and the partner must be defined and a partner 
matching rule must exist.

Steps
1. In the Matching Criteria page, select an attribute from the drop-down list in the 

Opportunity Attribute column. The window refreshes as the Matching 
drop-down list is populated. The values in the Matching drop-down list are 
determined by the return type of the attribute selected in the Opportunity 
Attribute.

2. Select an operator from the Matching Condition drop-down list.
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3. Select a related Attribute from the Partner Attribute column. Attributes 
displayed in the drop-down list of Partner Attributes are attributes that have 
the same return type as the attribute selected in the Opportunity Attribute 
column.

4. Repeat steps 3 through 5 to add additional Matching Criteria to the Matching 
Rule.

5. Click Apply to save your changes.

9.2.1.4 Add Geographic Proximity to the Partner Matching Rule
This step enables vendors to filter partners based on their proximity to the 
opportunity. It allows to limit the matched partners to the nearest ones or to show 
only partners within a given distance.

Use this procedure to assign a geographical region to the rule.

Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps
1. In the Geographic Proximity page, enter a distance value in the Select Partner 

Within field.

2. Select a distance denomination of either miles or kilometers.

3. Enter a numeric value for the number of partners to select in the defined 
geographic proximity into the Select Nearest field.

4. Click Apply to save your changes

9.2.1.5 Add Tiebreak Criteria to the Partner Matching Rule
If the rules requires a single winner or a list of winners in an order, vendors can 
define tie breaks criteria. For example, they can decide that everything else being 
equal, they want to rank first the partner with the highest percentage of accepted 
opportunities.

Use this procedure to assign tiebreak criteria to the rule. The tiebreaking attribute is 
the attribute that is compared if the opportunity and one or more partners compare 
equally.
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Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps
1. In the Tiebreak page, enter a Rank number. 

Attributes are compared in the rank order.

2. Select an Attribute from the drop-down list in the Partner Attribute column.

3. Click Apply to save your changes.

9.2.1.6 Add Routing Information to the Partner Matching Rule
This section of the rule is used if matching and routing of opportunities to partners 
is done automatically in the background.

Use this procedure to assign routing information to the rule.

Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps
1. In the Matching Routing page, select a routing type for the rule.

The routing method determines how the opportunity is offered to partners on 
the list. For information on routing types, see Routing Types.

2. Select the Bypass Channel Manager Approval check box in order to skip 
Channel Manager Approval for this Partner Matching Rule.

3. Enter the Channel Manager Timeout in Days or Hours.

4. Enter the Partner Timeout in Days or Hours.

5. Click Apply to save your changes.

9.2.2 Setting Up Manual Matching Options
For manual matching of partners, all active partner attributes that are enabled for 
matching are exposed by default on the manual search screen. Vendors can restrict 
this list by identifying partner attributes they want to expose at each responsibility 
level. Users whose current responsibility matches one of these responsibility levels 
can only see partner attributes that have been selected for this level.
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Use this procedure to set up manual matching options at the responsibility level.

Prerequisites
None

Steps
1. Log in as the channel administrator and navigate to Opportunity Routing > 

Manual Matching Setup.

The Partner Matching Options page appears.

2. Select a responsibility from the Responsibility drop-down list.

3. Enter a rank in the Rank field.

The rank determines the order in which the partner attributes are displayed in 
the manual search screen. Also, if the profile PV: Enable Partial Matching of 
Attributes is Yes, and partners are not found for the current search conditions, 
the lowest ranked condition is dropped and the search is performed again. This 
process continues until at least one partner is found or all the search conditions 
are exhausted.

4. Select an attribute from the Attribute drop-down list.

This displays all the active partner attributes that are enabled for matching.

5. Click Apply to save your changes.

9.2.3 Setting Up Timeouts
Timeouts are time periods during which an action is expected to take place. There 
are two timeout types: 

■ Channel Manager Timeout

■ Partner Timeout

Channel Manager Timeout: Limits the time period a channel manager can hold a 
matched opportunity before it is forwarded to the assigned partner. If the channel 
manager does not process the opportunity, the routing status is automatically 
changed to Offered and the opportunity is routed to the partner.

Partner Timeout: Limits the time period during which a partner can respond to an 
offered opportunity before it is recycled and offered to another partner.

Use this procedure to set up timeouts.
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Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Partner > Timeout Setup > 

Timeout Setup page.

2. Select a timeout type from the Timeout Type drop-down list.

The values are Channel Manager Timeout and Partner Timeout.

3. Select a country from the Country drop-down list.

4. Enter a value in the Timeout Period field.

5. Select the Remove check box to delete any existing timeouts.

6. Click Upgrade to save your changes.

9.2.4 Setting Up Channel Types
You can create your own channel types to reflect your business processes. Oracle 
Partner Management seeds several channel types. For each channel type, you must 
define which are your direct and indirect channels. This setup is used by the lead 
engine and partner matching engine to identify which opportunities are indirect 
and should be assigned to partners.

This setup allows vendors to flag each sales channel as either direct or indirect.

Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Opportunity Routing > 

Channel Setup.

The Channel Setup page appears.

2. Select a sales channel from the Channel drop-down list.

3. Select the Indirect check box to make the channel available for Oracle Partner 
Management. 

4. Enter a value in the Precedence column to rank channels for the purposes of 
tiebreaking.
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5. Click Apply to save your changes.

9.2.5 Setting Up Status Notification
Oracle Partner Management provides a built-in workflow system that triggers 
automatic e-mail notifications to certain groups of people (as determined by their 
assigned role) at different stages in the opportunity and routing process. 
Notifications are sent out to the following users whenever the status changes.

The various user types are:

■ Channel manager 

■ Assignment Manager - User that initiates the opportunity routing to partner.

■ Partner - Partner contacts on the opportunity sales team.

■ Other - Internal sales representatives that are neither channel managers nor 
assignment managers.

Use the following procedure to set up status notifications.

Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Opportunity Routing > 

Status Notifications.

The Status Notification page appears.

2. Select a status type from the Status type drop-down list.

The values are Opportunity and Routing.

3. Select a status from the Status drop-down list.

Note: The system checks for the appropriate e-mail address in 
User Registration (under administration). This is a mandatory 
requirement for the status notification to work. In addition, while 
creating users, please ensure that appropriate roles are defined. 
This means that at least one partner contact should have the 
permission: OPPTY_CONTACT. This permission is assigned by 
default to the user who registers the partner organization.
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4. Select if the following should receive notification upon a change in status:

■ Partner

■ Channel Manager

■ Assignment Manager

■ Others

5. Select the Remove check box to remove any status notifications.

6. Click Apply to save your changes.

9.3 Profile Options
Table 9–1 lists the profile options that need to be set up for Opportunity 
Assignment.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description

PV: Partner 
Matching 
Type

Optional - Default is 
'Stop at 
first rule' 
at site 
level 

Possible Values:

Exhaust all rules -The partner matching 
engine evaluates each rule (that matches 
the conditions specified in the 
'Opportunity Selection' section of each 
rule), by order of precedence, until it 
finds a partner. If there was a preferred 
partner specified on the opportunity, the 
evaluation stops at the first rule 
regardless of whether the first rule 
evaluated returned any partner.

Stop at first rule - The partner matching 
engine, after finding a rule that matches 
the conditions specified in the 
Opportunity Selection of that rule, uses 
only that rule in finding partners.
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PV: Enable 
Full Access on 
Opportunity 
to Partner

Optional Site Yes This profile is used to determine 
whether partner contacts are added to 
the opportunity sales team with full 
access or read-only access during 
opportunity routing.

If set to 'Yes', the partner, after accepting 
the opportunity can update the 
opportunity details.

If set to ’No’, the partner user has 
read-only access to the opportunity. In 
addition, the partner can create notes 
and add attachments.

PV: Active 
Notification 
Flag

Optional User Yes/No User can enable or disable notifications 
when the partners accepts an 
opportunity.

If set to Yes, the partner contact receives 
a notification when the routing status 
changes from Offered to Active.

PV: Bypass 
CM Approval 
for Campaign 
Routing

Yes Site Yes/No Determine whether channel manager 
approval is required for partners 
matched by a campaign. This profile 
option is used along with PV: Enable 
Automatic Routing by Campaign. The 
default value is No.

PV: Common 
Currency for 
Rules Engines

Yes Site Any 
available 
currency

Base currency used for currency 
comparison in partner matching. If the 
currency specified for the rule is not the 
same as the base currency, it is converted 
to the base currency and then the 
comparison is performed. This profile is 
also used by the concurrent program PV 
Refresh Attribute Text Table.

The default is USD.

PV: Default 
Batch 
Assignment 
User

Optional Site A User This user is added to the sales team of an 
opportunity which failed to complete the 
full automated background Lead to 
Opportunity to Routing process.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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PV: Default 
CM TimeOut

Optional Site # of 
Hours

Default channel manager timeout in 
hours if not specified at the country 
level.

Sets the time period available to channel 
managers to review and approve partner 
matching and selection. If the channel 
manager does not respond in the given 
time, the default response is Match 
Approved.

PV: Default 
Partner 
TimeOut

Optional Site # of 
Hours

Default partner timeout in hours if not 
specified at the country level.

Sets the time period available to Partner 
Contacts to accept the offered 
opportunity. If no response, the default 
response is Offer Declined.

PV: Default 
Routing Type

Yes Site Single

Multiple-
Serial

Multiple-
Parallel

Joint

Default assignment type used by the 
background partner routing.

Partners default assignment type. The 
default type is Single.

PV: Default 
Unassigned 
Opportunity 
TimeOut

Optional Site # of Days Sets the time period an unassigned 
opportunity may have the ’Unassigned’ 
routing status. At the expiration of the 
time period, a concurrent manager 
program, PV Unassigned Opportunity 
Process After Timeout, performs 
automatic matching and routing.

PV: Default 
Vendor User 
(Channel 
Manager)

Optional SAR - Default channel manager used if none 
found for partner.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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PV: Default 
for Bypass 
Channel 
Manager 
approval 
checkbox

Optional - - Determines the display of the Bypass 
channel manager approval flag on the 
opportunity assignment page.

Possible Values:

Bypass CM - Allow update

Bypass CM - No Update Allowed

Do not Bypass CM - Allow Update

Do not Bypass CM - No update Allowed

PV: Display 
Submit 
Routing 
Button

Optional All Yes/No Enable and disable ability for user to 
submit or withdraw assignment routing. 

When set to Yes, a Submit Routing 
button is displayed on the opportunity 
assignment page. This profile is not 
available to partner users.

The default is No.

PV: Enable 
Automatic 
Routing by 
Campaign

Optional Resp Yes/No Enables automatic routing based on 
campaigns. When the campaign field is 
completed, the system adds associated 
partners to the sales team, opportunity 
routing list and starts the routing 
process. The default is No.

PV: Enable 
Partial 
Matching of 
Attributes

Optional All No Enables the partner matching engine to 
return partners even if an exact match is 
not found for manual matching. The 
algorithm used is: if no partners are 
returned for the search conditions 
specified, the lowest ranked condition is 
dropped and the engine performs the 
search again. This process continues 
until at least one partner is found or all 
the search conditions are exhausted.

PV: Enable 
Workflow to 
send e-mails

Yes Site Yes/No Enable or disable notifications in indirect 
opportunity management.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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PV: Enforce 
Address 
Filters in 
Partner LOV

Yes Site Yes/No If set to Yes, the partner LOV allows to 
search based on partner name and 
address.

PV: Java Class 
to Restrict 
ORG Access 
Privilege

Optional Site Java Class 
Filename

Customizable Java Class is available to 
restrict partners from accessing customer 
details from the opportunity pages by 
clicking the customer link.

PV: Locator 
Default 
Distance Unit

Yes All Distance 
Unit 

Default distance unit for manual search. 
Also used for automatic matching if rule 
selected did not specify distance unit. 
This is also used by the reseller locator. 
The default value is Mile.

PV: Locator 
Distance

Yes All Numeric 
Value

The Reseller Locator searches for 
partners within this distance (default at 
site level is 10). 

PV: Locator 
Maximum No 
of Partners

Yes All Numeric 
Value

The maximum number of partners 
returned when Reseller Locator is 
searching for partners. The default value 
for site is 15. The default value for others 
is 20.

PV: Locator 
Partners Per 
Page

Yes All Numeric 
Value

The number of partners displayed per 
page. The default value is 10.

PV: Locator 
Proxy Port

Yes Site - Proxy server port. The default value is 
80.

PV: Locator 
Proxy Server

Yes Site - Proxy server address. The default value 
is www.proxy.us.oracle.com.

PV: Locator 
Server 
Timeout

Yes All Time in 
milli 
seconds

Timeout for the Elocation Request used 
in reseller locator. The default value is 
20000 milliseconds.

PV: Locator 
Skip 
eLocation 
Server

Yes Site Yes/No If Yes, the system does not use the 
eLocation server and performs 
geoproximity analysis based on radial 
distances only.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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PV: Matched 
Notification 
Flag

Optional User Yes/No User can enable or disable the 
notification when an opportunity is 
matched.

If set to Yes, the user receives an e-mail 
notification when an opportunity is 
matched with a partner. The default is 
Yes.

PV: Matching 
Rule Selected 
by Engine

Yes User Yes/No If set to Yes, the matching rule is selected 
by the Rules Engine in automatic 
matching. The default value is No. 

See Profile PV: Rule for Automatic 
Matching.

PV: Max 
Number of 
Matched 
Partners

Yes Site - Maximum number of partners returned 
during partner matching (manual and 
automatic). If the value is not specified, 
the number of partners returned is 10.

PV: Offered 
Notification 
Flag

Optional User Yes/No If set to Yes, the user receives an e-mail 
notification when an opportunity 
routing status changes to Offered.

PV: Require 
Opportunity 
Contact for 
Manual 
Routing

Optional Resp Yes/No Do not allow, or allow assignment 
routing if there are no opportunity 
contacts.

When set to Yes, a contact name for the 
opportunity is required for manual and 
batch routing to start. If set to No, a 
contact name is not required. The default 
is No.

PV: Restrict 
Sales Team 
Partner 
Contact LOV

Optional Site Yes/No For customer external sales team, if 
’Yes’, restrict the display of contacts to 
those partners that the sales team 
member can access.

PV: Rule for 
Automatic 
Matching

Yes User Yes/No If the profile, PV: Matching Rules 
Selected by Engine is set to No, this 
profile is used to determine which rule 
to use for automatic matching.

PV: System 
Login URL

Optional Site URL The system login URL to be displayed in 
e-mail notifications.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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PV: Trace for 
Auto 
Matching

Optional All Yes/No If set to Yes, automatic partner 
assignment process trace is displayed in 
the UI for debugging. The default value 
is No.

PV: 
Unassigned 
Notification 
Flag

Optional User Yes/No If set to Yes, user receives a notification 
for a new opportunity with routing 
status ’Unassigned’. The default is Yes.

PV: 
Withdrawn 
Notification 
Flag

Optional User Yes/No If set to Yes, the user receives an e-mail 
notification when an opportunity 
routing status changes from ’Offered’ to 
’Withdrawn’. 

The default is Yes.

Applications 
Server-Side 
Proxy Host 
and Domain

Optional Site - This is used by the TCA concurrent 
program, Spatial Information for 
Locations Batch Update.

HZ: Spatial 
Provider URL

Yes All A URL A URL for Spatial Information on 
Location (Default at site level is 
http://elocation.oracle.com/el
ocation/lbs). This is used by the TCA 
concurrent program, Spatial Information 
for Locations Batch Update.

HZ: Web 
Server Proxy 
Host Name

Optional All Web 
Server 
Proxy 
Name

This is used by the TCA concurrent 
program, Spatial Information for 
Locations Batch Update.

HZ: Web 
Server Proxy 
Port

Optional All Web 
Server 
Proxy 
Port

This is used by the TCA concurrent 
program, Spatial Information for 
Locations Batch Update.

OS: Auto 
Convert Lead 
to 
Opportunity

Yes Site Yes/No If Yes, the system converts indirect leads 
to opportunities and performs 
automated rule-based partner 
assignment.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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OSO: Default 
Sales Group 
and Role

Yes Site User 
Defined

Default Sales Group and Role

For more information, see the Oracle 
Sales Online Implementation Guide.

OS: 
Opportunity 
Access 
Privilege

SRU Site Full This profile drives the behavior of 
opportunity access. This profile is 
defined within the Sales Application. It 
should be set to sales team as the partner 
should only be allowed to see 
opportunities where they are on the 
sales team.

PV: Locator 
Server URL

Yes Site http://
elocati
on.orac
le.com/
servlet
s/lbs

PV Locator URL used to get the 
elocation service

PV: Locator 
TCP Request 
Content Type

Yes Site applicatio
n/x-ww
w-form-u
rlencoded

Locator TCP request content type

PV: Skip 
Elocation for 
Partner 
Matching 
Service

Optional SARU - If ’Yes’, system skips eLocation server 
and perform geo-proximity analysis 
based on radial distances only.

If value is not set, the system defaults to 
’No’.

PV: 
Unassigned 
Opportunity 
Timeout 
(Days)

Yes Site 10 Number of days indirect Opportunity 
has stayed unassigned. Used by 
concurrent program 'PV - Unassigned 
Opportunity process after timeout'

PV: Abandon 
Notification 
flag

Optional User - User can enable or disable notification 
when opportunity is abandoned. Default 
to ’Yes’.

PV: Recycled 
notification 
flag

Yes User - User can enable or disable notification 
when the opportunity is recycled. 
Default to ’Yes’.

Table 9–1 Profile Options

Option

Required 
-Yes/ 
Optional Level Setting Description
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9.4 Concurrent Programs
Table 9–2 lists concurrent programs that need to be run for Opportunity 
Assignment.

Table 9–2 Concurrent Programs

Name of the 
program

Required - Yes or 
Optional Description

PV Unassigned 
Opportunity Process 
After TimeOut

Optional This concurrent program invokes the partner 
matching engine to route indirect 
opportunities to partners for those indirect 
opportunities that have been left unassigned 
more than ’n’ days since the opportunity 
was created. 

The timeout period is based on the profile 
'PV : Unassigned Opportunity Timeout. 
(Days)

The parameters of the concurrent program 
are:

Country - Only process opportunities for 
country specified.

User Name - The user that is considered as 
the assignment manager for the opportunity 
routing.

From Date - Only consider opportunities 
that have been created after this date.

PV - Initial Build for 
Partners Open/Won 
Opportunities

Yes This program builds or rebuilds the 
materialized view to display the 
Opportunity Open and Won Bin.

The parameters of the concurrent program 
are:

No_of_process - For systems with multiple 
CPUs, this sets the number of parallel 
database processes that is started to build 
materialized views.

Next_extent - Database extent size to allocate 
whenever more space is needed to store the 
data.
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PV Refresh of Partner 
Opportunity Bin Data

Yes This program refreshes the materialized 
view to display the Opportunity Open and 
Won Bin.

The concurrent program PV - Initial Build 
for Partners Open/Won Opportunities 
needs to be run at least once to set up the 
materialized views prior to first execution of 
this concurrent program.

PV Update 
Referral/Deal Status

- This concurrent program records 
interactions for orders that are placed from 
an opportunity. 

Spatial Information 
for Locations Batch 
Update

Yes Acquire latitude and longitude values for 
locations in the TCA registry.

For addresses that already have spatial data, 
the program updates the records with the 
latest information from eLocation. (For more 
information, see Oracle Trading Community 
Architecture eLocation Spatial Data Integration 
User Guide.) This is needed for partner 
matching to determine the radial distances 
between a customer on the opportunity and 
the partners.

Workflow 
Background Process - 
POL Assignment 
Routing

Yes Process channel manager time-out and 
partner time-out activities in opportunity 
routing.

The parameters of the concurrent program 
are:

Item_type: POL Assignment Routing

Process Deferred: N

Process Timeout: Y

Process Stuck: N

Table 9–2 Concurrent Programs

Name of the 
program

Required - Yes or 
Optional Description
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Workflow 
Background Process - 
POL Automated 
Partner Matching

Yes When a lead is created, and the channel 
selection engine selects an indirect channel, 
based on the profile 'OS: Auto Convert Lead 
to Opportunity', the lead gets converted to 
an indirect opportunity and a workflow 
process is created to call the automatic 
partner matching or routing.

This concurrent program starts the workflow 
process to initiate the automated partner 
matching and routing of converted 
opportunities to partners.

Item_type: POL Automated Partner 
Matching

Process Deferred: Y

Process Timeout: N

Process Stuck: N

Workflow 
Background Process - 
POL NotifyParty

Yes Send e-mail notifications to channel 
managers when partner creates 
opportunities.

The parameters of the concurrent program 
are:

Item_type: POL Notify Party

Process Deferred: Y

Process Timeout: N

Process Stuck: N

Table 9–2 Concurrent Programs

Name of the 
program

Required - Yes or 
Optional Description
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PV: Refresh Partner 
Trend Values

Yes Updates partner trend values to enable up to 
date attribute matching. Retrieves or 
calculates the partner trend performance 
measures summarized at a monthly level.

The parameters of the concurrent program 
are:

Start from Beginning of Month - Identifies 
the starting month to refresh (only applies to 
measures that are cumulative). 
Non-cumulative measures are always 
calculated for the current month only.

To Ending of Month - Identifies the ending 
month to refresh (only applies to measures 
that are cumulative). Non-cumulative 
measures are always calculated for the 
current month only.

New Partners Only - If ’Yes’, then only 
process for new partners. New partners are 
defined as partners created after the last 
refresh run of this concurrent program 
(stored in the profile 'PV: Partner Trend Last 
Refresh')

Ignore refresh interval - If ’Yes’, process all 
attributes even though the time interval 
from the last refresh have not exceeded the 
refresh interval set for some attributes.

PV Refresh Attribute 
Text Table

Yes Allows the attribute details for a particular 
partner to be used in the matching process 
and to calculate the ’performance’ and 
’derived’ attributes for each partner.

There are two options for running this 
program: full refresh or new partners only 
refresh. 

Full refresh is the default.

The ’New partners only’ option picks up all 
the newly created partners since the last 
refresh of this type. The last refresh date is 
stored in the profile 'PV: Refresh Search 
Attributes Last Update Date'.

Table 9–2 Concurrent Programs

Name of the 
program

Required - Yes or 
Optional Description
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9.5 Interaction with Other Modules
This section lists interactions with other Oracle Partner Management flows and 
other Oracle E-Business Suite products.

■ Oracle Sales Online - Opportunity management for partners leverages the Sales 
Online opportunity module to support the assignment of indirect opportunities 
to partners.

■ Oracle Leads Management - When the lead engines identify the channel as 
indirect, the lead is automatically converted into an opportunity and routed to 
the partner either manually or automatically.

■ Oracle Marketing - Users can create, execute an email campaign schedule as 
well a web campaign schedule to target partners. For campaigns targeted at 
partners that result in indirect opportunities, Oracle Partner Management 
supports the ability to automatically assign the opportunities generated 
through a shared marketing campaign to the partner.

9.6 Seeded Data
Oracle Partner Management supports the ability to write interactions into a table 
visible to channel managers in the channel manager dashboard. The list of events 
that are tracked in the interaction table are:

■ Indirect opportunity status change: Opportunity status changed to 
<opportunity status>.

■ Indirect opportunity is matched to partners: Opportunity routing status 
changed to <opportunity routing status>. Opportunity matched to <partner 
name(s)>.

■ Indirect opportunity is offered to partners: Opportunity routing status changed 
to <opportunity routing status>. Opportunity is offered to <partner names>.

■ Indirect opportunity is accepted by partner: Opportunity routing status 
changed to <opportunity routing status>.

■ Indirect opportunity is withdrawn by vendor: Opportunity is withdrawn.

■ Indirect opportunity is abandoned by partner: Opportunity is abandoned.

■ Indirect Opportunity is closed as lost: Opportunity status changed to 
’Closed-Opportunity Lost’.
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■ Indirect Opportunity is closed as won: Opportunity status changed to 
’Closed-Opportunity Won’.

■ Order is placed from won direct/indirect opportunity: Customer <customer 
name> placed order for opportunity <opportunity number>.

9.7 Users and Security
Access to opportunities are restricted by user types and permissions.

User Types
■ Vendor User - These are employees in the vendor organization who can view 

opportunities they have created and opportunities they have access to, because 
they are on the partner's channel team. An example of a vendor user is a 
Channel Manager who is responsible for managing a set of partners.

■ Vendor Manager - These are employees it the vendor organization who can 
view, update and approve an opportunity assignment. 

■ Vendor Administrator - These are employees in the vendor organization who 
can perform system setup activities.

■ Partner User - These are employees in the partner organization who can view 
and accept opportunities.

■ Partner Administrator - These are employees in the partner organization who 
can view and accept all opportunities owned by their organization.

For information on setting up vendor users, see Section 6.2.1, "Creating a Channel 
Manager".

For information on setting up partner users, see Section 3.3.2, "Creating a Partner".

Permissions
■ A partner contact must have the PV_OPPTY_CONTACT permission to be able 

to accept an offered opportunity.
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 Setting Up Referral Management

This chapter provides information on setups required for Referral Management. 
Topics included are:

■ Section 10.1, "Overview"

■ Section 10.2, "Setups"

■ Section 10.3, "Profile Options"

■ Section 10.4, "Concurrent Programs"

■ Section 10.5, "Lookups"

■ Section 10.6, "Interaction with Other Modules"

■ Section 10.7, "Dependencies"

■ Section 10.8, "Users and Security"
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10.1 Overview
Referral Management enables partners to refer business opportunities to the 
vendor, which partners cannot fulfill directly. For example, the customer is 
interested in a product that the reseller does not sell. Partners can submit a referral 
to the vendor and receive a percentage of the revenue.

When partners submit a referral, it is routed to the appropriate approver(s). 
Approvers are notified of the referral and they review it and approve, reassign or 
decline it. When the referral is approved, a claim is generated after the order is 
shipped to the customer. After the claim is approved internally, partners receive 
notifications to review and accept compensation. After partners accept the 
compensation, the vendor pays the commission.

Vendors and partners receive notifications about referral activity and can navigate 
directly from the notification into the associated referral. Notifications are 
configured by vendors and sent when the status changes, for example, when a 
referral is approved.

Vendors and partners can access a summary list of referrals that they have access to. 
They can build personal views to quickly find referrals that they are most interested 
in.

10.2 Setups
The following sections provide information on setups that are required for Referral 
Management:

■ Section 10.2.1, "Setting Up Budgets"

■ Section 10.2.2, "Setting Up Offers"

■ Section 10.2.3, "Setting Up Claims"

■ Section 10.2.4, "Setting Up Referrals as Benefits"

■ Section 10.2.5, "Defining Profile Attributes for the Referral"

■ Section 10.2.6, "Defining Product Categories"

■ Section 10.2.7, "Defining Territories"

■ Section 10.2.8, "Defining Notification Messages for the Referral"

■ Section 10.2.9, "Setting Up Notes for a Referral"

■ Section 10.2.10, "Setting Up Approvers in Oracle Approvals Management"
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■ Section 10.2.11, "Setting Up Rules Using DQM Tools"

10.2.1 Setting Up Budgets
To compensate a partner, you must calculate the compensation and then source it 
from the budget defined in the referral benefit. Accruals are made against budgets 
that are associated with the referral benefit from which the referral was made. 
Budgets are fixed budgets and have to be active in order to be selected in the 
referral benefit. Accruals are created for each order line that match between 
customer orders and referred products submitted.

A budget is a pool of money, which vendors can use to execute trade promotion 
activities such as offers and campaigns. For a fixed budget, they must decide 
maximum funds that it can include.

Use the following procedure to create a fixed budget.

Prerequisites
A set of books must be defined.

Steps
1. Log into Oracle Trade Management as the Oracle Trade Management Super 

User and navigate to Budget > Budgets.

2. Click Create and select Fixed Budget from the Setup Type drop down list.

3. Enter a budget name and a budget number.

If you leave the budget number field blank, a unique budget number is 
automatically generated. The budget name and budget number are used to 
identify the budget.

4. Select a business unit.

Business units are organizations, which are set up in Oracle Human Resources 
with Type = Business Unit. It is used mainly for classification purposes. It can 
also affect approval rules.

5. Optionally select a parent budget name.

Selecting a parent budget name makes the current budget a child of the parent 
budget, thus establishing a budget hierarchy.

The budget type defaults from Setup Type. For example, if you have selected 
the Setup Type as Fixed budget, then the value “Fixed” is defaulted here.
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6. Select a budget category from the Category drop-down list.

Budget categories are set up in Administration and can be used to classify 
budgets. If Oracle General Ledger (GL) accounts are associated, and if a profile 
for displaying GL accounts is set, the GL accounts default on to the budget. In 
addition, an approval rule for a budget may use budget category as one of it’s 
criteria.

7. In the Budget Amount field, enter the amount of money that is set aside for this 
budget.

By default, the Currency field, displays the functional currency of the set of 
books. You may change it to another currency.

8. Optionally, in the Holdback Amount field, enter the amount you would like to 
reserve and not allocate down to lower levels. You may choose to reserve or 
release the holdback amount at any time. To release the holdback amount at a 
later point of time, you can manually reduce the amount that you had originally 
entered as holdback amount, and click Update.

The Owner field, by default displays the name of the user entering the budget 
details.

9. Optionally select the Start Date and End Date.

These dates are mapped in the GL calendars, and limits start and end dates of 
the budget.

10. Select the Start Date, and the End Date, and optionally enter a description for 
the budget.

11. Click Create.

10.2.2 Setting Up Offers
For information on setting up offers, see the Oracle Trade Management User Guide.

10.2.3 Setting Up Claims 
For information on setting up claims, see the Oracle Trade Management User Guide.

10.2.4 Setting Up Referrals as Benefits
Use this procedure to set up a referral as a benefit.
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Prerequisites
For a benefit to become active, the following items must exist:

■ At least one budget line with the requested amount

■ Offers

■ At least one product category

■ At least one territory

■ A net accrual offer which is created in the background based on the above items

Steps
1. Log in as the channel administrator and navigate to Programs > Benefits > 

Benefit Administration page.

2. Select 'Referrals' benefit from the Create Benefit LOV and click Go.

3. Enter a benefit name, select a sales transaction from the drop-down list and 
select a benefit currency from the drop-down list.

4. Enter a budget in the Budget region.

The user makes a request when activating the benefit. The budget request will 
undergo budget validation process.

The budget amount is the amount from where compensation is sourced. The 
budget LOV displays ’fixed’ and ’active’ budgets whose team access includes 
the group that the current user belongs to.

5. Enter details in the Additional Details region.

In this section you can collect additional questions to evaluate the referral and 
automatically populate fields for the lead or opportunity that is generated upon 
referral approval. For each question that you add, specify the following:

■ Label - This is the label displayed in the referral details under the additional 
details section when the partner is creating a referral.

■ Profile Attribute - Select a profile attribute. The profile attributes LOV 
displays attributes that you defined to be valid for referrals in the Attribute 
Creation screen.

■ Order - The order in which you want to present the questions.

■ Mandatory - Indicates a mandatory field. The partner needs to populate all 
mandatory fields when submitting a referral.
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For information on how to create your own questions, see Section 10.2.5, 
"Defining Profile Attributes for the Referral".

6. Enter product category and compensation amounts in the Products region. 

The referrals created under this benefit setup are restricted to the product 
categories specified here. 

■ Compensation Percentage - Specifies the referral compensation to be paid 
out to the partners based on a percentage of the net sales amount.

■ Maximum - Sets a cap on the referral compensation on a 
product-by-product basis. For a specific product, the referral compensation 
for the referral cannot exceed this amount regardless of the compensation 
percentage specified.

7. Enter geographic territories in the Territories region.

A country or groups of countries (regions) are geographic territories which are 
defined in the Territory Manager module of Oracle Trade Management. The 
geographic territories restrict the customers that can be referred to specific 
(countries) as specified in the benefit. 

When a referral is set up as a benefit, geographic regions and the minimum 
threshold amount for each region should also be defined. The referred 
products' total amount should be greater than or equal to the threshold amount.

8. Define notifications in the Notifications region.

Notifications are sent regarding the activities on a referral. They can be linked 
for any status of a referral. The following notifications are seeded:

■ Acceptance Letter/Referral Commission - Partner Notification

■ Referral Accepted - Partner Notification

■ Referral Approved - Requires Customer de-duplication Vendor notification

■ Referral Created - Partner Notification

■ Referral Created - Vendor Notification

■ Referral Declined - Partner Notification

For information on how to create your own notification messages, see 
Section 10.2.6, "Defining Product Categories"

For each referral status that you want to attach a notification, specify the 
following:
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■ Status - Referral status change that requires notification.

■ User Role - Group of users that needs to be notified for the corresponding 
status change.

■ Notification Name - The workflow notification to use when sending 
notifications.

9. Click Apply to save the benefit. Click Activate to start the validation process. 

The benefit creation process may go through one of the four benefit statuses: 
Active, Inactive, Draft, Failed Validation. When the process completes, the 
status is updated to Active or to Failed Validation.

When a benefit is created, it can be saved in the draft status by clicking ’Apply’. 
At this point, no validation is done on the budget. When the user clicks 
Activate, a Net Accrual Offer is created in the background and budget 
validation is performed on the offer. Budget validation involves ensuring that 
the products and territories information specified in the benefit setup screen 
correspond and fall under their counterparts specified in the budget. Budget 
validation also ensures that each of the budget requests has a valid amount. If 
any one of the above items failed the validation, the benefit status becomes 
’Failed Validation’. Otherwise, it becomes ’Active’. When the benefit status 
becomes ’Failed Validation’, it can still be re-activated by correcting the failed 
item(s) and reapplying the changes. This process can be repeated until the 
benefit becomes active.

Once a benefit becomes active, the following conditions hold:

■ Budget lines cannot be removed, but new lines can still be added.

■ Products and territories can neither be removed nor added.

■ New Additional detail lines cannot be added.

■ New notification lines can be added.

10.2.5 Defining Profile Attributes for the Referral
Once vendors define attributes for the referral, they can associate a question with 
the attribute. They can setup questions for the referral to track extra fields on the 
referral and automatically populate the fields on a lead or opportunity. In addition, 
the partner responses to some of these questions transfer over to the lead or 
opportunity.

Table 10–1 lists attributes that are seeded and can be added to a referral benefit.
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Additionally, the vendor can create their own set of questions. Use this procedure 
to define profile attributes for the referral.

Prerequisites
None.

Steps

1. Log in as the channel administrator and navigate to Partner > Profile Attributes 
page.

2. Click Create.

3. In the Create Attribute page, enter the following required information:

Table 10–1 Questions

Question Map to Opportunity Map to Lead

Industry - -

Source (Campaign) X X

Number of users - -

Opportunity Description - -

Opportunity Size - -

SIC - -

Total employees - -

Information Verified - -

Customer Annual 
Revenue

- -

Time Frame (Purchase 
Timeframe)

- X

Budget Status - X

Total Budget X X

Response Channel X X

Sales Stage X -

Close Date X -

Offer X X
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1. Attribute Type - Select either 'List of Values' or 'Text Box'. Do not select 
'Derived’.

2. Display Style - This depends on the attribute type that was selected. Based 
on the display style selected, the UI may present additional details that 
need to be updated.

3. Enter a name, description and set the category to ’General’. This is not used 
but needs to be set.

4. Set the status to ’Active’.

5. Select the 'Lead Referral’ checkbox under ’Related to’ and set everything 
else at the default.

6. Click Create.

10.2.6 Defining Product Categories
When a partner submits a referral, the product categories that the partner can refer 
depend on the benefit setup. Product categories need to be defined in the form of a 
hierarchy that are relevant for the referral. This information is used as the basis for 
approving a referral, identifying orders that directly result from a referral, and 
computing the compensation amount due to the partner.

For information on defining product categories, see Oracle Advanced Product Catalog 
User Guide.

10.2.7 Defining Territories
Territories are defined in Oracle Territory Manager with the transaction type 
’Offers’. 

Use this procedure to define territories.

Prerequisites
None.

Steps
1. Log in to Oracle Forms as a CRM Administrator and navigate to Territory 

Manager > Territory Administration.

The navigator window displays available territories.
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2. Select Oracle Trade Management territory and navigate to Administration > 
Define Territory.

3. Enter ’Oracle Trade Management’ in the Usage field.

4. Enter a name for the territory in the Name field.

5. Select ’Offer’ as the Transaction Type and save the details.

The territory is saved.

6. In the Transaction Qualifiers tab, enter values in the Name, Operator and Value 
From fields.

The Qualifiers page appears. Oracle Partner Management supports only the 
'Country' qualifier.

7. Save your details.

The territory is saved with all the qualifiers and resources.

10.2.8 Defining Notification Messages for the Referral
E-mail notifications are handled by Oracle Workflow. Some of the notification 
messages are defined using the Oracle Workflow Builder tool and some of the 
notification messages are seeded.

Use this procedure to define notification messages.

Prerequisites
None

Steps
1. Launch the Workflow Builder 2.6 client application. Ensure that the access level 

is set to 100. Verify this in Help > About Oracle Workflow Builder 2.6. This 
ensures that the customization is preserved.

2. Navigate to File > Open > Database radio button. Enter the apps login and 
database connection and click OK.

3. In the Show Item Type popup window, select Referral Benefit Workflow and 
click OK.

4. Expand the Messages Node and see notification messages that have been 
seeded for Referral Management.
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5. At this point, you can copy an existing message to use as your new message. 
You can reference any attribute that has been seeded out of the box in the 
message template.

Important: The Internal Name you give your message has to conform to the 
naming convention of REFERRAL STATUS CODE#### where #### is a 4 digit 
number starting with 1000. For example, DECLINED1001.

6. Save your changes and exit. You should see your newly defined workflow 
message appear in the notification section of the referral benefit.

10.2.9 Setting Up Notes for a Referral
To set up notes, you must set up:

■ Note Types

■ Note Mapping

Oracle Partner Management has seeded a new source to associate note types to 
referrals.

For more information, see the Oracle Application Foundation Implementation Guide.

Partners can only create public notes. Vendor users can decide to create private, 
public or publish notes.

When approvers approve, decline or reassign the referral, they can add their 
reasons for doing so, provide comments and subsequent approvers can see these 
comments in the Notes fields. Vendors can set up the security on the comments to 
enable partners to see the comments or keep it private where only vendors can view 
comments.

The settings are:

1. Public: Other vendor users can see comments.

2. Publish: Partner users and other vendor users can see comments.

3. Private: Only vendor users can see comments.

10.2.10 Setting Up Approvers in Oracle Approvals Management
The first step of the approval process is to validate information entered by the 
partner. Approvers are internal employees or vendors that are defined in Oracle 
Approval Management (AME). Approvers are assigned to review referrals and do 
the following:
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■ Check for duplicate referrals and approve or decline a referral. They are set up 
in AME and notified based on rules defined in AME.

■ Check for duplicate customers and contacts for their assigned referral. They are 
set up in DQM and notified to review the referral.

When the approver receives a notification, he/she reviews the referral and searches 
for duplicate referrals and approves or declines the referral. Before approving the 
referral, the approver checks if the referral matches any existing referral, lead and 
opportunity.

Use this procedure to set up approvers.

Prerequisites
None.

Steps
1. Log in to the self-service application as an Approvals Management Application 

Administrator and navigate to Approvals Management Application 
Administrator > Approvals.

The Approvals Management page appears. Click the Conditions tab.

Conditions tab
1. In the AME page, select the 'PV: Referral Management Approvals' transaction 

type and click Continue.

The Conditions page appears.

2. Click Add a Condition, select the 'Ordinary' option and click Continue.

3. Select the 'Customer Country' attribute and click Continue.

4. Click Create Condition.

5. Click the Groups tab.

Groups tab
1. In the Create an Approval group page, enter a name, description and static 

option.

2. Click Create Group.

A group is created.

3. Click Add Approver and search for an approver. 
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4. Click Search.

The approvers matching the search criteria appear.

5. Select an approver and click Continue. 

6. Click Create Member.

An approver is added and edit approval group page appears. 

7. Click Quit.

An approval group is created with an approver.

8. Click the Rules tab.

Rules tab
1. Select 'PV: Referral Management Approvals' transaction type and click 

Continue.

The Rules page is appears.

2. Click Add Rule and Usage and enter a description, Rule Type - list-creation, 
Start Date - current date, End Date - none. 

The Add a Rule-Step 1 page appears.

3. Click Continue.

The Add a Rule-Step 2 page appears.

4. Select the 'chain of authority includes an approval group' option and click 
Continue.

The Add a Rule-Step 3 page appears.

5. Select the approval group created above from the LOV and click Continue.

The Add a Rule-Step 4 page appears.

6. Select 'Customer Country' in the 'Ordinary-Condition Attributes' multi-select 
field, and click Continue.

The Add a Rule-Step 5 page appears.

7. Select 'Customer Country is true' in the 'Ordinary Conditions' field, and click 
Continue. 

A rule is created and the approval setup is complete. When a referral is sent to 
the approvals engine from the lead referral module, it processes the rule 
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defined for lead referral in the system and returns the approver according to the 
approver type chosen.

Table 10–2 lists AME attributes to define conditions for Referral Approval Rules. 
When the vendor creates AME conditions, he/she must enter attribute names in 
upper case as specified.

10.2.11 Setting Up Rules Using DQM Tools
Use this procedure to set up rules.

Prerequisites
None

Steps
1. Log into Oracle Forms as a Trading Community Manager and navigate to Data 

Quality Management > Setup > Match Rules.

2. In the Match Rules screen, enter data in the 'Acquisitions' sub tab and enter 
details for:

Attribute 1, Description, Status, Purpose, Attribute Name, Entity, Attribute 
Match, Transformation Name, Attributes 2 and 3, Entity, Type, and 
Transformation Name.

3. Save your changes. The Acquisitions details for the rule is saved.

4. Select the Click 'Scoring' sub tab and enter details for:

Table 10–2 AME Attributes

Name Description

CUSTOMER Customer Name

CUSTOMER_COUNTRY Customer Country

PARTNER_INDUSTRY Partner Industry

PARTNER_LEVEL Partner Level

PARTNER_NAME Partner Name

PARTNER_TYPE Partner Type

PRODUCT_CATEGORY_ID Product category Id matches exact or parent 
categories
10-14 Oracle Partner Management Implementation Guide



Profile Options
Attribute 1, Attribute Name, Entity, Score, Transformation Name, Weight, 
select the ’Exact’ option, and enter similar details for Attribute 2.

5. Save your changes. The scoring details for rule is saved.

6. Click Compile. The rule is complied.

For customer duplicates, if the search criteria is based on the ’party name’, you 
must select a rule that has ’party name’ as a condition in that rule. 

For contact duplicates, if the search criteria is based on the ’contact name’, you must 
select a rule that has ’contact name’ as a condition in that rule. 

10.3 Profile Options
Table 10–3 lists the profile options that need to be set up for Referral Management.

Table 10–3 Profile Options

Profile 
Name

Level - 

Site/Applic
ation/Resp
onsibility/U
ser

Default 
At

Default 
Value Description

OS: 
Opportunity 
Access 
Privilege 

SRU Site Full This profile drives the behavior of 
opportunity access. This profile is 
defined within the Sales Application 
but Oracle Partner Management 
uses it to drive access to referalls. 

If this profile is set to ’Full’, users 
can view all the referrals that have 
been approved and converted to an 
opportunity.

If this profile is set to another value, 
users can only view referrals linked 
to opportunities where they are on 
the sales team. 
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OS: Sales 
Lead Access 
Privilege

SRU Site Full If this profile is set to ’Full’, users 
can view all referrals that generated 
a lead.

If this profile is set to another value, 
users can only view referrals linked 
to leads where they are on the sales 
team.

PV: Default 
Referral 
Approver (if 
AME 
approval 
rules are not 
setup)

SAR - - The default approver if the AME 
approval rule does not return any 
approvers for the referral.

PV: Assign 
Approvers 
to lead or 
opportunity

SAR Site No If this profile is set to ’Yes’, when 
the referral generates a lead or 
opportunity, the approvers of the 
referral is added to the sales team of 
the lead or opportunity. 

Additionally, for a lead, the owner 
of the lead is set to the first approver 
of the referral. However, if ’PV: 
Assign Channel Manager to sales 
transactions’ is also set to ’Yes’, the 
owner of the lead is set to one of the 
channel managers of the referral.

PV: Assign 
Channel 
Manager to 
sales 
transactions

SAR - - If this profile is set to ’Yes’, when 
the referral generates a lead or an 
opportunity, the channel managers 
of the partner submitting the 
referral is added to the sales team of 
the lead or the opportunity. 
Additionally, for a lead, the owner 
of the lead is set to one of those 
channel managers.

Table 10–3 Profile Options

Profile 
Name

Level - 

Site/Applic
ation/Resp
onsibility/U
ser

Default 
At

Default 
Value Description
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PV: Copy 
Lead Owner 
or Sales team 
members on 
approval 
notifications

SAR - - If this profile is set to ’Yes’, 
notifications are sent to lead owners 
if a lead is generated from a referral, 
or to sales team members if an 
opportunity is generated from a 
referral. 

Note: The referral benefit must be 
configured to send notification to 
those user types.

MO: 
Operating 
Unit

SAR - - Determines the vendor organization 
operating unit that the partner is 
interacting with, when making a 
referral. This is normally set at the 
partner responsibility that the 
partner is using to log into the 
system.

This is used to create the claim 
against the correct operating unit.

PV: DQM 
Contact 
Match Rules

SAR - - Stores the DQM rule used to 
perform customer contact DQM for 
a referral.

PV: DQM 
Customer 
Match Rules

SAR - - This profile stores the DQM rule 
used to perform customer DQM for 
a referral.

OZF: 
Validate 
market and 
product 
eligibility 
between 
object and 
budget

SR - - This is for enabling budget 
validation when a referral offer is 
created. This should be set at the 
responsibility level for the ’Channel 
Administrator’ responsibility and it 
should be set to ’Validate customer 
and products by each budget’.

Table 10–3 Profile Options

Profile 
Name

Level - 

Site/Applic
ation/Resp
onsibility/U
ser

Default 
At

Default 
Value Description
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QP: Source 
System Code

SAU - - This should be set at the application 
level for Oracle Partner 
Management. It should be set to the 
same value that the ’Oracle 
Marketing’ application is set to.

AMS : Allow 
Recalculatio
n of 
Committed 
Budget

SARU - - If this profile is set to ’Yes’, when 
the budget exceeds the limit while 
making the accrual, the accrual is 
allowed to exceed the budget's 
committed amount, enabling the 
offer to ask for more fund later.

OZF: Allow 
committed 
budget to 
exceed total 
amount

- - - If set to 'Yes', the referral benefit can 
be activated even though the 
requested budget amount exceeds 
the total budget amount.

If set to 'No', the referral benefit will 
fail validation if the requested 
budget amount exceeds the total 
budget amount.

PV: Contact 
Relationship 
Codes

SAR Site Contact Of When a new customer contact is 
created, this profile is used to 
determine the relationship of the 
contact with the customer.

PV: iStore 
Login URL

S - - Partner login URL link sent with 
workflow notification for the 
partner users.

PV: Self 
Service URL 
with 
Workflow 
Notification

S - - Vendor Self Service Apps URL sent 
with a workflow notification for 
vendor users.

PV: Default 
DQM 
Approver

SAR None - The default approver if the AME 
approval rule does not return any 
DQM approvers.

Table 10–3 Profile Options

Profile 
Name

Level - 

Site/Applic
ation/Resp
onsibility/U
ser

Default 
At

Default 
Value Description
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10.4 Concurrent Programs
Table 10–4 lists concurrent programs that need to be run for Referral Management.

HZ: 
Generate 
Party 
Number

SARU - - Generate party number when 
creating a party. As part of the 
customer de-duplication process for 
referrals, a new customer can be 
created in the system.

This profile needs to be set to ’Yes’ 
for the customer to be created 
successfully in the system.

HZ: 
Generate 
Party Site 
Number   

SARU - - Generate party site number when 
creating a party site. As part of the 
customer de-duplication process for 
referrals, a new customer can be 
created in the system.

This profile needs to be set to ’Yes’ 
for the customer site to be created 
successfully in the system.

Table 10–4 Concurrent Programs

Concurrent 
Program Required Description

OZF-TM: Net 
Accrual Engine

Yes This concurrent program is used to calculate accruals. 
The accrual created is used to calculate the referral 
commission.

Run this program before you run the ’PV - Referral 
Compensation Order Completion’ program and when 
you want to calculate how much your partners have 
accrued. This can be run once a month at the end of the 
month.

Table 10–3 Profile Options

Profile 
Name

Level - 

Site/Applic
ation/Resp
onsibility/U
ser

Default 
At

Default 
Value Description
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PV - Update 
Referral/Deal 
Status

Yes This concurrent program goes through all approved 
referrals to update the status to one of the following:

’Closed. Dead Lead’

’Closed. Lost Opportunity’

’Closed. Opportunity Won’

’Expired’

Run this program when you want to close approved 
referrals. You must run this program before running the 
’PV - Referral Compensation Order Completion’ 
program. Run this program on a weekly schedule to 
make sure the referral statuses are up to date. 

PV - Referral 
Compensation 
Order Completion

Yes Run this program to create claims and start the payment 
process for referrals that generated fulfilled orders. This 
should be run once a month.

Generate 
Territory Package. 
Required

Yes As a part of the standard territory creation process, this 
program must be run after a territory is created. 

OZF-TM: 
Generate Party 
List for Market 
Qualifier. 
Required

Yes This concurrent program populates a denormalized table 
AMS_PARTY_MARKET_SEGMENTS which stores 
customer segmentation information based on territory 
definitions. This concurrent program needs to be run in 
two situations:

1. When a new territory is created. It should be run 
after ’Generate Territory Package’ is run.

2. When a new customer is created.

It ensures that the net accrual engine matches customer 
orders to offers accurately.

Table 10–4 Concurrent Programs

Concurrent 
Program Required Description
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10.5 Lookups
Table 10–5 lists lookups that need to be set up for Referral Management. Vendors 
can add more values to the existing list.

10.6 Interaction with Other Modules
The Referral Management module integrates with multiple products within the 
Oracle E-Business Suite such as Oracle Approvals Manager, Oracle Customer Data 
Quality Manager (DQM), Territories, Oracle Trade Management (Offer, Budget, 
Claim), Oracle Sales Online, Oracle Leads Management, Oracle Workflow and 
Partner Programs to deliver this functionality.

■ Oracle Trade Management - Vendors compensate partners through Oracle 
Trade Management functionality in the areas of offer, budget and claim.

DQM Staging 
Program

Yes Login as a user with the ’Trading Community Manager 
Responsibility’ and run this program when a new party 
(hz_parties) is created in the system. This populates the 
search table against which the DQM process performs the 
query.

Parameters:

Number of Workers = 5

Staging Command = STAGE_ALL_DATA

Continue previous execution = ’No’

No values need to be set for the rest

Table 10–5 Lookups

Lookup Type Description Value

Referral Decline Reason 
(PV_REFERRAL_
DECLINE_REASON)

Customer Details Not 
Verified

Existing Lead

Existing Opportunity

More Information 
Required

CUST_DTLS_NOT_VERIFIED

EXISTING_LEAD

EXISTING_OPPTY

MORE_INFO_REQD

Table 10–4 Concurrent Programs

Concurrent 
Program Required Description
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■ Budget - Vendors source the referral benefit from one or more fixed and active 
budgets to pay out the partner's compensation.

■ Offer - A Net Accrual Offer is created for each referral benefit using the budget 
specified in the benefit. All referrals created using this referral benefit accrue 
against this offer. The offer is created in the background when the benefit is 
activated.

■ Claims - A claim is generated by the system when a referred customer order is 
shipped and accruals are made for the order. This is the means by which 
referral management system compensates a partner for referral submitted.

■ Oracle Approvals Manager - This is used to identify approvers for referrals 
submitted and also to identify the person responsible for checking customer 
duplicates and de-duplication on a referred customer.

■ Oracle Customer Data Quality Manager - Referral Management leverages 
TCA-DQM functionality to find potential customer or contact matches in the 
system for the referred customer and contact. This reduces the occurrences of 
creating duplicate parties in the system.

■ Territories - Territories are used to define geographic boundaries for which the 
referral benefit is applicable. These territories are defined under Oracle Trade 
Management usage with transaction type ’Offers’. For this release only the 
’Country’ qualifier is supported.

■ Oracle Sales Online and Oracle Leads Management - Referrals, when approved, 
create leads or opportunities depending on the referral benefit. Referral is fully 
integrated with Oracle Sales Online and Oracle Leads Management and enables 
the cross navigation between a referral and a lead or opportunity.

■ Partner Programs - Referral Management is implemented as a benefit that can 
be attached to any partner program. Partners, by enrolling into a program 
which has referrals as a benefit, gain access to the Referral Management 
functionality.

■ Oracle Workflow - Integration with Oracle Workflow enables vendors to 
configure e-mail notifications for each referral status change.

10.7 Dependencies
Referral Management is dependent on the following features:

■ Offers

■ Claims
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■ Opportunities/Leads

■ DQM

10.7.1 Offers
A referral benefit is created with product, territories, compensation rates, and 
budget. The referral benefit is activated and a budget request is submitted for 
approval. 

When the referral benefit is activated (by clicking Activate), a Net Accrual Offer is 
created in the background and budget validation is performed on the offer. Budget 
validation involves ensuring that the products and territories information specified 
in the benefit setup screen correspond and fall under their counterparts specified in 
the budget. Budget validation also ensures that each of the budget requests has a 
valid amount. If any one of the above items failed the validation, the benefit status 
becomes ’Failed Validation’. Otherwise, it becomes ’Active’. 

Active referral benefits are available to be added to a program and the program is 
published to partners for enrollment. The partner enrolls into the program and 
submits a referral. When the referral is approved, an opportunity is created. If the 
opportunity is won, an order is placed. The order is shipped.

At this point, the concurrent program ’OZF-TM: Net Accrual Engine’ runs and 
calculates accrual for the partner. To calculate the accrual, orders with open 
referrals are matched on the same customer, products and validity date. If a match 
is found, the offer is applied and accrual is calculated. (compensation)

A claim is created and routed based on territory management. The claim analyst 
researches the claims and settles it. The internal approver reviews the claim and 
approves it. Once it is approved, it is sent to the partner for approval. The partner 
can accept or reject the compensation. If the partner requests for assistance, the 
claim is rejected. The claim is sent back to the analyst for additional processing. 
When the partner accepts the compensation, the claim is approved and sent to 
Oracle Accounts Payable or Oracle Receivable for payment. The partner is paid and 
the referral is closed.

Offers are applied to orders for which:

■ Customers are in the geography that is valid for the offer.

■ Products in the order maps to the one in the offer.

■ Dates are within the validity period.

■ An approved, valid referral on the same customer, products, and date is found.
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10.7.2 Claims
Claims are processed through Oracle Accounts Payable or Oracle Accounts 
Receivables.

When a matching customer order is completed, meaning all the products ordered 
that matches the referral, are shipped, the claim process begins. A claim is 
automatically created, per qualifying referral, and routed to a claim analyst who 
views the claim and adjusts the claim amount if necessary. The compensation is 
posted to the partner for acceptance and after they approve the claim, processing of 
the claim is handled through Oracle Accounts Payable for check payment or Oracle 
Accounts Receivables for credit memo.

10.7.3 Opportunities/Leads
After the referral is approved and the customer and contact duplicate checking has 
been performed, a lead or opportunity is generated by the system. The lead or 
opportunity generated have a link to the referral to enable sales representatives to 
view details of the referral.

10.7.4 DQM
DQM is a tool from the Oracle Trading Community Architecture (TCA) group that 
is used to check for potential duplicate customers and contacts for a given customer 
and contact.

When a referral is created, the customer/reseller name entered by the partner needs 
to be matched to an existing record in TCA, if any. 

■ If there are no matches for the customer, a customer and contact are created.

■ If there are matches for the customer, the DQM approver can review and decide 
to create a new organization or use an existing organization. 

■ If the DQM approver creates a new organization, they also create a new 
contact.

■ If the DQM approver uses an existing organization, they check whether 
there are matches for the contact.

10.8 Users and Security
Access to referrals are controlled based on user types and permissions.
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User Types
■ Vendor User - These are employees in the vendor organization who can view 

referrals they have created and referrals they have access to, because they are 
on the partner's channel team. An example of a vendor user is a Channel 
Manager who is responsible for managing a set of partners.

■ Vendor Manager - These are employees in the vendor organization who can 
view and update all referrals within their hierarchy. 

■ Vendor Administrator - These are employees in the vendor organization who 
can perform system setup activities. These users can also perform operations 
such as resetting the referral status if there is a mistake. 

■ Vendor Approver - These are employees in the vendor organization who can 
approve referrals. After they have performed the approval, they can continue to 
access the referral. 

■ DQM Approver - These are employees in the vendor organization who can run 
DQM to link customer and contact on the referral into the master customer in 
the system. 

■ Partner User - These are employees in the partner organization who can view 
and update referrals they have created and referrals where they are identified 
as the contact.

■ Partner Administrator - These are employees in the partner organization who 
can view and update all referrals owned by their organization.

For information on setting up vendor users, see Section 6.2.1, "Creating a Channel 
Manager".

For information on setting up partner users, see Section 3.3.2, "Creating a Partner".

Permissions
■ Super User Permission - [PV_REFERRAL_SUPERUSER] - Allows a vendor user 

to view and update all referrals and allows a partner user to view and update 
all referrals owned by their organization. 

■ Compensation Approver - [PV_REF_COMP_APPROVER] - This permission 
enables partners to view and accept compensation for referrals. 

Users who are granted access to all leads and opportunities within the sales 
application can access all referrals that generated a lead or an opportunity.
Setting Up Referral Management 10-25



Users and Security
10-26 Oracle Partner Management Implementation Guide



Setting Up Deal Regis
11

 Setting Up Deal Registration

This chapter provides information on setups required for Deal Registration. Topics 
included are:

■ Section 11.1, "Overview"

■ Section 11.2, "Setups"

■ Section 11.3, "Profile Options"

■ Section 11.4, "Concurrent Programs"

■ Section 11.5, "Lookups"

■ Section 11.6, "Interaction with Other Modules"

■ Section 11.7, "Dependencies"

■ Section 11.8, "Users and Security"
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Overview
11.1 Overview
When partners resell your products, there is often a conflict between your direct 
sales force and your partner network. Deal Registration enables partners to submit 
opportunities and receive your commitment not to compete directly and support 
partners on the deal. You increase partner loyalty and gain visibility into partner 
activity.

When partners register a deal, it is routed to the appropriate approver(s). 
Approvers are notified of the deal registration and they review it and approve, 
reassign, or decline it. When the deal registration is approved, a new opportunity is 
created in the system and assigned to the partners’ organization for fulfillment. 

Vendors and partners receive notifications about deal registration activity and can 
navigate directly from the notification into the associated deal registration. 
Notifications are configured by the vendor and sent when the status changes, for 
example, when a deal registration is approved.

Vendors and partners can access a summary list of deal registrations that they have 
access to, in the system. They can build personal views to quickly find deal 
registrations that they are most interested in.

11.2 Setups
The following sections provide information on setups that are required for Deal 
Registration.

■ Section 11.2.1, "Setting Up Deals as Benefits"

■ Section 11.2.2, "Defining Profile Attributes for the Deal"

■ Section 11.2.3, "Defining Territories"

■ Section 11.2.4, "Defining Notification Messages for the Deal"

■ Section 11.2.5, "Setting Up Notes for a Deal"

■ Section 11.2.6, "Setting Up Approvers in Oracle Approvals Management"

■ Section 11.2.7, "Setting Up Rules Using DQM Tools"

11.2.1 Setting Up Deals as Benefits
Use this procedure to set up a deal as a benefit.
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Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Programs > Benefits > 

Benefit Administration page.

2. Select 'Deal Registration' benefit from the create LOV and click Go.

3. Enter a benefit name and select a benefit currency from the drop-down list.

4. Enter details in the Additional Details region.

These questions are questions that you want to ask when a partner wants to 
register a deal. For each question that you add, specify the following:

■ Label - This is the label displayed in the deal details under the additional 
details section when the partner is registering a deal.

■ Profile Attribute - This is the profile attribute which stores the value entered 
by the partner and determines how the field is displayed (for example, 
checkbox, single select, multi-select, currency, date, etc.).

■ Order - The order in which you want to present the questions.

■ Mandatory - Whether or not this is a mandatory field that the partner must 
enter.

For information on how to create your own questions, see Section 11.2.2, 
"Defining Profile Attributes for the Deal".

5. Enter product details in the Products region.

The deals created under this benefit setup are restricted to the product 
categories specified here.

6. Enter geographic territories in the Territories region.

A country or groups of countries (regions) are geographic territories which are 
defined in the Territory Manager module of Oracle Trade Management. The 
geographic territories restrict the customers that can be referred to specific 
countries as specified in the benefit.

When a deal is set up as a benefit, geographic regions and their threshold 
amounts should also be defined. The deal applies to the specified region(s) and 
a minimum threshold amount for each region must be defined. The registered 
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products' total amount should be greater than or equal to the threshold amount 
specified in the benefit for the matching geographic region.

For information on how to create territories, see Section 11.2.3, "Defining 
Territories".

7. Define notifications in the Notifications region.

Notifications are sent regarding the activities on a deal. They can be linked for 
any status of a deal. The following notifications are seeded:

■ Deal Registration Accepted - Partner Notification

■ Deal Approved - Requires Customer de-duplication - Vendor Notification

■ Deal Registration Declined - Partner Notification

■ Deal Registration Created - Partner Notification

■ Deal Registration Created - Vendor Notification

For information on how to create your own notification messages, see 
Section 11.2.4, "Defining Notification Messages for the Deal"

For each deal status that you want to attach a notification, specify the following:

■ Status - Deal status change that requires notification.

■ User Role - Group of users that need to be notified for the corresponding 
status change.

■ Notification Name - The workflow notification to use when sending 
notifications.

8. Click Apply to save the benefit. Click Activate to start the validation process. 

The benefit creation process may go through one of the four benefit statuses: 
active, inactive, draft, or failed validation. When the process completes, the 
status is updated to Active or to Failed Validation.

Once a benefit becomes active, the following conditions hold:

■ Products and territories can neither be removed nor added

■ New Additional detail lines cannot be added

■ New notification lines can be added
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11.2.2 Defining Profile Attributes for the Deal
Once vendors define attributes for the deal, they can associate a question with the 
attribute. They can setup questions for the deal to track extra fields on the deal and 
automatically populate the fields on an opportunity. In addition, the partner 
responses to some of these questions transfer over to the opportunity created.

Table 11–1 lists attributes that are seeded and can be added to a deal benefit.

Additionally, the vendor can create their own set of questions. Use this procedure 
to define profile attributes for the deal.

Prerequisites
None.

Table 11–1 Questions

Question Map to Opportunity

Industry -

Source (Campaign) X

Number of users -

Opportunity Description -

Opportunity Size -

SIC -

Total employees -

Information Verified -

Customer Annual Revenue -

Time Frame (Purchase Timeframe) -

Budget Status -

Total Budget X

Response Channel X

Sales Stage X

Close Date X

Offer X
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Steps
1. Log in as the channel administrator and navigate to Partner > Profile Attributes 

page.

2. Click Create. 

3. In the Create Attribute page, enter the following required information:

1. Attribute Type - Select either 'List of Values' or 'Text Box'. Do not select 
'Derived’.

2. Display Style - This depends on the attribute type that was selected. Based 
on the display style selected, the UI may present additional details that 
need to be updated.

3. Enter a name, description and set the category to ’General’. This is not used 
but needs to be set.

4. Set the status ’Active’.

5. Select the 'Deal Registration checkbox under ’Related to’ and set everything 
else at the default.

6. Click Create.

11.2.3 Defining Territories
Territories are defined in the Territory Manager module in Oracle Trade 
Management with the transaction type ’Offers’. 

Use this procedure to define territories.

Prerequisites
None.

Steps
1. Log in to Oracle Forms as a CRM Administrator and navigate to Territory 

Manager > Territory Administration.

The navigator is seen with all available territories.

2. Select Oracle Trade Management territory and navigate to Admin > Define 
Territory.

3. Enter ’Oracle Trade Management’ in the Usage field.

4. Enter a name for the territory in the Name field.
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5. Select ’Offer’ as the Transaction Type.

6. Save your details.

The territory is saved.

7. In the Transaction Qualifiers tab, enter values in the Name, Operator, and 
Value From fields.

The Qualifiers page appears. Oracle Partner Management supports only the 
'Country' qualifier.

8. Save your details.

The territory is saved with all the qualifiers and resources.

11.2.4 Defining Notification Messages for the Deal
E-mail notifications are handled by Oracle Workflow. Some of the notification 
messages are defined using the Oracle Workflow builder tool and some of the 
notification messages are seeded.

Use this procedure to define notification messages.

Prerequisites
None

Steps
1. Launch the Workflow Builder 2.6 client application. Ensure that the access level 

is set to 100. Verify this in Help > About Oracle Workflow Builder 2.6. This 
ensures that the customization is preserved.

2. Navigate to File > Open > Database radio button. Enter the Apps login and 
database connection and click OK.

3. In the Show Item Type popup window, select Deal Registration Benefit 
Workflow and click OK.

4. Expand the Messages Node and see notification messages that have been 
seeded for Deal registration.

5. At this point, you can copy an existing message to use as your new message. 
You can reference any attribute that has been seeded out of the box in the 
message template.
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Important: The Internal Name you give your message has to conform to the 
naming convention of DEAL STATUS CODE#### where #### is a 4 digit 
number starting with 1000. For example, DECLINED1001.

6. Save your changes and exit. You should see your newly defined workflow 
message appear in the notification section of the deal benefit.

Table 11–2 lists deal statuses and the corresponding deal code.

11.2.5 Setting Up Notes for a Deal
To set up notes, you must set up:

■ Set Up Note Types

■ Set Up Note Mapping

Oracle Partner Management has seeded a new source to associate note types to 
deals.

For more information, see the Oracle Application Foundation Implementation Guide.

Partners can only create public notes. Vendor users can decide to create private, 
public or publish notes.

When approvers approve, decline or reassign the deal registration, they can add 
their reasons for doing so, provide comments and subsequent approvers can see 
these comments in the Notes fields. Vendors can set up the security on the 

Table 11–2 Deal Statuses

Deal Status Deal Code

Closed. Dead Lead CLOSED_DEAD_LEAD

Closed. Lost Opportunity CLOSED_LOST_OPPTY

Expired EXPIRED

Draft DRAFT

Closed by Vendor MANUAL_CLOSE

Pending Approval SUBMITTED_FOR_APPROVAL

Extended by Vendor MANUAL_EXTEND

Pending Customer Review APPRVD_PENDNG_CSTMR_DQM

Declined DECLINED

Approved APPROVED
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comments to enable partners to see the comments or keep it private where only 
vendors can view comments.

The settings are:

1. Public: Other vendor users can see comments.

2. Publish: Partner users and other vendor users can see comments.

3. Private: Only vendor users can see comments.

11.2.6 Setting Up Approvers in Oracle Approvals Management
The first step of the approval process is to validate the information entered by the 
partner. Approvers are internal employees or vendors that are defined in Oracle 
Approval Management (AME). Approvers are assigned to review deals and,

■ check for duplicate deals and approve or decline a deal. They are set up in AME 
and notified based on rules defined in AME.

■ check for duplicate customers or contacts for their assigned deal. They are set 
up in DQM and notified to review the deal.

When the approver receives a notification, he/she reviews the deal, searches for 
duplicate deals and approves or declines the deal. Before approving the deal, the 
approver checks if the deal matches any existing deal.

Use this procedure to set up approvers.

Prerequisites
None.

Steps
1. Log in to the self-service application as an Approvals Management Application 

Administrator and navigate to Approvals Management Application 
Administrator > Approvals.

The Approvals Management page appears.

Click the Conditions tab.

Conditions tab
1. Select the 'PV: Deal Registration Management' transaction type and click 

Continue. The Conditions page appears.
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2. Click Add a Condition and select the 'Ordinary' option and click Continue.

3. Select the 'Customer Country' attribute and click Continue.

4. Click Create Condition.

Click the Groups tab.

Groups tab
1. In the Create an approval group page, enter a name, description and static 

option.

2. Click Create Group. A group is created.

3. Click Add Approver and search for an approver. 

4. Click Search. The approvers matching search criteria appears.

5. Select an approver and click Continue. 

6. Click Create Member. An approver is added and edit approval group page 
appears. 

7. Click Quit. An approval group is created with an approver.

Click the Rules tab.

Rules tab
1. Select 'PV: Deal Registration Management' transaction type and click 

Continue.The Rules page appears.

2. Click Add Rule and Usage and enter a description , Rule Type - list-creation, 
Start Date - current date, End Date - none. 

The Add a Rule-Step 1 page appears.

Click Continue. The Add a Rule-Step 2 page appears.

3. Select the 'chain of authority includes an approval group' option and click 
Continue. The Add a Rule-Step 3 page appears.

4. Select the approval group created above from the LOV and click Continue. The 
Add a Rule-Step 4 page appears.

5. Select 'Customer Country' in the 'Ordinary-Condition Attributes' multi-select 
field, and click Continue. Add a Rule-Step 5 page appears.

6. Select 'Customer Country is true' in the 'Ordinary Conditions' field, and click 
Continue. 
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A rule is created and the approval setup is complete. When a deal registration is 
sent to the approvals engine from the deal registration module, it processes the 
rule defined for the deal registration in the system and return the approver 
according to the approver type chosen.

Table 11–3 lists the AME attributes that are available to define conditions for Deal 
Approval Rules. When you create AME conditions, enter values in upper case as 
specified.

11.2.7 Setting Up Rules Using DQM Tools
DQM is a tool from trading community architecture (TCA) group that is used to 
check for potential duplicate customer, contact, address and/or contact point for a 
given customer, contact, address or contact point attributes.

Use this procedure to setup rules in DQM.

Prerequisites
None.

Steps
1. Log into Oracle Forms as a Trading Community Manager and navigate to Data 

Quality Management > Setup > Match Rules.

2. In the Match Rules screen, enter data in the 'Acquisitions' sub tab and enter 
details for:

Table 11–3 AME Attributes

Name Description

CUSTOMER Customer Name

CUSTOMER_COUNTRY Customer Country

PARTNER_INDUSTRY Partner Industry

PARTNER_LEVEL Partner Level

PARTNER_NAME Partner Name

PARTNER_TYPE Partner Type

PRODUCT_CATEGORY_ID Product category identifier matches exact or 
parent categories
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Attribute 1: Rule Name, Description, Status, Purpose, Attribute Name, Entity, 
Attribute Match, and Transformation Name.

Attributes 2 and 3: Attribute Name, Entity, Type, and Transformation Name.

3. Save your changes. The Acquisitions details for the rule is saved.

4. Select the Click 'Scoring' sub tab and enter data for:

Attribute 1: Match Threshold, Attribute Name, Entity, Score, Transformation 
Name, Weight, and select the ’Exact’ option.

Attribute 2: Attribute Name, Entity, Type, Score, Transformation Name, Weight 
and select the ’Exact’ option.

5. Save your changes. The scoring details for rule is saved.

6. Click Compile. The rule is complied.

11.3 Profile Options
Table 11–4 lists the profile options that need to be set up for Deal Registration.

Table 11–4 Profile Options

Profile

Level - 

Site/ 
Responsibility
/User

Default 
At

Default 
Value Description

OS: Opportunity 
Access Privilege 

SRU Site Full This profile drives the 
behavior of opportunity 
access. This profile is defined 
within the Sales Application 
but Oracle Partner 
Management uses it to drive 
access to deals. 

If this profile is set to ’Full’, 
users can view all deal 
registrations that generated an 
opportunity.

If this profile is set to another 
value, users can only view 
deal registrations linked to 
opportunities for which they 
are on the sales team.
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PV: Default Deal 
Registration 
Approver

SAR - - The default approver if the 
AME approval rule does not 
return any approvers for the 
deal.

PV: Default DQM 
Approver

- - - The default approver if the 
AME approval system does 
not return any DQM 
approvers.

PV: Assign 
Approvers to lead 
or opportunity

SAR Default - When creating an opportunity, 
if this profile is set to Yes, the 
approvers of the deal 
registration are added to the 
sales team of the opportunity.

PV: Assign 
Channel Manager 
to sales 
transactions

SAR - - When creating an opportunity, 
if this profile is set to yes, the 
channel manager is added to 
the sales team of the 
opportunity with full access 
and the keep flag enabled.

PV: DQM Contact 
Match Rules

SAR - - This profile stores the DQM 
rule that is used to perform 
contact DQM for the customer.

PV: DQM 
Customer Match 
Rules

SAR - - Stores the DQM rule that is 
used to perform customer 
DQM for the customer.

PV: Contact 
Relationship 
Codes

SAR Site Contact 
Of

Used to determine the 
relationship of the contact 
with the customer.

PV: iStore Login 
URL

S - - Partner Login URL link sent 
with workflow notification for 
partner users.

PV: Self Service 
URL with 
Workflow 
Notification

S - - Vendor Self Service Apps URL 
sent with a workflow 
notification for vendor users.

Table 11–4 Profile Options

Profile

Level - 

Site/ 
Responsibility
/User

Default 
At

Default 
Value Description
Setting Up Deal Registration 11-13



Concurrent Programs
11.4 Concurrent Programs
Table 11–5 lists concurrent programs that need to be run for Deal Registration.

HZ: Generate 
Party Number   

SARU - - Generate party number when 
creating a party. As part of the 
customer de-duplication 
process for deals, a new 
customer can be created in the 
system. This profile needs to 
be set to ’Yes’ for the customer 
to be created successfully in 
the system.

HZ: Generate 
Party Site Number   

SARU - - Generate party site number 
when creating a party site. As 
part of the customer 
de-duplication process for 
deals, a new customer can be 
created in the system. This 
profile needs to be set to ’Yes’ 
for the customer site to be 
created successfully in the 
system.

Table 11–5 Concurrent Programs

Concurrent 
Program Required Description

PV - Update 
Referral/Deal 
Status

Yes This concurrent program goes through all approved deal 
registrations to update the status to one of the following:

’Closed. Dead Lead’

’Closed. Lost Opportunity’

’Closed. Opportunity Won’

’Expired’

Table 11–4 Profile Options

Profile

Level - 

Site/ 
Responsibility
/User

Default 
At

Default 
Value Description
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11.5 Lookups
Table 11–6 lists lookups that need to be set up for Deal Registration. Vendors can 
add more values to the existing list.

11.6 Interaction with Other Modules
The Deal Registration module integrates with multiple products within the Oracle 
E-Business Suite such as Oracle Approvals Manager, Oracle Customer Data Quality 
Manager (DQM), Territories, Oracle Sales Online, Oracle Workflow and Partner 
Programs to deliver this functionality.

■ Oracle Approvals Manager - This is used to identify approvers for deals 
submitted and also to identify the person responsible for checking customer 
duplicates and de-duplication on a registered customer.

■ Oracle Customer Data Quality Manager - Deal Registration leverages the 
TCA-DQM functionality to find potential customer or contact matches in the 
system for the registered customer and contact. This reduces duplicate parties 
in the system.

■ Territories - Territories are used to define geographic boundaries for which the 
deal benefit is applicable. These territories are defined under Oracle Trade 
Management usage with transaction type ’Offers’. For this release only the 
’Country’ qualifier is supported.

■ Oracle Sales Online - Deals, when approved, create opportunities. Deal 
registration is fully integrated with Oracle Sales Online and allows the cross 
navigation between a deal and an opportunity.

■ Partner Programs - Deal Registration Management is implemented as a benefit 
that can be attached to any partner program. Partners, by enrolling into a 
program that has deals as a benefit, gain access to the Deal Registration 
functionality. 

Table 11–6 Lookups

Lookup Type Lookup Code Description

Referral Decline 
Reason

(PV_REFERRAL_
DECLINE_REASON)

CUST_DTLS_NOT_VERIFIED

EXISTING_LEAD

EXISTING_OPPTY

MORE_INFO_REQD

Customer Details Not Verified

Existing Lead

Existing Opportunity

More Information Required
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■ Oracle Workflow - Integration with Oracle Workflow enables to configure 
e-mail notifications for each deal status change.

11.7 Dependencies
Deal Registration is dependent on the following features:

■ Opportunities

■ Product Categories

■ DQM

11.7.1 Opportunities
Deal Registration enables partners to register deals with the vendor to avoid 
competition on the sale. Vendors gain visibility into partner activity and avoid 
channel conflict. With the deal registration flow partners and vendors can work 
more closely and close more business.

When a deal registration is accepted, it gets converted to an opportunity. The lead 
or opportunity generated has a link to the deal to enable the sales representative to 
view details of the deal registration.

11.7.2 Product Categories
When a partner submits a deal registration, the products that can be registered are 
based on the benefit setup. Product categories need to be defined in the form of a 
hierarchy, that are relevant for the benefit. This information is used as the basis for 
approving a deal registration, identifying products for which the partner is seeking 
non-competition status and generating an opportunity in the system for partner to 
close.

For information on defining product categories, see Oracle Advanced Product Catalog 
User Guide.

11.7.3 DQM
DQM is a tool from trading community architecture (TCA) group that is used to 
check for potential duplicate customer, contact, address and/or contact point for a 
given customer, contact, address or contact point attributes.

When a deal is registered, the customer name, reseller entered by the partner needs 
to be matched to an existing record in TCA, if any. 
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■ If there are no matches for the customer, reseller (via DQM), a new customer is 
automatically created by the system. 

■ If there are no matches for the person specified (via DQM), a new person with a 
’contact’ relationship with the specified customer is automatically created by 
the system. 

■ If there are possible customer matches, the DQM approver can review the 
matches and select an existing customer in the system or choose to create a new 
customer. 

■ If there are possible person matches, the DQM approver can review the matches 
and select an existing ’contact relationship’ in the system or choose to create a 
new customer. 

11.8 Users and Security
Access to deals are controlled based on user types and permissions.

User Types
■ Vendor User - These are employees in the vendor organization who can view 

deals they have created and deals they have access to, because they are on the 
partner's channel team. An example of a vendor user is a Channel Manager 
who is responsible for managing a set of partners.

■ Vendor Manager - These are employees in the vendor organization who can 
view and update all deals within their hierarchy. 

■ Vendor Administrator - These are employees in the vendor organization who 
can perform system setup activities. These users can also perform operations 
such as resetting the deal status, if there is a mistake. 

■ Vendor Approver - These are employees in the vendor organization who can 
approve deals. After they have performed the approval, they can continue to 
access the deal. 

■ DQM Approver - These are employees in the vendor organization who can run 
DQM to link customer and contact on the deal into the master customer in the 
system. 

■ Partner User - These are employees in the partner organization who can view 
and update deals they have created and deals where they are identified as the 
contact.
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■ Partner Administrator - These are employees in the partner organization who 
can view and update all deals owned by their organization.

For information on setting up vendor users, see Section 6.2.1, "Creating a Channel 
Manager".

For information on setting up partner users, see Section 3.3.2, "Creating a Partner".

Permissions
■ Super User Permission - [PV_DEAL_SUPERUSER] - Vendors with this 

permission can view and update all deals. Partners with this permission can 
view and update all deals for their organization.

■ Users who are granted access to all leads and opportunities within the sales 
application can access all deal registrations linked to an opportunity.
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Setting Up Special Pricing Management

This chapter provides information on setups required for Special Pricing 
Management. Topics included are:

■ Section 12.1, "Overview"

■ Section 12.2, "Setups"

■ Section 12.3, "Profile Options"

■ Section 12.4, "Concurrent Programs"

■ Section 12.5, "Lookups"

■ Section 12.6, "Interaction with Other Modules"

■ Section 12.7, "Seeded Data"

■ Section 12.8, "Users and Security"
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12.1 Overview
Special Pricing Management enables partners to submit and check the status of 
special pricing requests and claims online. A special pricing request enables 
partners to request discounted pricing from the vendor. Partners can request 
discounts on competitive sales deals, specific end-customer deals, and on inventory 
that they have not been able to move. 

When a request is submitted, it gets routed to the appropriate approver(s). 
Approvers are notified of the request and they review the request and approve or 
decline it. After the special pricing request has been approved, and the partner has 
closed the sale, he/she can submit a claim to receive the discount that was 
approved. The claim is routed to the claim approver who then validates the claim. 
When the claim gets approved, the vendor pays the discount amount. 

Partners receive notifications about the special pricing request activity and can link 
directly from the notification into the associated special pricing request. 
Notifications are configured by the vendor and sent when the status changes, for 
example, when a special pricing request is approved. 

Partners can access a summary list of all the special pricing requests that they have 
access to, in the system. They can build personal views to quickly find the special 
pricing requests that they are most interested in.

12.2 Setups
The following sections provide information on setups that are required for Special 
Pricing:

■ Section 12.2.1, "Special Pricing Setup"

■ Section 12.2.2, "Setting Up Notifications"

■ Section 12.2.3, "Data Quality Management (DQM)"

■ Section 12.2.4, "Setting Up Approvers in Oracle Approvals Management"

■ Section 12.2.5, "Setting Up Claims"

12.2.1 Special Pricing Setup
To make the Special Pricing link available in the 'Quick Links' bin, a custom 
responsibility must be created and this responsibility can include the special pricing 
function in the menu structure.
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Menus tied with the ’Partner Super User’ responsibility can be used as a reference 
to create menus for custom responsibilities. For defining menus that can be used 
with the Quick Links bin, see the Oracle iStore Implementation Guide.

Use this procedure to create a custom responsibility for accessing a special pricing 
request, with root menu and menu exclusions.

Prerequisites
None.

Steps
1. Log into Oracle Forms as the system administrator and navigate to Security > 

Responsibility > Define. 

2. Enter the following details in the Responsibilities window.

Responsibility Name: Partner Special Pricing

Application: Partner Relationship Management

Responsibility Key: PV_SPECIALPRICE

Description: Responsibility for Special Pricing

Name: Standard

Application: Partner Relationship Management

Menu: Root menu name

3. Click Save.

A custom responsibility is created.

For more information, see Chapter 5, "Setting Up the Partner Dashboard".

12.2.2 Setting Up Notifications
Vendors can configure notifications to be sent based on any status change so that all 
users are immediately notified via e-mail of any activity they should be aware of.

Use the following procedure to set up notifications.

Prerequisites
None
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Steps
1. Log in as the channel administrator and navigate to Special Pricing 

Notifications > Special Pricing Notifications page.

2. Select a status, user role and notification name from the respective drop-down 
lists.

3. Click Save. 

The notification has been defined.

Table 12–1 lists seeded notifications. Customers can add more notifications.

12.2.2.1 Defining Notification Messages for the Special Pricing Request
E-mail notifications are handled by Oracle Workflow. Some notification messages 
are defined using the Oracle Workflow builder tool and some notification messages 
are seeded.

Use this procedure to define notification messages.

Prerequisites
None.

Table 12–1 Notifications

Notification Name User Role Status

Request Created - Channel 
Manager Notification

 Channel Manager Draft

Request Submitted - Partner 
Notification

Partner Contact, Special Pricing Super 
User (Partner)

Pending Approval

Request Submitted - Vendor 
Notification

Vendor Channel Manager, Vendor 
Approvers, Special Pricing Super User 
(Vendor)

Pending Approval

Request Approved - Partner 
Notification 

Partner Contact, Special Pricing Super 
User (Partner)

Approved

Request Returned - Partner 
Notification

Partner Contact, Special Pricing Super 
User (Partner)

- 

Request Cancelled - Partner 
Notification

Partner Contact, Special Pricing Super 
User (Partner)

- 

Request Declined - Partner 
Notification

Partner Contact, Special Pricing Super 
User (Partner)

Declined
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Steps
1. Launch the Workflow Builder 2.6 client application. Ensure that the access level 

is set to 100. Verify this in Help > About Oracle Workflow Builder 2.6. This 
ensures that the customization is preserved.

2. Navigate to File > Open > Database radio button. Enter the apps login and 
database connection and click OK.

3. In the Show Item Type popup window, select Special Pricing Benefit Workflow 
and click OK.

4. Expand the Messages Node and see notification messages that have been 
seeded for Special Pricing.

5. At this point, you can copy an existing message to use as your new message. 
You can reference any attribute that has been seeded out of the box in the 
message template.

Important: The Internal Name you give your message has to conform to the 
naming convention of SPECIAL PRICING STATUS CODE#### where #### is a 
4 digit number starting with 1000. For example, DECLINED1001. 

6. Save your changes and exit. You should see your newly defined workflow 
message appear in the notification section of the deal benefit. 

Table 12–2 lists special pricing statuses and the corresponding special pricing code.

12.2.3 Data Quality Management (DQM)
DQM is a tool from the Oracle Trading Community Architecture (TCA) group that 
is used to check for potential duplicate customers or contacts for a given customer 
or contact.

Table 12–2 Special Pricing Request Statuses

Status Code

Draft DRAFT

Pending Approval SUBMITTED_FOR_APPROVAL

Approved APPROVED

Declined DECLINED

Closed CLOSED
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When a special pricing request is created, the end-customer name and reseller 
entered can be matched to an existing record in TCA.

If a duplicate record exists, the approver selects the existing end customer or 
partner record, and the system links the selected record with the special pricing 
request. If the system finds an exact match with one and only one party, then the 
system automatically links the selected record with the special pricing request. If a 
duplicate record does not exist, the approver creates a new end customer or partner 
record.

Users with the permission OZF_SPECIAL_PRICE_DQM and OZF_SPECIAL_
PRICING_SUPERUSER can identify DQM approvers. Any user with this 
permission and with access to the special pricing function can look up requests that 
need party matching from the entire request list by filtering requests. In the Create 
View page, add the ’Customer Data Merged’ column in the search query to filter 
data and view requests for which DQM is required to be run.

12.2.4 Setting Up Approvers in Oracle Approvals Management
When a request is created, it has to be approved by the approver. The approver 
views the request and approves or declines it. Approvers are internal employees or 
vendors that are defined in Oracle Approval Management (AME). Approvers are 
assigned to review requests and can perform the following:

■ Validate the information entered by the partner.

■ Check for similar requests and accept or decline a request. 

■ Compare pricing details between similar requests.

■ Reassign requests to another vendor user to approve or decline requests. The 
newly assigned user must be able to access the special pricing request.

Vendors can configure the approval process. For example, they can have a single 
approver or multiple approvers. Once a request is approved, it is locked.

Use this procedure to set up approvers.

Prerequisites
None
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Steps
1. Log in to the self-service application as an Approvals Management Application 

Administrator and navigate to Approvals Management Application 
Administrator > Approvals.

The Approvals Management page appears. Click the Conditions tab.

Conditions Tab
1. Select 'Special Pricing Request' transaction type and click Continue.

2. Click Add a Condition, select the 'Ordinary' option and click Continue.

The window to select the condition's attribute appears.

3. Select the attribute on which you want to set a condition.

For example, 'Customer Country' and click ’Continue’ and set a value like 'US'.

4. Click Create Condition to create the condition.

You can add any number of conditions.

5. Click the Groups tab.

Groups Tab
1. Click Add Group and provide a name and description and click Create Group. 

The group is created and the Edit Approval Group window appears.

2. Click Add Approver. Search for an approver, select the approver and click 
Create Member. 

If there is more than one approver, pick the order in which the approvals have 
to be performed. The approver is added and the Edit Approval Group window 
appears.

3. Click the Rules tab.

Rules Tab
1. Select ’Special Pricing Request’ transaction type and click Continue.

2. Click Add Rule and Usage. Enter a description, select Rule Type as 
’list-creation-rule’, select the start date (current date) and end date 
appropriately. Click Continue. The ’Add a Rule-Step 2’ window appears.

3. Select the 'chain of authority includes an approval group' option and click 
Continue. The Add a Rule-Step 3 window appears.
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4. Select the approval group created above and click Continue. The ’Add a 
Rule-Step 4’ window appears.

5. In the 'Ordinary-Condition Attributes' multi-select field, select attribute 
'Customer Country' and click Continue. The ’Add a Rule-Step 5’ window 
appears.

6. In the 'Ordinary Conditions' field, check the option for 'Customer Country is 
true' and click Continue.

Rule is created and the approval setup is complete.

Once requests are submitted from the special pricing request module, the 
approvals engine processes the rule defined for special pricing requests and 
returns approvers according to the approver type chosen.

For more information, see the Oracle Approvals Management User Guide.

12.2.5 Setting Up Claims
The following setups are required to set up claims.

Custom Setup
A custom setup can be seeded for special pricing claims. Creating different custom 
setups provide the following benefits:

■ A different prefix can be used for special pricing claims and it applies to the 
claim number.

■ Approvals can be routed differently based on this setup.

■ The claim validation process can be different.

Custom setups are created from Oracle Trade Management User > Administration 
> Trade Management > Setups > Custom Setups.

Claim Reasons
Partners can give specific reasons when submitting claims on special pricing 
requests. Reasons that can be seen by a partner user have to be flagged for 'Partner 
Access'. Claim reasons are setup from Oracle Trade Management User > 
Administration > Trade Management > Claim > Reasons.
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Claim Defaults
Claim defaults allows setting up of default custom setup, claim type and claim 
reason for Special Pricing claims. Claim defaults are setup from Oracle Trade 
Management User > Administration > Trade Management > Claim > Claim 
Defaults.

Trade Profiles
Trade Profiles allow defaulting of payment methods, vendor and vendor site 
mapping for a partner and batch level, line level threshold limits for error margins 
of special pricing claims submitted through the Indirect Sales Management module. 
Trade profiles are setup from Oracle Trade Management User > Administration > 
Trade Management > Customer > Trade Profile.

For more information, see Oracle Trade Management Implementation Guide.

12.3 Profile Options
Table 12–3 lists the profile options that need to be set up for Special Pricing 
Management.

Table 12–3 Profiles Options

Profile Name

Required

Yes or 
Optional

Level - 

Site/ 
Application/ 
Responsibilit
y/User

Setting - 
Available 
setting 
choices Description

OZF_SP_
ENABLE_
PROD_
SECURITY

Optional Site, 
Responsibility

Yes/No Value in the profile 
controls if all products 
should be displayed or 
only products belonging 
to categories assigned to a 
partner in the Special 
Pricing Product 
Categories field in the 
partner's profile.

The user selects at the 
product category level. 
The partner can see all 
products under that 
category and 
subcategories.
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12.4 Concurrent Programs
The ’OZF - TM: Release Committed Budget Amount After Grace Period’ concurrent 
program closes a special pricing request after the grace period, makes the Submit 
Claim button no longer available, and reconciles the liabilities. It can be scheduled 
to run periodically.

12.5 Lookups
Table 12–4 lists lookups that need to be set up for Special Pricing Management.

OZF_SP_
GRACE_DAYS

Optional Site, 
Responsibility

Numbers Used to set up grace days 
to close special pricing 
requests. It is the number 
of days past the end date. 

The value is zero if the 
profile is not set.

OZF_SP_
DEFAULT_
APPROVER

Optional Site, 
Responsibility

List of 
internal 
employees

Request is sent to this 
default approver when 
Oracle Approvals 
Manager does not find 
any rule that matches the 
special pricing request 
criteria.

OZF_SP_
DEFAULT_
BUDGET

Optional Site, 
Responsibility

List of 
active 
fixed 
budgets

Budget from this profile is 
used to create the budget 
request when a special 
pricing request is 
submitted.

OZF_SP_
PARTY_DQM_
RULE

Optional Site, 
Responsibility

List of 
DQM rules 
for party 
match

Used to find the master 
party record for the 
reseller and end customer 
names, when submitting 
a special pricing request.

Table 12–3 Profiles Options

Profile Name

Required

Yes or 
Optional

Level - 

Site/ 
Application/ 
Responsibilit
y/User

Setting - 
Available 
setting 
choices Description
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Table 12–4 Lookups

Lookup Name
Lookup Type 
Code

Type - 
System/

Extensible/

User Value Description

Request Status OZF_REQUEST_
STATUS

System DRAFT

APPROVED 

CLOSED

DECLINED

SUBMITTED_FOR_
APPROVAL 

Draft

Approved

Closed

Declined

Pending 
Approval

Request Class OZF_REQUEST_
CLASS

System SOFT_FUND

SPECIAL_PRICE

Soft Fund

Special Price

Request Type OZF_REQUEST_
TYPE

System MEET_
COMPETITOR

BLANKET_
REQUEST

BID_REQUEST

Meet 
Competitor 
Price

Blanket Request

Bid Request

Special Pricing 
Request Decline 
Code

OZF_SP_
REQUEST_
DECLINE_CODE 

Extensible CANNOT_MEET

NEED_MORE_
INFO

Cannot Meet 
Discount 
Requested

Need More 
Information

Special Pricing 
Discount Type

OZF_SP_
REQUEST_
DISTYPE

System %

AMT

NEWPRICE

Discount 
Percent

Discount 
Amount

New Price

Special Pricing 
Request 
Outcome

OZF_SP_
REQUEST_
OUTCOME

Extensible IN_PROGRESS

LOST

WON

In Progress

Lost

Won
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12.6 Interaction with Other Modules
This section lists interactions or integrations with other Oracle Partner Management 
flows and other Oracle eBusiness Suite products or modules.

Oracle Trade Management - Offers
When a special pricing request is approved, an offer is generated. Offers are created 
in Oracle Trade Management and the types of offers are:

■ ScanData Offer - This offer is generated in the Existing Inventory scenario. The 
offer enables vendors to reimburse partners for the discounted amount on 
products that partners have already bought. 

■ Off Invoice Offer - This offer is generated in the New Inventory scenario. This 
offer acts as a pricing modifier for future orders. Vendors can see the Offer 
Type field during approval if the Ship from Stock check box is not selected. If 
the vendor approver specifies this type of offer, partners do not have to submit 

Marketing Fund 
Source

OZF_FUND_
SOURCE

System SPECIAL_PRICE

FUND

CAMP

DELV

EVEH

EVEO

OFFR

EONE

OPTN

PTNR

USER

PRIC

CSCH

VEND

Special Price

Budget

Campaign

Deliverable

Event

Event Schedule

Offer

One Off Event

Other Partner

Partner

Person

Price List

Schedule

Vendor

Table 12–4 Lookups

Lookup Name
Lookup Type 
Code

Type - 
System/

Extensible/

User Value Description
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a claim. An authorization code is generated for the partner upon approval, 
which needs to be used when booking the order to receive the discount. The 
authorization code is displayed on the approved special pricing request.

■ Accrual Offer - This offer is generated in the New Inventory scenario. This offer 
acts as a pricing modifier for future orders. Vendors can see this field during 
approval if the Ship from Stock check box is not selected. If the vendor 
approver specifies type of offer, partners have to submit a claim to receive the 
approved discount. An authorization code is generated for the partner upon 
approval, which needs to be used when booking the order to receive the 
discount. The authorization code is displayed on the approved special pricing 
request.

Oracle Trade Management - Budgets
A default budget can be set up for sourcing discounts. When a default budget 
exists, the system generates a budget request for the total discount amount 
requested, upon submission. The Budget tab can be configured to appear/not 
appear for approvers. When the budget tab appears, approvers can change the 
budget sourcing options. If approvers do not change the sourcing option, the 
system automatically adjusts the budget amount based on the approved amount. 
Approvers can only source from budgets that they have access.

Oracle Trade Management - Claims
After a sale is completed at the discounted price, the partner can submit a claim to 
collect payment. Claims can be submitted manually or automatically.  To submit 
claims automatically, the partner can submit the POS or channel sales data with 
special pricing authorization information in it. Then, the system automatically 
generates claims from that data, links the claims to the appropriate special pricing 
request and validates and initiates payment on those claims per setups in Oracle 
Trade Management. Claims are validated in Oracle Trade Management.

Claims have to be submitted in the same vendor organization as the special pricing 
request is approved.

For more information, see the Oracle Trade Management Implementation Guide.

12.6.1 Liability Calculation
In case of special pricing requests, the liability gets created upon approval for each 
of the products for the total approved discount amount. When a request is linked 
with another request, the liability gets created only for amounts in products, which 
exceeds the current liability for that product.
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For example:

A special pricing request (SPR1234) has been submitted to sell products mentioned 
in the table below, to a Customer A for the ’Existing Inventory’ scenario.

A special pricing request (SPR1235) has been submitted to sell products mentioned 
in the table below, to a Customer A for the ’Existing Inventory’ scenario.

If SPR1234 is approved first and SPR1235 gets linked to SPR1234 because it is a 
request for the same end-customer deal, when request SPR1235 gets approved, it 
creates an additional $100 liability for laptops and an additional liability is not 
created for desktops.

In the above scenario, the same underlying offer authorization code would be used 
to track liabilities for both requests and both would have same agreement numbers.

12.6.2 Tracking Financial Liability
Each budget has five kinds of the budgeted amount. They are Planned, Committed, 
Utilized, Earned, and Paid. The planned amount increases when a request is made 
on that budget. When the budget request is approved, the committed amount 
increases. If a Scan Data offer is generated, the utilized and earned amounts 
increase when the offer is approved. If an Accrual or Off-Invoice offer is generated, 
the utilized amount increases when an order is booked and the earned amount 
increases after the order is shipped. For Scan Data and Accrual offers, the paid 
amount increases after claims are closed. For Off-Invoice offer, the paid amount 
increases after an invoice is generated for that order. In this flow, liabilities are 
earnings that are tracked based on the offer types.

Product Discount Amount Units Discount

Laptop $120 10 1000

Desktop $100 60 6000

Product Discount Amount Units Discount

Laptop $120 11 1100

Desktop $100 55 5500
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In the ’Existing Inventory’ scenario, accruals are created which can be paid upon 
completion of the sale. 

In the ’New Inventory’ scenario: 

■ When a request is approved with Accrual offers, utilizations get created after 
orders are placed and become available for payments once they are shipped.

■ When a request is approved with Off-invoice offers, liabilities are not tracked as 
the discount is taken directly off the invoice.

For more information on liabilities, see the Oracle Trade Management User Guide.

12.7 Seeded Data
The following data is seeded for this functionality:

Permissions
■ OZF_SPECIAL_PRICING_SUPERUSER: Vendor users with this permission can 

view, update, approve and have DQM access to all requests. Partner users with 
this permission can view and update all requests made by their organization.

■ OZF_SPECIAL_PRICING_DQM: Vendor users with this permission can match 
a party record to a master TCA record or create a new party record. Anyone 
with this permission can see the DQM flag in the Personalize screen and select 
records where DQM has not been run and then select an existing or create a 
new record.

Notifications
E-mail notifications are handled by Oracle Workflow. Some notification messages 
are defined using the Oracle Workflow builder tool and some notification messages 
are seeded. Notification messages are contained in the workflow item type 
OZFSPBEN - 'Special Price Benefit Notifications'. Seeded messages in this workflow 
are:

■ Request Created - Vendor Notification

■ Request Submitted - Partner Notification

■ Request Submitted - Vendor Notification

■ Request Approved - Partner Notification 

■ Request Cancelled - Partner Notification
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■ Request Declined - Partner Notification

OAM Transaction Types and Attributes
The transaction type for special pricing is seeded and the value is 'OZF: Special 
Pricing Request'. 

The following mandatory attributes are seeded.

■ ALLOW_DELETING_RULE_GENERATED_APPROVERS

■ ALLOW_REQUESTOR_APPROVAL

■ AT_LEAST_ONE_RULE_MUST_APPLY

■ EVALUATE_PRIORITIES_PER_LINE_ITEM

■ USE_RESTRICTIVE_LINE_ITEM_EVALUATION

Special Pricing Management has header and line level attributes. 

Table 12–5 describes the header attributes.

Table 12–5 Header Attributes

Attribute Description Requiring Approval Types

ALLOW_EMPTY_APPROVAL_
GROUPS

Whether to allow 
approval groups 
not to have 
members.

approval-group chain of 
authority, 
post-chain-of-authority 
approvals, 
pre-chain-of-authority 
approvals

CURRENCY_CODE Currency Code None

END_CUSTOMER_COUNTRY End Customer 
Country

None

END_CUSTOMER_NAME End Customer 
Name 

None

IS_VAD To find whether the 
partner is a 
distributor

None

MEMBERSHIP_TYPE Partner 
Membership Type

None

PARTNER_COUNTRY Partner Country None

PARTNER_INDUSTRY Partner Industry None
12-16 Oracle Partner Management Implementation Guide



Seeded Data
Table 12–6 describes the line level attributes.

Interactions
Interactions are logged whenever the status changes for a special pricing request.

Table 12–7 provides information on seeded interaction messages that would be 
logged for the corresponding status changes. 

PARTNER_LEVEL Partner Level None

PARTNER_NAME Partner Name None

PARTNER_TYPE Partner type None

REQUESTED_AMOUNT Total Discount 
Amount

None

REQUEST_TYPE_CODE Discount Type None

SHIP_FROM_STOCK Ship From Stock None

Table 12–6 Line Level Attributes

Attribute Description Requiring Approval Types

DISCOUNT_AMOUNT Requested Discount 
Amount

None

DISCOUNT_TYPE Discount Type None

PRODUCT Product None

REQUESTED_QUANTITY Requested Quantity None

REQUESTED_UOM Requested UOM None

Table 12–7 Interaction Messages

Message Name Status Logged

OZF_SP_PENDING_LOG Pending Approval

OZF_SP_REJECTED_LOG Declined

OZF_SP_APPROVED_LOG Approved

OZF_SP_CLOSED_LOG Closed

Table 12–5 Header Attributes

Attribute Description Requiring Approval Types
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Offer Custom Setups
Three offer custom setups have been seeded for special pricing requests. The offer 
custom setups drive the prefix of the request.

1. Special Pricing Off Invoice - New inventory requests approved with the Off 
Invoice offer, use this setup.

2. Special Pricing Accrual - New inventory requests approved with the Accrual 
offer, use this setup.

3. Special Pricing ScanData - Ship and Debit special pricing request, use this setup.

12.8 Users and Security
Access to requests are controlled based on user types and permissions. 

User Types
■ Vendor User - These are employees in the vendor organization who can view 

special pricing requests they have created and requests that they have access to 
because they are on the partner's channel team. An example of a vendor user is 
a Channel Manager who is responsible for managing a set of partners.

■ Vendor Manager - These are employees in the vendor organization who can 
view, update, approve and perform DQM on all special pricing requests.

■ Vendor Administrator - These are employees in the vendor organization who 
can perform system setup activities.

■ Vendor Approver - These are employees in the vendor organization who can 
approve special pricing requests. After they have performed the approval, they 
can continue to access the special pricing request.

■ DQM Approver - These are employees in the vendor organization who can run 
DQM to link end customer or reseller information on the special pricing request 
into the master customer or partner record in the system.

■ Partner User - These are employees in the partner organization who can view 
and update special pricing requests they have created and requests where they 
are identified as the Requestor.

OZF_SP_DRAFT_LOG Draft

Table 12–7 Interaction Messages

Message Name Status Logged
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■ Partner Administrator - These are employees in the partner organization who 
can view and update all special pricing requests owned by their organization.

For information on setting up vendor users, see Section 6.2.1, "Creating a Channel 
Manager".

For information on setting up partner users, see Section 3.3.2, "Creating a Partner".

Permissions
■ Super User Permission - [OZF_SPECIAL_PRICING_SUPERUSER] - Allows a 

vendor user to view, update, approve and perform DQM on all special pricing 
requests. Allows vendor users to edit the End Date of a special pricing request. 
Allows partner users to view and update all special pricing requests owned by 
their organization.

■ DQM Permission - [OZF_SPECIAL_PRICING_DQM] - Allows a vendor user to 
view, update and perform DQM on all special pricing requests.
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 Setting Up Partner Funds Management

This chapter provides information on setups required for Partner Funds 
Management. Topics included are:

■ Section 13.1, "Overview"

■ Section 13.2, "Setups"

■ Section 13.3, "Profiles Options"

■ Section 13.4, "Concurrent Programs"

■ Section 13.5, "Lookups"

■ Section 13.6, "Interaction with Other Modules"

■ Section 13.7, "Seeded Data"

■ Section 13.8, "Dependencies"

■ Section 13.9, "Users and Security"
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Overview
13.1 Overview
Partner Funds Management enables partners to submit and check the status of fund 
requests and claims online. They can request funds for specific marketing activities 
and thus boost sales. 

When they submit a request, it gets routed to the appropriate approver(s). 
Approvers are notified of the request and they review, approve, decline, or return 
the request. The approver can return the request asking the partner to provide 
additional information. After the partner resubmits the request and the request is 
approved, he/she can execute the marketing activity and submit a claim to redeem 
money from the vendor. When the partner submits a claim, it is routed to the claim 
approver who then validates the claim. When the claim gets approved, the vendor 
pays the amount.

Partners receive notifications about the fund request activity and can navigate 
directly from the notification into the associated fund request. Notifications are 
configured by the vendor and sent when the status changes, for example, when one 
of the fund requests is approved.

Partners can access a summary list of all the fund requests that they have access to 
in the system. They can build personal views to quickly find the fund requests that 
they are most interested in.

13.2 Setups
The following sections provide information on setups that are required for Partner 
Funds Management.

■ Section 13.2.1, "Setting Up Partner Fund Benefits"

■ Section 13.2.2, "Setting Up Notifications"

■ Section 13.2.3, "Setting Up Approvers in Oracle Approval Management (AME)"

■ Section 13.2.4, "Setting Up Claims"

13.2.1 Setting Up Partner Fund Benefits
Vendors can set up a program benefit to enable partners enrolled in that program to 
request channel marketing funds.

Use this procedure to set up a program benefit.
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Prerequisites
None.

Steps
1. Log in as the channel administrator and navigate to Programs > Benefits > 

Benefit Administration page.

2. Select 'Soft Funds' from the create LOV and click Go. 

3. In the Budget region, enter a default budget. 

Budgets requests are generated automatically. Vendor approvers can change 
the budget sourcing to use any budget that they have security to see, based on 
the budget security.

4. In the Notifications region, attach notifications to the benefit.

When a partner fund benefit is setup, notifications can be set up as well. 
Vendors can configure notifications to be sent based on any status change so 
that all users are immediately notified via e-mail of any activity they should be 
aware of.

5. Click Apply to save the benefit.

13.2.2 Setting Up Notifications
Vendors can configure notifications to be sent based on any status change so that all 
users are immediately notified via e-mail of any activity they should be aware of.

Table 13–1 lists seeded notifications. Customers can add more notifications.

Table 13–1 Notifications

Notification Name User Role Status

Request Created – Channel 
Manager Notification

Channel Manager Draft

Request Submitted – Partner 
Notification

Partner Contact, Soft Fund Super User 
(Partner)

Pending Approval

Request Submitted – Vendor 
Notification

Vendor Channel Manager, Vendor 
Approvers, Soft Fund Super User 
(Vendor)

Pending Approval

Request Approved – Partner 
Notification 

Partner Contact, Soft Fund Super User 
(Partner)

Approved
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13.2.2.1 Defining Notification Messages for the Fund Request
E-mail notifications are handled by Oracle Workflow. Some notification messages 
are defined using the Oracle Workflow builder tool and some notification messages 
are seeded.

Use this procedure to define notification messages.

Prerequisites
None.

Steps
1. Launch the Workflow Builder 2.6 client application. Ensure that the access level 

is set to 100. Verify this in Help > About Oracle Workflow Builder 2.6. This 
ensures that the customization is preserved.

2. Navigate to File > Open > Database radio button. Enter the apps login and 
database connection and click OK.

3. In the Show Item Type popup window, select Fund Request Benefit Workflow 
and click OK.

4. Expand the Messages Node and see notification messages that have been 
seeded for Fund Request.

5. At this point, you can copy an existing message to use as your new message. 
You can reference any attribute that has been seeded out of the box in the 
message template.

Important: The Internal Name you give your message has to conform to the 
naming convention of FUND REQUEST STATUS CODE#### where #### is a 4 
digit number starting with 1000. For example, DECLINED1001. 

Request Returned – Partner 
Notification

Partner Contact, Soft Fund Super User 
(Partner)

Returned

Request Cancelled – Partner 
Notification

Partner Contact, Soft Fund Super User 
(Partner)

Void

Request Declined – Partner 
Notification

Partner Contact, Soft Fund Super User 
(Partner)

Declined

Table 13–1 Notifications

Notification Name User Role Status
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6. Save your changes and exit. You should see your newly defined workflow 
message appear in the notification section of the deal benefit. 

Table 13–2 lists fund request statuses and the corresponding fund request code.

13.2.3 Setting Up Approvers in Oracle Approval Management (AME)
When a request is created, it has to be approved by the approver. The approver 
views the request and approves or declines it. Approvers are internal employees or 
vendors that are defined in Oracle Approval Management (AME). Approvers are 
assigned to review requests and can perform the following:

■ Validate the information entered by the partner.

■ Reassign requests to another vendor user to approve or decline requests. The 
newly assigned user must be able to access the fund request.

Vendors can configure the approval process. For example, they can have a single 
approver or multiple approvers. Once a request is approved, it is locked.

Use this procedure to set up approvers.

Prerequisites
None

Steps
1. Log in to the self-service application as an Approvals Management Application 

Administrator and navigate to Approvals Management Application 
Administrator > Approvals.

Table 13–2 Fund Request Statuses

Status Code

Draft DRAFT

Pending Approval SUBMITTED_FOR_APPROVAL

Returned RETURNED

Approved APPROVED

Declined DECLINED

Closed CLOSED

Void VOID
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The Approvals Management page appears. 

2. Click the Conditions tab.

Conditions tab
1. Select 'Fund Request' transaction type and click Continue.

2. Click Add a Condition, select the 'Ordinary' option and click Continue. The 
window to select the condition's attribute appears.

3. Select the attribute on which you want to set a condition.

4. Click Create Condition to create the condition.

You can add any number of conditions. 

5. Click the Groups tab.

Groups Tab
1. Click Add Group and provide a name and description and click Create Group. 

The group is created and the Edit Approval Group window appears.

2. Click Add Approver. Search for an approver, select the approver and click 
Create Member. 

If there is more than one approver, pick the order in which the approvals have 
to be performed. The approver is added and the Edit Approval Group window 
appears.

Click the Rules tab.

Rules Tab
1. Select ’Fund Request’ transaction type and click Continue.

2. Click Add Rule and Usage. Enter a description, select Rule Type as 
’list-creation-rule’, select the start date (current date) and end date 
appropriately. Click Continue. The ’Add a Rule-Step 2’ window appears.

3. Select the 'chain of authority includes an approval group' option and click 
Continue. The Add a Rule-Step 3 window appears.

4. Select the approval group created above and click Continue. The ’Add a 
Rule-Step 4’ window appears.
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5. In the 'Ordinary-Condition Attributes' multi-select field, select attribute 
'Customer Country' and click Continue. The ’Add a Rule-Step 5’ window 
appears.

6. In the 'Ordinary Conditions' field, check the option for 'Customer Country is 
true' and click Continue.

The rule is created and the approval setup is complete.

Once requests are submitted from the fund request module, the approvals 
engine processes the rule defined for fund requests and returns approvers 
according to the approver type chosen.

13.2.4 Setting Up Claims
The following setups are required to set up claims.

Custom Setup
A custom setup can be seeded for fund request claims. Creating different custom 
setups provides the following benefits:

■ A different prefix can be used for fund request claims and it applies to the claim 
number.

■ Approvals can be routed differently based on this setup.

■ The claim validation process can be different.

Custom setups are created from Oracle Trade Management User > Administration 
> Trade Management > Setups > Custom Setups.

Claim Reasons
Partners can give specific reasons when submitting claims for fund requests. 
Reasons that can be seen by a partner user have to be flagged for 'Partner Access'. 
Claim reasons are setup from Oracle Trade Management User > Administration > 
Trade Management > Claim > Reasons.

Claim Defaults
Claim defaults allows setting up of default custom setup, claim type and claim 
reason for fund request claims. Claim defaults are setup from Oracle Trade 
Management User > Administration > Trade Management > Claim > Claim 
Defaults.
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Trade Profiles
Trade Profiles allow defaulting of payment methods, vendor and vendor site 
mapping for a partner. Trade profiles are setup from Oracle Trade Management 
User > Administration > Trade Management > Customer > Trade Profile.

For more information, see the Oracle Trade Management Implementation Guide.

13.3 Profiles Options
Table 13–3 lists the profile options that need to be set up for Partner Funds 
Management.

13.4 Concurrent Programs
The ’OZF-TM: Release Committed Budget Amount After Grace Period’ concurrent 
program closes a fund request after the grace period, makes the Submit Claim 
button no longer available, and reconciles the liabilities. It can be scheduled to run 
periodically.

Table 13–3 Profiles Options

Profile Name

Required

-Yes/ 
Optional

Level - 

Site/ 
Application/ 
Responsibility
/User

Setting - 
Available 
setting 
choices Description

OZF_SF_
GRACE_
DAYS

Optional Site, 
Responsibility

Numbers Used to set up grace days to 
close fund requests. It is the 
number of days past the 
approved date. The value is 
zero if the profile is not set.

OZF_SF_
DEFAULT_
BENEFIT

Optional Site, 
Responsibility

List of 
fund 
request 
benefits

Used to set up default benefit 
for fund requests. For 
deployments that do not use 
partner programs, this will be 
the default benefit that 
appears.

OZF_SF_
DEFAULT_
APPROVER

Optional Site, 
Responsibility

List of 
internal 
employees

Request is sent to this default 
approver when Oracle 
Approvals Manager does not 
find any rule that matches the 
fund request criteria.
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13.5 Lookups
Table 13–4 lists lookups that need to be set up for Partner Funds Management.

Table 13–4 Lookups

Lookup 
Name

Lookup 
Type Code

Type - 
System/

Extensible
/

User Value Description

Request 
Status

OZF_
REQUEST_
STATUS

System DRAFT

APPROVED

CLOSED

DECLINED

VOID

SUBMITTED_FOR_
APPROVAL 

RETURNED

Draft

Approved

Closed

Declined

Void

Pending Approval

Returned

Request Class OZF_
REQUEST_
CLASS

System SOFT_FUND

SPECIAL_PRICE

Soft Fund

Special Price

Request Type OZF_
REQUEST_
TYPE

System SOFT_FUND Soft Fund

Partner 
Funds 
Decline Code

OZF_SF_
DECLINE_
CODE

Extensible COLLATERAL

DUPLICATE

INVALID

Collateral Did Not 
Meet Criteria

Duplicate Request

Invalid Request

Partner 
Funds Return 
Code

OZF_SF_
RETURN_
CODE

Extensible COLLATERAL

OTHER

MISS_INFO

Collateral 
Submission 
Requested

Other

Request Missing 
Information

 Performance 
Unit

OZF_
PERFORMA
NCE_UOM

System AMOUNT

NUMBER

Amount

Number
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13.6 Interaction with Other Modules
This section lists interactions with other Oracle E-Business Suite products.

Oracle Trade Management - Offers
When a fund request is approved, an offer of type lumpsum is generated. All 
lumpsum offers created use the seeded custom setup 'Soft Fund - Lumpsum'.

Oracle Trade Management - Budgets
After a fund request is approved, the budget request is sent for approval. 

Marketing 
Fund Source

OZF_FUND_
SOURCE

System SOFT_FUND

FUND

CAMP

DELV

EVEH

EVEO

OFFR

EONE

OPTN

PTNR

USER

PRIC

CSCH

VEND

Soft Fund

Budget

Campaign

Deliverable

Event

Event Schedule

Offer

One Off Event

Other Partner

Partner

Person

Price List

Schedule

Vendor

Performance 
Objectives

OZF_
PARTNER_
PERFORMA
NCE

Extensible LEAD

REVENUE

Lead

Revenue

Table 13–4 Lookups

Lookup 
Name

Lookup 
Type Code

Type - 
System/

Extensible
/

User Value Description
13-10 Oracle Partner Management Implementation Guide



Seeded Data
Budget request approval can be enabled or disabled for funds requests from the 
offer custom setup. The custom setup for partner fund is 'Soft Fund - Lumpsum'. To 
enable budget request approval, navigate to Oracle Trade Management > 
Administration > Setup > Custom Setup > Soft Fund - Lumpsum > Components. 
For the Budget Approval component, select the Available Attributes checkbox.

Approvers can change the budget that will be used to request fund from the 
Budgets tab. These approvers can only view budgets they have access to.

Oracle Trade Management - Claims
After a request is approved and the partner has executed the desired activity, 
he/she can submit a claim to collect payment. Claims are validated in Oracle Trade 
Management. Claims have to be submitted in the same vendor organization in 
which the fund request is approved. 

For more information on claims, see the Oracle Trade Management Implementation 
Guide.

13.6.1 Tracking Financial Liability
Each budget has five kinds of budgeted amounts.  They are Planned, Committed, 
Utilized, Earned and Paid.  The planned amount increases when a request is made 
on that budget.  When the budget request is approved, the committed amount 
increases.  The utilized and earned amounts increase when the offer is approved.  
The paid amount increases after claims are closed.  In this flow, liabilities are 
earnings that are tracked at the expense lines.

13.7 Seeded Data
The following data is seeded for this functionality:

Permissions
OZF_SOFT_FUND_SUPERUSER: Vendor users with this permission can view, 
update and approve all requests. Partner users with this permission can view and 
update all requests made by their organization.

Notifications
E-mail notifications are handled by Oracle Workflow. Some notification messages 
are defined using the Oracle Workflow builder tool and some notification messages 
are seeded. Notification messages are contained in the workflow item type 
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Seeded Data
OZFSPBEN - 'Soft Fund Benefit Notifications'. Seeded messages in this workflow 
are:

■ Request Created - Vendor Notification

■ Request Submitted - Partner Notification

■ Request Submitted - Vendor Notification

■ Request Approved - Partner Notification 

■ Request Returned - Partner Notification

■ Request Cancelled - Partner Notification

■ Request Declined - Partner Notification

OAM Transaction Types and Attributes
The transaction type for fund requests is seeded and the value is 'OZF: Soft Fund 
Request'. 

The following mandatory attributes are seeded.

■ ALLOW_DELETING_RULE_GENERATED_APPROVERS

■ ALLOW_REQUESTOR_APPROVAL

■ AT_LEAST_ONE_RULE_MUST_APPLY

■ EVALUATE_PRIORITIES_PER_LINE_ITEM

■ USE_RESTRICTIVE_LINE_ITEM_EVALUATION

Partner Funds Management has header and line level attributes. 

Table 13–5 describes the header attributes.

Table 13–5 Header Attributes

Attribute Description Requiring Approval Types

ALLOW_EMPTY_APPROVAL_
GROUPS

Whether to allow 
approval groups 
not to have 
members.

approval-group chain of 
authority, 
post-chain-of-authority 
approvals, 
pre-chain-of-authority 
approvals

CURRENCY_CODE Currency Code None
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Seeded Data
Table 13–6 describes the line level attributes.

Interactions
Interactions are logged whenever status changes for a fund request.

Table 13–7 provides information on seeded interaction messages that would be 
logged on the corresponding status changes. 

IS_VAD To find whether the 
partner is a 
distributor

None

MEMBERSHIP_TYPE Partner 
Membership Type

None

PARTNER_AMOUNT Partner Amount None

PARTNER_COUNTRY Partner Country None

PARTNER_INDUSTRY Partner Industry None

PARTNER_LEVEL Partner Level None

PARTNER_NAME Partner Name None

PARTNER_TYPE Partner Type None

REQUESTED_AMOUNT Requested Amount None

SOFT_FUND_BENEFIT Soft Fund Benefit None

TOTAL_AMOUNT Total Amount None

ACTIVITY Activity None

Table 13–6 Line Level Attributes

Attribute Description Requiring Approval Types

PRODUCT Product None

GEOGRAPHY Geography None

PERFORMANCE OBJECTIVES Performance 
Objectives

None

Table 13–5 Header Attributes

Attribute Description Requiring Approval Types
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Dependencies
Offer Custom Setups
New custom setup has been seeded for lumpsum offers created by fund requests. 
The suffix defined in this offer custom setup becomes the prefix for the fund request 
number.

13.8 Dependencies
Fund Requests is dependent on the following features:

■ Section 13.8.1, "Expense Items"

■ Section 13.8.2, "Setting Up Activity"

■ Section 13.8.3, "Defining Performance Objectives"

■ Section 13.8.4, "Setting Up Budget Category"

■ Section 13.8.5, "Setting Up Budgets"

■ Section 13.8.6, "Setting Up Approval Rule for Budget Requests"

■ Section 13.8.7, "Offers"

■ Section 13.8.8, "Geography"

13.8.1 Expense Items
The breakdown of expenses are setup as marketing mediums in Oracle Trade 
Management. The benefit selected drives the activities that appear. The marketing 
activity selected, drives expense breakdown items that get displayed. Accruals that 
are to be paid on approval of the fund request are tracked against these marketing 

Table 13–7 Interaction Messages

Message Name Status Logged

OZF_SF_PENDING_LOG Pending Approval

OZF_SF_REJECTED_LOG Declined

OZF_SF_APPROVED_LOG Approved

OZF_SF_RETURNED_LOG Returned

OZF_SF_CLOSED_LOG Closed

OZF_SF_DRAFT_LOG Draft
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Dependencies
mediums. Marketing mediums can be created from Oracle Trade Management User 
> Administration > Trade Management > Setup > Marketing Medium. 

For more information, see Oracle Trade Management User Guide.

13.8.2 Setting Up Activity
Use this procedure to create a marketing activity.

Prerequisites
Marketing mediums must exist.

Steps
1. Log into Oracle Marketing as a Oracle Trade Management User and navigate to 

Administration > Trade Management > Setup > Activity page.

2. Click Create and enter the following details in the Create Activity page.

Activity Name, Activity Type, select the Active check box, Marketing Media - 
select required mediums (expense items) from the LOV. These are the expense 
items that are available when a fund request is made for performing this 
activity.

An activity is created.

13.8.3 Defining Performance Objectives
The performance objective is the outcome that is expected for a marketing activity. 

Use this procedure to enter values that are populated as Performance Objectives 
while submitting a fund request. This is displayed on the fund request to capture 
expected performance results, and on the claim to capture actual performance 
results.

Prerequisites
None.

Steps
1. Log into Oracle Forms as a Oracle Trade Management Administrator and 

navigate to Setup > Lookups.
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Dependencies
2. In the Lookups page, query for the lookup type Performance Objectives and 
enter performance objectives as lookup codes. 

For example, Leads generated, Revenue expected. The values for lookup are 
saved and these values appear as Performance Objectives on the fund request 
and the fund request claim.

13.8.4 Setting Up Budget Category
Use this procedure to set up a budget category.

Prerequisites
An activity must exist.

Steps
1. Log into Oracle Marketing as a Oracle Trade Management User and navigate to 

Administration > Trade Management > Setup > Activity page.

2. Click the Category side navigation link. The Categories page appears.

3. Click Create and enter the following details in the Create Category page. 

Category Name, select the Enabled check box, Created for, Activity.

A category for the budget is created.

13.8.5 Setting Up Budgets
Marketing administrators can define budgets from the Oracle Trade Management 
Budgets module. Every budget belongs to a budget category. Budget categories are 
set up with different activities that can be used. Depending on the benefit that is 
selected, the activity values appear.

Use this procedure to set up budgets.

Products specified in fund request do not get validated against products in budget.

Prerequisites
Budget categories must exist.

Steps
1. Log into Oracle Marketing as a Oracle Marketing Super User and navigate to 

Oracle Marketing > Budget.
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Dependencies
2. Click the Budget tab.

The Budgets summary screen appears.

3. Click Create and enter the following details.

Setup Type, Name, Category, Budget Amount and Start Date.

4. Click Create.

The budget is created in draft status.

5. Click Request Approval. 

In the Preview Approval page, ensure that the Active checkbox is selected and 
User Status is 'Active'.

6. Click Confirm.

If the owner and approver are not the same user, the approver has to approve 
the budget via Workflow > Worklist and drill into the budget and click 
Approve. The budget is approved automatically and the status changes to 
'Active' if the owner and approver are the same user.

13.8.6 Setting Up Approval Rule for Budget Requests
Use this procedure to set up approval rules for a budget request.

Prerequisites
The custom setup is configured to require budget approval.

Steps
1. Log into Oracle Marketing as a Oracle Trade Management User and navigate to 

Administration > Trade Management > Setup > Approval Rule.

The Approval Rules page appears.

2. Click Create.

The Create Approval Rules page appears.

3. Enter necessary details in the Create Approval Rule page.

4. Select 'Offer' from the Approval Rule For drop-down list.

5. Select 'Lumpsum' from the Offer Type drop-down list.

6. Select 'Soft Fund - Lumpsum' from the Setup Type drop-down list.
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7. Select 'Budget' from the Approval Type drop-down list.

8. Enter the Minimum Amount.

9. Click Create.

The Approval Rule Details page appears.

10. Enter details in the Approvers region and click Update.

The approver is added to the approval rule.

13.8.7 Offers
When a request is approved, a lumpsum offer is generated in the background. The 
offer is used to track funds committed for the fund request. Vendors can:

■ Submit a claim using Oracle Trade Management by entering the request 
number.

■ Link offers associated with a fund request to a campaign schedule.

For more information, see Oracle Trade Management User Guide.

13.8.8 Geography
The geographical regions are regions where the marketing activity is executed. 
Geographies are set up in Oracle Forms in Territory Manager > Territory 
Administration.

For information on setting up territories, see Assigning User Management Roles 
(JTT Roles) to Vendor Users (Employees) in Chapter 6, "Setting Up the Channel 
Manager Dashboard".

13.9 Users and Security
Access to requests are restricted by user types and permissions.

User Types
■ Vendor User - These are employees in the vendor organization who can view 

fund requests they have created and requests that they have access to because 
they are on the partner's channel team. An example of a vendor user is a 
Channel Manager who is responsible for managing a set of partners.

■ Vendor Manager - These are employees in the vendor organization who can 
view, update, and approve all fund requests.
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Users and Security
■ Vendor Administrator - These are employees in the vendor organization who 
can perform system setup activities.

■ Vendor Approver - These are employees in the vendor organization who can 
approve fund requests. After they have performed the approval, they can 
continue to access the fund request.

■ Partner User - These are employees in the partner organization who can view 
and update fund requests they have created and requests where they are 
identified as the Requestor.

■ Partner Administrator - These are employees in the partner organization who 
can view and update all fund requests owned by their organization.

■ For information on setting up vendors users, see Section 6.2.1, "Creating a 
Channel Manager". 

■ For information on setting up partner users, see Section 3.3.2, "Creating a 
Partner"

Permissions
■ Super User Permission - [OZF_FUND_REQUEST_SUPERUSER] - Allows a 

vendor user to view, update, and approve all fund requests. Allows a partner 
user to view and update all fund requests owned by their organization.
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Profiles, Concurrent Programs and Loo
A

Profiles, Concurrent Programs and

Lookups

This chapter describes how to set up profile options, run concurrent programs and 
set up lookup vales. Topics included are: 

■ Section A.1, "Setting Up Profile Options"

■ Section A.2, "Running Concurrent Programs"

■ Section A.3, "Lookups"
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Setting Up Profile Options
A.1 Setting Up Profile Options
Use the following procedure to set a profile option.

Prerequisites
None.

Steps
1. Log in to Oracle Forms as a CRM Administrator and navigate to Functions > 

Profile > System.

2. In the Find System Profile Values window, check the level(s) at which you want 
to set the profile option. The available levels are listed below:

■ Site: Indicates that profiles are set at the site level. This site level setting 
affects the entire database.

■ Application: If you select this level, choose the application from the 
Application LOV for which you want to set the profile option.

■ Responsibility: If you select this level, choose the responsibility from the 
Responsibility LOV for which you want to set the profile option.

■ User: If you select this level, choose the user from the User LOV for whom 
you want to set the profile option.

3. In the Profile field, enter the profile name, such as IBE: Item Validation 
Organization, or a wildcard search criterion such as IBE%.

4. Click Find.

The System Profile Values form opens with the results of your search.

5. Verify or set the profile option(s) at the levels that you selected.
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A.2 Running Concurrent Programs
The procedure for running concurrent programs is the same for all Oracle 
applications. Use this procedure to run OCM concurrent processes.

Steps
1. Log into Oracle Forms and select the Oracle Sales Administrator responsibility.

2. Double-click Concurrent Requests.

3. Double-click Run.

4. Select the Single Request radio button.

5. Click OK.

6. Search for the concurrent request that you want to run.

7. Click Submit.

8. Select from the search results.

9. Click OK.

10. Click OK to run the concurrent request.

For a detailed description of the procedures, refer to the Oracle Applications System 
Administrator’s Guide.

A.3 Lookups
Table A–1 lists lookups that need to be set up for a benefit. Vendors can add more 
values to the existing list.
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Lookups
Table A–1 Lookups

Lookup Type Description Value

PV_BENEFIT_ENTITY_
STATUS

Approved

Awaiting For Partner 
Acceptance

Closed by Vendor

Closed. Dead Lead

Closed. Fee Paid

Closed. Lost Opportunity

Compensation Cancelled

Declined

Draft

Expired

Extended by Vendor

Negotiating 
Compensation

Payment Being Processed

Pending Approval

Pending Customer 
Review

Processing Compensation

APPROVED

AWAITING_FOR_PARTNER_
ACCEPTANCE

CLOSED_BY_VENDOR

CLOSED_DEAD_LEAD

CLOSED_FEE_PAID

CLOSED_LOST_OPPTY

COMP_CANCELLED

DECLINED

DRAFT

EXPIRED

EXTENDED_BY_VENDOR

COMP_BEING_NEGOTIATED

PAYMENT_BEING_
PROCESSED

PENDING_APPROVAL

PENDING_CUSTOMER_
REVIEW

PROCESSING_
COMPENSATION
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Glossary

This appendix provides a glossary of terms used throughout this guide.

Assignment
When an opportunity is matched to partners.

Assignment Routing
Process that routes an opportunity assignment to partners.

Attribute
Oracle Partner Management provides a flexible profiling framework to capture and 
track the attributes of a partner. The profiling framework supports fixed attributes, 
information entered by the partner or channel manager, and derived attributes, 
information calculated based on partner data and transactions. The profiling 
framework provides a central repository to capture and track all partner related 
information. Channel managers can use this information to differentiate partners 
and provide better services, such as soft funds, incentives, and opportunities.

Benefit
Oracle Partner Management extends benefits to partners based on their program 
participation.

Campaign
A marketing effort comprising any number of different techniques for reaching 
Customers or Prospects.
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Channel Administrator
They have access to administrative setups to define profile attributes, program 
benefits such as referral and deal registration initiatives as well as setups, 
notifications and partner users accounts.

Channel Manager
They own the relationship between the vendor and the partner and bear 
responsibility for managing and distributing information to partners. They work 
with the partner, assign and maintain opportunities, approve assignments, approve 
submitted referrals, special pricing requests, fund requests, and deals. Depending 
upon business rules, they may approve or reject opportunities being assigned to 
partners. They can maintain opportunities depending upon access and business 
rules.

Channel Manager Dashboard
The channel manager dashboard provides you an easy to use, configurable user 
interface to help you with your day to day responsibilities. It provides you with a 
360 degree view of your partners and activities, thereby enabling you to make 
informed decisions.

Channel Manager Timeout
This is the date by which all channel managers must approve or deny the 
opportunity assignment.

Customer
A purchaser of products or services.

Compensation
If a partner’s referral results in orders in the system, they have to be compensated 
for the same. The compensation rates vary from initiative to initiative and by 
product. Once a partner is compensated, the referral is closed.

Concurrent Manager
The concurrent manager is a process manager that coordinates processes generated 
by users’ requests to run various data-intensive programs. An Oracle applications 
product group can have several concurrent managers.
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Deal Registration
When a partner resells your products, there is often a conflict between your direct 
sales force and your partner network. Deal Registration enables partners to submit 
opportunities and receive your commitment not to compete directly and support 
the partner on the deal.

Distributor
A business that buys, warehouses, ships, invoices and resells; a party that acts as an 
intermediary in order and inventory management.

DQM
Data Quality Management (DQM) is a tool that is used to check for potential 
duplicate customers, contacts, address and/or contact points for a given customer, 
contact, address or a contact. The system finds potential duplicates using rules 
defined within DQM.

Enrollment
Enrollments enables you to administer and expedite the registration of partners into 
Oracle Partner Management by enrolling them into programs. 

Existing Inventory
When a partner has already bought the product and wants a discount for past 
purchases.

Expense Breakdown
This is the breakdown of expenses for the marketing activity. The line items 
appearing within the Expense Breakdown are based on the Activity you selected.

Forms
Forms are a logical collection of fields, regions, and graphical components that 
appears on a single window. Oracle Forms resemble paper forms used to run a 
business. You enter data by typing information in the form.

Forms Server
A Forms server is a type of application server that hosts the Forms server engine. It 
mediates between the desktop client and the database, providing input windows 
for the Forms-based products on the desktop client and creating or changing 
database records based on user actions.
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Framework
A framework is a collection of collaborating classes. The interaction framework 
dictates the architecture. It defines the overall structure, its partitioning into classes 
and objects, the key responsibilities, how the classes and objects collaborate, and the 
thread of control.

Fund Request
The request a partner submits (or a vendor on behalf of a partner) in order to 
request soft fund dollars from you.

Fund Request Claim
After a fund request is approved and the partner has executed the planned 
marketing activity, they can submit a claim to redeem money from you. 

Hyperlink
A link to another page.

Indirect Managed Partner/IMP
Smaller partner organizations that deal with VADs to purchase and resell specific 
vendor items. They do not have a direct relationship with you.

Joint Selling
In this routing option, the channel manager offers an opportunity to multiple 
partners. Multiple partners can accept the opportunity and work together on it.

Joint Assignment
This routing option supports collaborative selling. The opportunity is offered to 
multiple partners for fulfillment. The partners come together and bring their 
expertise to win the deal.

Managed Partner
An organization or person who has a strategic agreement with you to conduct 
certain transactions and is managed directly by you.

Manufacturer
A business or person that produces one or more products. (also known as vendor)
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Marketing Activity (Partner Fund)
This is the marketing activity for which funding is being requested.

Membership Level
Particular levels of participation within a partner program. Membership levels exist 
within a partner program and can offer partners special incentives and benefits.

Multiple-Parallel
In this routing option, you can also broadcast the opportunity to multiple partners 
for review at the same time. However, only the partner who accepts it first, will win 
the opportunity. If you want to do multiple matching, you need to select at least 
two partners from the partner LOV window.

Multiple Serial
This is a variation of the single routing option and you can create an ordered list of 
partners. The opportunity will be offered to the first partner for review. If the 
partner accepts it, the assignment is successful. If the partner declines it, it is offered 
to the second partner in the list for review. You need to select at least two partners 
from the partner LOV window.

New Inventory
When a partner requests a special price for a new purchase and you approve it, the 
partner can close the sale to the end-customer at a discounted rate. 

Note Status
There are three statuses available for notes:

■ Public: Other vendor users can see comments.

■ Publish: Partner users and other vendor users can see comments.

■ Private: Only you can see comments.

Note Type
These are organization-defined types to used to categorize notes.

Offer
Offers are generated in the background when approving a special pricing request to 
track the special pricing discount that has been approved. There are three types of 
offers:
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■ Accrual Offer - The discounted amount will be accrued and the partner will be 
paid later.

■ Off-Invoice Offer - The discounted amount will be paid to the partner off the 
invoice.

■ Scan Data Offer - If the special pricing request is being fulfilled from existing 
inventory, the system will generate a Scan Data offer.

Opportunity
A qualified sales opportunity with the potential to bring in revenue. An 
opportunity has a life span and it eventually closes either because it turns into a 
sale, is lost to a competitor, or is a bad opportunity. An opportunity is assigned to 
one or more territories based on a variety of criteria and can be worked on by a 
single sales representative, by a team of employees, or by a sales partner.

Partner
Partners are people or organizations with whom you can have a business 
relationship. Every partner organization is a distinct legal entity with its own 
challenges, market pressures, customer pressures, and intellectual capital.

Partner Administrator
The partner administrator is the primary contact of the organization and is 
responsible for administering all opportunities assigned to the partner.

Partner Contact
The primary contact for a partner, (the role responsible for administering all 
opportunities assigned to the partner) receives e-mail notifications and accepts or 
declines opportunities on behalf of the partner.

Partner Dashboard
The partner dashboard enables partners to enroll into programs, manage 
memberships, view and manage company profile, manage users, view product 
catalog, place orders, view order status, submit referrals, register deals, request soft 
funds, request discounts, accept opportunities, and work on assigned opportunities.

Partner Fund
Partner funds enable you to better manage and distribute channel marketing funds 
to your channel partners. You can provide funds for a specific time period and base 
it on fiscal periods of your organization.
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Partner Funds Liability
The liability is the amount of money that you have committed to pay out to your 
channel partners for marketing activities but have not yet paid out.

Partner List
Oracle Partner Management integrates with Oracle Marketing to enable you to 
generate partner lists. These lists can then be used to run marketing campaigns for 
partners. Based on profile attributes, you can create a list and save your search. 
Based on the search criteria, partners will be displayed and this can be created as a 
list.

Partner Timeout Period
Partner timeout is based on a partner’s country; it is the time period during which a 
partner who has been offered an opportunity is expected to respond (accept/reject 
the opportunity) before the next action can occur. These time frames are 
user-defined and supported by Oracle Workflow through automatic e-mails, 
notifications, and routing status changes.

Partner Type
A type of partnership with specified terms and conditions, that is Value-Added 
Distributor (VAD), Value-Added Reseller (VAR), System Integrator (SI), 
Independent Software Provider (ISP), Supplier, Manufacturer, and so on.

Partner User
They can use the transactional system and request for a special price, request for 
funds, submit referrals, and register deals. They can also request for an account via 
self-service and these requests will be routed to partner administrators for 
approval. They can manage a user’s profile, preferences, view their company 
profile, manage objects that they have access to and can also purchase things from 
the store.

Personalize
A function that allows a user to customize many different pages to accommodate 
specific needs.

Program
Programs are used to segment partners and provide different benefits to partners.
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Program Benefit
Programs are used to segment partners and provide different benefits to partners. 
Partners enrolled in programs can enjoy special benefits like leads, opportunities, 
marketing development funds, referrals, deals, and special pricing.

Prospect
Prospective customers who have not previously purchased products or services.

Record
A collection of related Fields. All of the fields in a record contain data relating to a 
single item.

Referral
Partners can submit referrals and receive a commission for referring the business. 
Partners can refer business opportunities that they cannot fulfill directly. For 
example, the customer is interested in a product that the reseller does not resale. 
The partner can then submit a referral and receive a percentage of the revenue 
generated.

Reseller
A business that buys goods from a manufacturer and resells them to customers 
unchanged.

Similar Special Pricing Request
Special pricing provides approval with a decision support tool to compare similar 
requests and link similar requests. This mechanism ensures legal compliance with 
U.S. pricing laws. It essentially enables you to ensure similar pricing. Regardless of 
your geography, it enables you to ensure the same or similar pricing for all special 
pricing requests for a particular end-customer deal.

Special Pricing
Special Pricing enables you to automate and streamline the special pricing process 
in which your partners request discounts on sales deals. You can respond quickly 
and intelligently to your partners’ requests for special, discounted pricing, thus 
closing more sales and increasing partner loyalty.
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Special Pricing Claim
When a special pricing request is approved, partners can close the sale at the 
discounted price and submit a claim to collect payment.

Special Pricing Request 
A special pricing request enables partners to request discounted pricing from you. 
They can request discounts on competitive sales deals, specific end-customer deals, 
and on inventory that they have not been able to move.

Special Pricing Request Type
The request types are:

■ Meet Competitor Price: When a partner wants to match a competitor’s price, they can 
ask you to reduce the price to complete a sale.

■ Bid Request: When a partner wants to win a deal for a specific end-customer.

■ Blanket Request: When a partner has inventory in his warehouse and has not 
been able to move it, they can ask for a discount to move the unsold inventory.

Special Pricing Liability
The liability is the amount of money that you have committed to pay out to your 
channel partners for discounts but have not yet paid out.

Status
Statuses are assigned to various marketing objects to let users and the system know 
the state of the object. Changes in status may be affected by the user or may be 
affected by the system, particularly those status changes requiring approval.

Structured Query Language (SQL)
Sometimes pronounced ’Sequel’, Structured Query Language is a standard for 
querying, or asking questions of, a database.

Single Assignment
In this routing option, the opportunity is routed only to one partner.

Summary Page
Summary pages, which are a list of marketing objects, appear under many tabs and 
horizontal navigation links. To view a marketing object's details, click the object's 
name.
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Tab
Main divisions within the user interface of Oracle Partners.

TAP
Territory Assignment Program. This is a CRM common module that enables 
businesses to allocate resources based on territory definitions.

TCA or Trading Community Architecture
Oracle's single customer database architecture for all types of customers.

Vendor
A business entity that is engaged in the activity of selling products and/or 
providing services to the market place.

Workflow
Oracle Workflow automates and continuously improves business processes, routing 
information of any type according to business rules you can change. Oracle 
Workflow manages business processes according to rules that you define. The rules, 
which we call a workflow process definition, include the activities that occur in the 
process and the relationship between those activities. An activity in a process 
definition can be an automated function defined by:

■ a PL/SQL stored procedure or an external function

■ a notification to a user or role that they may request a response

■ a business event

■ a subflow that itself is made up of many activities.

Workflow Attributes
Workflow attributes control the behavior of the workflow.

Workflow Monitor
The workflow monitor is a Java based tool used for administering and viewing 
workflow process.
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